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安全上のご注意安全上のご注意安全上のご注意安全上のご注意安全上のご注意
ここでは、本機をご使用になる上での安全に関する項目を記載してあります。
あなたや他の人々へ与える危害や、財産などへの損害を未然に防止するため、ここに記載されている事項をお守りいただくも
のです。本機をご使用の前には必ずお読みください。

この表示の欄に記載されている事項を無視して、誤った取り扱
いをすると、人が死亡または重傷を負う可能性が想定される内
容を示しています。

この表示の欄に記載されている事項を無視して、誤った取り扱
いをすると、人が障害を負ったり、物的損害の発生が想定され
る内容を示しています。

警告 注意

絵表示について絵表示について絵表示について絵表示について絵表示について
本書、および製品の表示には、あなたや他の人々へ与える危害や財産の損害を未然に防ぎ、本機を安全にご使用いただくため
に、警告または注意を促す絵表示を使用しています。これらの絵表示の意味をよく理解してから本書をお読みください。

絵表示の例絵表示の例絵表示の例絵表示の例絵表示の例

△記号は、注意しなければならない
内容（警告も含みます）を示してい
ます。具体的な注意事項は△の中や
近くに絵や文章で示しています（上
図の例は「感電注意」を示していま
す。

◯記号は、禁止内容（してはいけな
いこと）を示しています。具体的な
禁止事項は◯の中や近くに絵や文章
で示しています（上図の例は「分解
禁止」を示しています。

●記号は、強制内容（必ずすること）
を示しています。具体的な強制事項
は●の中や近くに絵や文章で示して
います（上図の例は「電源プラグを
コンセントから抜く」を示していま
す。

 警 告
異常が発生した場合

●万一、煙りが出ている、変なにおいや音がするなどの
異常状態のまま使用すると、火災・感電の原因になり
ます。すぐに機器本体の電源を切り、必ずACアダプ
タの電源プラグをコンセントから抜いてください。異
常がなくなったことを確認して販売店または当社営業
窓口へ修理の依頼をしてください。お客様ご自身での
修理は大変危険ですので、絶対にお止めださい。

●万一、機器内部に水や異物が入った場合には、すぐに
機器本体の電源を切り、必ずACアダプタの電源プラ
グをコンセントから抜いて販売店または当社営業窓口
へ修理の依頼をしてください。そのまま使用すると火
災・感電の原因になります。

●万一、機器を落としたり、カバーを破損した場合に
は、すぐに機器本体の電源を切り、必ずACアダプタ
の電源プラグをコンセントから抜いて販売店または当
社営業窓口へ修理を依頼してください。そのまま使用
すると火災・感電の原因になります。

●ACアダプタの電源コードの断線、芯線の露出など、
コードが傷んだ場合には、販売店または当社営業窓口
へ修理を依頼してください。そのまま使用すると火
災・感電の原因になります。

設置する場合

●機器本体に直接水のかかる場所には置かないでくださ
い。火災・感電の原因になります。特に屋外での使用
（雨天、降雪時、海岸、水辺）にはご注意ください。

●製品本体の上に花瓶、コップや水などの入った容器、
または小さな金属物類を置かないでください。何らか
の理由で水がこぼれたり、中に金属物が入ったりした
場合、火災・感電の原因になります。
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使用する場合
●本機の分解・修理・改造は絶対にしないでください。
また、本体カバーは絶対に外したりしないでくださ
い。火災・感電の原因になります。

●雷が鳴り出したら、ACアダプタの電源プラグには絶
対手を触れないでください。感電の原因になります。

●ACアダプタの電源コードを傷つけたり、加工したり、
ねじったり、引っ張ったり、あるいは加熱したりしな
いでください。コードが破損して、火災・感電の原因
になります。

●ACアダプタの電源コードの上に重いものを載せたり、
コードが本機の下敷きにならないようにしてくださ
い。コードが傷付いて火災・感電の原因になります。

●機器本体または取扱説明書に表記されている電源電圧
以外の電圧では使用しないでください。なお、ACアダ
プタの電源プラグは電源コンセントに確実に差し込ん
でご使用ください。火災・感電の原因になります。
また、内蔵バッテリーを使用するときも、ご使用前に
確実にセットされていることを確認してください。

設置する場合

●油煙や湯気の当たるような場所、あるいは湿気やホ
コリの多いところに置かないでください。火災・感
電の原因となることがあります。

●ACアダプタの電源コードを熱器具に近付けないでく
ださい。コードの被覆が溶けて、火災・感電の原因と
なることがあります。

●本機を長期間（一ヶ月以上）使用しない場合には、安
全のため必ずACアダプタの電源プラグをコンセント
から抜いてください（およびバッテリーを外す）。接
続（あるいはバッテリーを内蔵したまま）したままに
しておくと、火災・感電の原因となることがあります。

●窓を閉め切った車の中や、直射日光が長時間当たる
場所など、異常に温度が高くなる場所に放置しない
でください。火災の原因となることがあります。

●本機をぐらついた台の上や傾いたところなど、不安
定な場所に置かないでください。落ちたり倒れたり
してけがの原因となることがあります。

●この製品は精密な部品でできています。製品を運ぶ
ときなどは、必ず二人以上で慎重に行ってください。

●本機を移動する場合には、電源スイッチを切り、必
ずACアダプタの電源プラグをコンセントから抜い
て、接続されている外部機器の接続ケーブルを外し
てから行ってください。コードが傷付き、火災・感電
の原因となることがあります。

使用する場合

●本機に他のオーディオ機器を接続する場合には、必
ず本機および接続する機器の電源を切り、接続する
機器の説明書をよく読んで、説明に従って正しく接
続してください。また、接続に使用するケーブルな
どは指定されたケーブルを使用してください。

製品をお手入れする場合
●本機をお手入れする場合には、安全のためACアダプ
タの電源プラグをコンセントから抜いてください。
電源プラグを差し込んだまま行うと、感電の原因とな
ることがあります。

●濡れた手でACアダプタの電源プラグの抜き差しはし
ないでください。感電の原因となることがあります。

●電源が入った状態で、本機を布やふとんなどで被った
りしないでください。熱がこもり、火災の原因となる
ことがあります。

●5年に一度位は、機器内部の清掃が必要です。販売店
または当社営業窓口へご相談ください。長期間掃除し
ないと内部にホコリがたまり、そのまま使用すると火
災・感電の原因となることがあります。特に湿気の多
くなる梅雨時期の前に行うと、より効果的です。

●本機の電源を入れる前には音量（ボリュームなど）を
最小にしてください。突然大きな音が出て聴力障害
の原因となることがあります。

その他のご注意

●本機の近くで携帯電話を使用すると、機器にノイズが入ることが
あります。携帯電話のご使用は、本機から離れた場所で行ってく
ださい。

●この製品をラジオやテレビの近くで使用すると、ノイズや雑音が
生じることがあります。このような場合には、本機をラジオやテ
レビから離してご使用ください。

●大きなモニター音を長時間ヘッドフォンでモニターす
るのはお止め下さい。聴力障害の原因となることがあ
ります。

 注 意

●ディスク・トレイを開けると、可視または不可視レー
ザ光が出ます。ビームを直接見たり、触れたりしない
でください。
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ご使用になる前の注意ご使用になる前の注意ご使用になる前の注意ご使用になる前の注意ご使用になる前の注意（冒頭記載の「安全上のご注意」と、併せてお読みください）

● 本機の電源をACコンセントから供給する場合には、必ず付属のACアダプタをご使
用ください。指定以外のアダプタをご使用になった場合、FR-2LEの性能が得られな
いばかりか、本機を壊す恐れがありますのでご注意ください。

● 付属のACアダプタは、日本国内（AC100V電源仕様）でのみ使用できます。
電源電圧の異なる地域でご使用いただく場合は、当社サービス部門（☎ 042-546-
3151、FAX. 042-546-3198）へご相談ください。なお、ACアダプタは電源周波数
50Hz、60Hzいずれの地域でもご使用になれます。

● 本機には、定格以外の電源電圧を供給しないでください。

● 電池は、ニッカド電池、ニッケル水素電池、アルカリ電池またはタミヤ・バッテリー
（7.2V）を使用し、充電電池はフル充電されている物をご使用ください。

● 電池の交換や、ACアダプタの電源プラグの抜き差しは、必ず本機の主電源をオフに
してから行ってください。電源がオンの状態では、常にデータのやり取りを行ってい
るため、メモリ内容を壊す恐れがあります。

● 記録中などメモリー・カードのアクセス中は、絶対に電源を切らないでください。
電源をオフするときは、 カードのアクセスが完全に停止していることを確認してくだ
さい。記録したデータを失うことはもとより、メモリー・カードの故障の原因となり
ます。なお、なお、なお、なお、なお、本機を使用中に生じるあらゆるデータの消失に関しては、本機を使用中に生じるあらゆるデータの消失に関しては、本機を使用中に生じるあらゆるデータの消失に関しては、本機を使用中に生じるあらゆるデータの消失に関しては、本機を使用中に生じるあらゆるデータの消失に関しては、当社では一切当社では一切当社では一切当社では一切当社では一切
の責任を負いませんのでご注意ください。の責任を負いませんのでご注意ください。の責任を負いませんのでご注意ください。の責任を負いませんのでご注意ください。の責任を負いませんのでご注意ください。

●●●●● 本機を使用して生じる本機を使用して生じる本機を使用して生じる本機を使用して生じる本機を使用して生じる「「「「「直直直直直接接接接接的的的的的損損損損損害害害害害」」」」」・・・・・「「「「「間間間間間接接接接接的的的的的損損損損損害害害害害」」」」」については、については、については、については、については、当社では一切の責当社では一切の責当社では一切の責当社では一切の責当社では一切の責
任を負えませんので、任を負えませんので、任を負えませんので、任を負えませんので、任を負えませんので、あらかじめご承知置きください。あらかじめご承知置きください。あらかじめご承知置きください。あらかじめご承知置きください。あらかじめご承知置きください。

● 本機の内部（特にカード・スロット内部）に水などの液体や可燃物、あるいはピンな
どの金属類を入れないでください。万一、水などが入った場合にはすぐに電源を切り、
ACアダプタを使用している場合はアダプタの電源コードを抜いて、当社サービス部
門へご相談ください。

● 本機を落としたり、強い衝撃を与えないでください。内部回路やディスプレイ／パネ
ルなどが破損することがあります。本機は主に屋外での使用を考慮して設計されてい
ますが、精密機器のため取り扱いには充分ご注意ください。

● 本機外装カバーを取り外したり、本機の内部に手を触れないでください。故障の原因
となります。

はじめにはじめにはじめにはじめにはじめに
この取扱説明書は、フォステクス Field Memory Recorder Model FR-2LEをご使用いた
だくためのガイド・ブックです。
本書の記載内容は、業務用デジタル・レコーダの使用経験と基礎知識がおありになる方々
を対象に書かれています。したがって、本書の「第1章　製品の概要」および「第3章
　各部の名称と機能」をお読みいただければ、FR-2LEのおおよその使用方法がお分かり
いただけるよう、簡潔にまとめてあります。

特に、「第2章　ご使用になる前に」では、FR-2LEを初めてご使用になるために重要な
「電源の取り扱い方法」、および「メモリー・カードの取り扱い方法」など、基本的な取
り扱い方法や注意事項について記載しています。本機をはじめてご使用いただくには、是
非「第2章　ご使用になる前に」を十分にお読みくださるようお願い致します。
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アフターサービスについてアフターサービスについてアフターサービスについてアフターサービスについてアフターサービスについて
● 保証期間中は保証書の記載内容に基づき、当社サービス部門で修理致します。その他

詳細については、保証書の裏をご覧ください。

● 保証期間経過後、または保証書を提示されない場合の修理についてご不明な点は、お
買い上げいただいた販売店、もしくは当社営業窓口（☎042-546-6355, FAX. 042-
546-6067）へご相談ください。

●●●●● 本機を下記のような条件下では、本機を下記のような条件下では、本機を下記のような条件下では、本機を下記のような条件下では、本機を下記のような条件下では、使用しないでください。使用しないでください。使用しないでください。使用しないでください。使用しないでください。
* 極端に暑いところや寒いところなど、気温の変化の激しい場所。
* 湿気の多い場所。
* 激しく振動する場所。
* ホコリの多い場所。
* 強い磁気を発生する場所、あるいは磁気を発生させる機器の傍。
* 長時間直射日光があたる場所。
* 直接雨などの水が当たる場所。

●●●●● 結露について結露について結露について結露について結露について
極端に寒いところから急に暖かい部屋などへ本機を移動すると、結露が生じてディス
プレイ／パネルなどに水滴が付くことがあります。このような場合には、移動した場

所の温度になじむまで、本機をしばらく放置することをお勧めします。

設置上のご注意設置上のご注意設置上のご注意設置上のご注意設置上のご注意

＜重要＞＜重要＞＜重要＞＜重要＞＜重要＞
本機の機種名、電気定格、およびシリアル・ナンバーなど
は、製品の底部に表示されています。

MODEL FR-2LE
FIELD MEMORY RECORDER

FOSTEX CO.
INPUT: 12VDC

SERIAL NO.

MADE IN CHINA

● 付属のショルダーをご使用になる際は、ショルダーをFR-2LE本体に正しく取り付け
てください。思わぬ事故の原因となります。

● LCDディスプレイには強い衝撃を与えないでください。LCD内部の液体は有害物質
です。万一、破損流失した液晶は、なめたり吸い込んだりしないでください。手など
他の皮膚に液晶が付着した場合には、速やかに水などで完全に洗い流してください。

MP3 (MPEG Layer-3) MP3 (MPEG Layer-3) MP3 (MPEG Layer-3) MP3 (MPEG Layer-3) MP3 (MPEG Layer-3) についてについてについてについてについて
本製品の供給は、収益を発生する放送システム（地上波、衛生放送、ケーブルおよび／
もしくはその他の配信チャンネル）、ストリーミングアプリケーション（インターネット、
イントラネット、および／もしくはその他のネットワーク経由で）、その他のコンテンツ
システム（ペイオーディオまたはオーディオオンデマンドアプリケーションなど）、また
は物理的媒体（コンパクトディスク、デジタル汎用ディスク、半導体チップ、ハードド
ライブ、メモリーカードなど）で、本製品で創作されたコンテンツを配信するライセン
スを与えるものではありませんし、同コンテンツを配信する権利を暗示するものでもあ
りません。当該使用には、独立したライセンスが必要です。詳細に関してはhttp://
mp3licensing.comにアクセスしてください。
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取扱説明書のご使用にあたって取扱説明書のご使用にあたって取扱説明書のご使用にあたって取扱説明書のご使用にあたって取扱説明書のご使用にあたって

この取扱説明書は、フォステクスFIELD MEMORY RECORDER FR-2LEを有効にご使
用いただくためのガイドブックとして構成されています。
製品の各部の名称と働きをはじめ、FR-2LEが搭載している各種機能の説明など、FR-
2LEをご使用いただく上で理解していただきたい事項について、章ごとに分けて説明し
てあります。さらに、ご使用上の注意、安全上の注意、およびアフターサービスについ
ても説明してありますので、常に本書を参考にしていただけるよう、大切に保管してご
利用ください。

＜本書の目的＞＜本書の目的＞＜本書の目的＞＜本書の目的＞＜本書の目的＞

＜本書の構成＞＜本書の構成＞＜本書の構成＞＜本書の構成＞＜本書の構成＞
目次をご覧いただいても、おおよその項目を知ることができますが、ここでは本書全体
の構成と記載内容を把握していただくために、第１章をはじめ全章の概略について説明
しています。

＜第＜第＜第＜第＜第11111章＞章＞章＞章＞章＞：：：：：製品の概要製品の概要製品の概要製品の概要製品の概要
FR-2LEの概要をはじめ、製品の主な特徴について記載しています。

＜第＜第＜第＜第＜第22222章＞章＞章＞章＞章＞：：：：：ご使用になる前にご使用になる前にご使用になる前にご使用になる前にご使用になる前に
初めてFR-2LEをご使用になる際に必要な、「電源の取り扱いと注意事項」と「メモリー・
カードの取り扱い／初期フォーマット」などについて記載しています。

＜第＜第＜第＜第＜第33333章＞章＞章＞章＞章＞：：：：：各部の名称と働き各部の名称と働き各部の名称と働き各部の名称と働き各部の名称と働き
FR-2LEの機能が理解できるよう、フロント・パネル／トップ・パネル部のスイッチや操
作キーの説明、およびサイド・パネル部の入出力端子の働きなどを説明しています。
デジタル機器に使い慣れたユーザーであれば、この章をお読みいただくことでFR-2LEの
機能がおおよそ理解できるようになっています。

＜第＜第＜第＜第＜第44444章＞章＞章＞章＞章＞：：：：：基本接続基本接続基本接続基本接続基本接続
FR-2LEの入出力端子に接続する、外部機器の基本的な接続方法と使用方法について記載
しています。アナログ・オーディオ信号、USBコネクタを使用したPCとの接続や、ワ
イヤード・リモコンの接続などについて記載しています。

＜第＜第＜第＜第＜第55555章＞章＞章＞章＞章＞：：：：：記録／再生記録／再生記録／再生記録／再生記録／再生
FR-2LEを使ったアナログ・オーディオ信号の記録／再生について記載しています。
さらには、CUEの記録方法やロケート機能についてもこの章をお読みください。

● 保証期間経過後でも、修理によって製品の機能が維持できる場合には、お客様のご要
望により有料修理致します。修理費用／期間などについては、当社サービス部門（☎
042-546-3151, FAX. 042-546-3198）へお問い合わせください。

● この製品の補修用性能部品（製品の機能を維持するために必要な部品）の最低保有期
間は、製造打ち切り後6年です。
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＜第＜第＜第＜第＜第77777章＞章＞章＞章＞章＞：：：：：MENUMENUMENUMENUMENUモードモードモードモードモード
本機をご使用いただく上で必要な各種設定メニューについて記載しています。
MENUモードは4つのメイン・メニューで構成され、それぞれのメイン・メニューには
用途に応じた各種設定を行うサブ・メニューが用意されています（注意注意注意注意注意：：：：：製品のバージョ製品のバージョ製品のバージョ製品のバージョ製品のバージョ
ンアップに伴い、ンアップに伴い、ンアップに伴い、ンアップに伴い、ンアップに伴い、メニューの項目は変更することがありますメニューの項目は変更することがありますメニューの項目は変更することがありますメニューの項目は変更することがありますメニューの項目は変更することがあります）。

Format メモリー・カードのフォーマット。

Reel No メモリー・カードのReel Numberを編集して再登録。

Resume レジューム機能のON/OFFを設定。

（（（（（22222）））））DiskDiskDiskDiskDiskメニューメニューメニューメニューメニュー（（（（（詳詳詳詳詳細細細細細ははははは8686868686ページを参照）ページを参照）ページを参照）ページを参照）ページを参照）
メモリー・カードに関連した設定や編集を行う、3つのサブ・メニューで構成されています。

サブサブサブサブサブ・・・・・メニューメニューメニューメニューメニュー 詳　細詳　細詳　細詳　細詳　細

＜第＜第＜第＜第＜第66666章＞章＞章＞章＞章＞：：：：：PCPCPCPCPCへの取り込みへの取り込みへの取り込みへの取り込みへの取り込み
本機とPCを接続して、記録したオーディオ・ファイルのデータ（BWFファイル／MP3
ファイル）をコンピュータのハードディスクへコピーしたり、Digidesign Pro Toolsな
どのコンピュータ・ソフトへインポートする方法について記載しています。

Locate 選択した任意のファイル先頭へロケート。

Rename 任意のオーディオ・ファイル・ネームをリネームして再登録。

Remove 任意のオーディオ・ファイルをADL (Audio Decision List)から外す。

Prev.Insert ADLから外したフリー・ファイルを、再度ADLに組み込む。

（（（（（11111）））））FileFileFileFileFileメニューメニューメニューメニューメニュー（（（（（詳詳詳詳詳細細細細細ははははは8080808080ページを参照）ページを参照）ページを参照）ページを参照）ページを参照）
オーディオ・ファイルに関連した設定や編集を行う、5つのサブ・メニューで構成されています。

Next Insert ADLから外したフリー・ファイルを、再度ADLに組み込む。

サブサブサブサブサブ・・・・・メニューメニューメニューメニューメニュー 詳　細詳　細詳　細詳　細詳　細

ALC Auto Level ControlまたはLimiterのON/OFF設定。

HPF ハイパスフィルター機能のON/OFF設定。

Def. FS/BIT メモリー・カードの記録フォーマットを設定。

Source Sel. 記録ソース（外部入力または内蔵マイク）の設定。

（（（（（33333）））））SetupSetupSetupSetupSetupメニューメニューメニューメニューメニュー（（（（（詳詳詳詳詳細細細細細ははははは9191919191ページを参照）ページを参照）ページを参照）ページを参照）ページを参照）
FR-2LEの動作環境に関連した設定や編集を行う、19のサブ・メニューで構成されています。

サブサブサブサブサブ・・・・・メニューメニューメニューメニューメニュー 詳　細詳　細詳　細詳　細詳　細
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Phantom ファンタム電源のON/OFF設定。

サブサブサブサブサブ・・・・・メニューメニューメニューメニューメニュー 詳　細詳　細詳　細詳　細詳　細

Monitor Mode モニターの出力モード（ステレオ／モノ）を設定。

File Name Mode 記録時のファイル・ネーム・モードを設定。

Default File Name File Name ModeをTake設定時の、Scene name/Take Noを設定。

Pre Rec Pre Record機能のON/OFFを設定。

Time Display タイム表示部の表示モードを設定。

Remain Display リメイン表示部の表示モードを設定。

Max. File Size ファイルの最大記録容量を設定。

Battery Type 本機を駆動する、電池の種類を設定。

Error Tone エラー・トーン出力機能のON/OFFを設定。

AdjustRealTimeClock 内蔵時計の設定。

Version 搭載ROMのバージョン確認。

Initial Setup Setupメニューのイニシャライズ。

Card Protect メモリー・カードのプロテクトON/OFF設定。

USB Device Mode PCとのUSB接続／解除を設定。

（（（（（44444）））））USB ModeUSB ModeUSB ModeUSB ModeUSB Modeメニューメニューメニューメニューメニュー（（（（（詳詳詳詳詳細細細細細ははははは6969696969ページを参照）ページを参照）ページを参照）ページを参照）ページを参照）
PCとの接続を実行する際に必要なUSBモードの設定に関連した、2つのサブ・メニューで構成さ
れています。

サブサブサブサブサブ・・・・・メニューメニューメニューメニューメニュー 詳　細詳　細詳　細詳　細詳　細

＜第＜第＜第＜第＜第88888章＞章＞章＞章＞章＞：：：：：製品の主な仕様製品の主な仕様製品の主な仕様製品の主な仕様製品の主な仕様
本機の機械特性、電気特性や外観寸法図など、製品規格の詳細を記載してあります。

Version Up ソフトウエアのバージョンアップ。

Speaker Out 内蔵スピーカー機能のON/OFFを設定。
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FR-2LE Field Memory Recorder

本書説明においては、下記のような記述がされています。

1） 本文中に多く出てくる言葉は、以下のように「略語」で表記しています。

＜表記例＞
コンパクトフラッシュTM・カード → CFC（CompactFlashTM Card）
サンプリング周波数 → FS（Sampling  Frequency）
リアルタイム・クロック → RTC（Real Time Clock）
パーソナル・コンピュータ → PC（Personal Computer）

2） 各操作キー、スイッチ、コネクタなどは、原則として本体パネルの表記文字を使
い、 [      ] で囲って記載してあります。

＜表記例＞＜表記例＞＜表記例＞＜表記例＞＜表記例＞
プレイ・キー → [PLAY] キー
電源スイッチ → [POWER] スイッチ
アナログ入力コネクタ → [ANALOG IN] コネクタ

3） “     ”で囲まれた文字は、スイッチのポジション名、あるいはディスプレイに表
示されるメッセージなどを表しています。

4） インジケータだけでなく、ディスプレイ上に現れるメッセージなども含め、「点灯」
または「点滅」と表現しています。

5） 通常アナログ・レコーダーでは「録音」と表記しますが、本機のようなデジタル・
レコーダでは、オーディオ信号以外にCUEポイントなども扱うため、「記録」と表
現しています。ただし、オーディオ信号の解説で一部「録音」と記載している箇
所もあります。

6） ＜注意＞は、本機を正しくご使用いただくための注意事項、およびアドバイスと
して記載してあります。

＜本書の記述方法について＞＜本書の記述方法について＞＜本書の記述方法について＞＜本書の記述方法について＞＜本書の記述方法について＞
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FR-2LE Field Memory Recorder（第 1章　製品の概要）

第第第第第11111章　製章　製章　製章　製章　製     品品品品品     ののののの     概概概概概     要要要要要
FR-2LEの主な特長／機能、および付属品やソフトウェアのバージョンアップなどについて記載しています。
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FR-2LE Field Memory Recorder（第 1章　製品の概要）

製品の主な概要製品の主な概要製品の主な概要製品の主な概要製品の主な概要
Model FR-2LEは、TYPE IIのコンパクトフラッシュ・カードTMをメディアに採用した、
ポータブル・タイプの業務用メモリー・レコーダで、高音質のステレオ録音が可能です。
主に屋外での音声収録に性能を発揮させるため、小型／軽量設計のボディを採用、電池
またはACアダプタの2電源方式で駆動することができます。

また、パソコンとの接続を可能にする専用USBポートを装備し、FR-2LEで記録したオー
ディオ・ファイル・データをパソコンに取り込んで編集などが可能です。

製品の主な特長／機能製品の主な特長／機能製品の主な特長／機能製品の主な特長／機能製品の主な特長／機能
● TYPE II のCFカード用スロットを装備し、記録メディアにコンパクトフラッシュ・

カードTMが使用可能です。

● 電源は2電源方式を採用し、付属のACアダプタまたは単三電池（アルカリ／ニッ
カド／ニッケル水素）で駆動することが可能です。さらには、世界標準のタミヤ
バッテリー（7.2V）が内蔵でき、長時間の録音にも対応します。

● ファイル・システムはFAT32に対応し、記録ファイルのフォーマットはBWFの
インターリーブ1ファイル仕様を採用しています。Pro Tools等のDAWにイン
ポートすることが可能です。

● 44.1kHz / 48kHz / 88.2kHz / 96kHz 24Bitおよび44.1kHz / 48kHz 16Bitでの
記録をサポートし、さらにはMP3ファイルのダイレクト記録も可能です。

● 屋外での収録時に威力を発揮する“Pre Record”機能を搭載。記録開始前2秒間
のオーディオ・データをバッファに蓄えることで、記録開始時の録音ミスを防ぐ
ことが可能です。（“Pre Record”機能は、MENUモードのSetupメニューで設定
します）。

● 外部マイク入力には、L、R独立したトリムによる入力レベルの調整、さらには電
源を必要とするコンデンサ・マイクへのファンタム電源（+48V）の供給も可能で
す（ファンタム電源の供給は、MENUモードのSetupメニューで設定します）。

● 132×64ドット・マトリクスの、バックライト機能付きLCDをディスプレイに
採用し、多彩な情報を表示するとともに小型／省電力化を実現しました。

● パソコンとの接続専用USBポートを装備し、ダイレクトにPCとの接続が可能で
す。これにより、FR-2LEとPC間でオーディオ・ファイル（BWFファイル/MP3
ファイル）のやり取りが行なえます。

● 記録中にマーカーを付加するCUE機能を搭載しています（ファイルごとに最大99
記録可能です）。

● ワイヤード・リモコンを標準装備し、簡易リモート・コントロールが可能です。

● 電源電圧に異常が発生したとき、およびメモリー・カードの記録残領域が少なく
なってきたときに、エラー・トーンを発して警告する機能を搭載しています
（MENUモードの設定が必要です）。
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FR-2LE Field Memory Recorder（第 1章　製品の概要）

付属品について付属品について付属品について付属品について付属品について
本製品の梱包には、FR-2LE本体に加え以下の付属品が同梱されています。
開梱後、全ての品が揃っているかご確認ください。万一、欠品や損傷があった場合には、
お手数でもお買い求めの取扱代理店へご連絡ください。

専用専用専用専用専用ACACACACACアダプタアダプタアダプタアダプタアダプタ
使用方法については20ページを参照

電池収納ケース電池収納ケース電池収納ケース電池収納ケース電池収納ケース（（（（（単単単単単三三三三三×××××44444本収納タイプ）本収納タイプ）本収納タイプ）本収納タイプ）本収納タイプ）
使用方法については21ページを参照

ワイヤードワイヤードワイヤードワイヤードワイヤード・・・・・リモコンリモコンリモコンリモコンリモコン+++++固定バンド固定バンド固定バンド固定バンド固定バンド
使用方法については52ページを参照

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：FR-2LEには電池およびUSBケーブルは、付属されておりません。
市販の電池およびUSBケーブルをお買い求めください。なお、電池はアルカリ電池、ニッ
カド電池、ニッケル水素電池、またはタミヤ・バッテリーをご使用ください。

ショルダーショルダーショルダーショルダーショルダー

ソフトソフトソフトソフトソフト・・・・・ケースケースケースケースケース（（（（（袋袋袋袋袋）））））

COMPACTFLASH    CARD

CFCFCFCFCFカードカードカードカードカード
本体スロットに
挿入済み

FR-2LEFR-2LEFR-2LEFR-2LEFR-2LE本体本体本体本体本体

CFカードの取り扱い方法については
32ページを参照

使用方法については36ページを参照
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ソフトウエアーのバージョンアップについてソフトウエアーのバージョンアップについてソフトウエアーのバージョンアップについてソフトウエアーのバージョンアップについてソフトウエアーのバージョンアップについて
本製品のソフトウエアーは、仕様変更に伴いバージョンアップされます。
最新ソフトウエアーのバージョンは、弊社ホーム・ページ（http://www.fostex.jp）へア
クセスして確認するか、弊社サービス部門へお問い合わせください。

また、バージョンアップされたソフトウエアーは、弊社ホームページからダウンロード
して、下記手順でバージョンアップすることが可能です（具体的な操作方法については
参照ページをお読みください）。

＜ご注意＞＜ご注意＞＜ご注意＞＜ご注意＞＜ご注意＞：：：：：弊社ホームページからダウンロードできないお客様は、お手数でも弊社
サービス部門（Tel: 042-546-3151、Fax: 042-546-3198）へご相談ください。

（（（（（11111））））） 弊社ホームページ弊社ホームページ弊社ホームページ弊社ホームページ弊社ホームページ（（（（（http://www.fostex.jphttp://www.fostex.jphttp://www.fostex.jphttp://www.fostex.jphttp://www.fostex.jp）））））にアクセスして、にアクセスして、にアクセスして、にアクセスして、にアクセスして、FR-2LEFR-2LEFR-2LEFR-2LEFR-2LEバージョンバージョンバージョンバージョンバージョン
アップ用のソフトウエアーをパソコンへダウンロードします。アップ用のソフトウエアーをパソコンへダウンロードします。アップ用のソフトウエアーをパソコンへダウンロードします。アップ用のソフトウエアーをパソコンへダウンロードします。アップ用のソフトウエアーをパソコンへダウンロードします。

（（（（（22222））））） パソコンとパソコンとパソコンとパソコンとパソコンとFR-2LEFR-2LEFR-2LEFR-2LEFR-2LEをををををUSBUSBUSBUSBUSBケーブルで接続し、ケーブルで接続し、ケーブルで接続し、ケーブルで接続し、ケーブルで接続し、ダウンロードしたソフトウエアを、ダウンロードしたソフトウエアを、ダウンロードしたソフトウエアを、ダウンロードしたソフトウエアを、ダウンロードしたソフトウエアを、
FR-2LEFR-2LEFR-2LEFR-2LEFR-2LEのメモリーのメモリーのメモリーのメモリーのメモリー・・・・・カードにコピーします。カードにコピーします。カードにコピーします。カードにコピーします。カードにコピーします。
接続に関する詳細は70ページと71ページ、コピーの詳細は72ページをお読みください。

（（（（（33333））））） パソコンとパソコンとパソコンとパソコンとパソコンとFR-2LEFR-2LEFR-2LEFR-2LEFR-2LEの接続を解除した後、の接続を解除した後、の接続を解除した後、の接続を解除した後、の接続を解除した後、MENUMENUMENUMENUMENUモードのモードのモードのモードのモードの     “““““SetupSetupSetupSetupSetup”””””メニューにメニューにメニューにメニューにメニューに
あるあるあるあるある“““““Version UpVersion UpVersion UpVersion UpVersion Up”””””メニューを使って、メニューを使って、メニューを使って、メニューを使って、メニューを使って、バージョンアップを実行します。バージョンアップを実行します。バージョンアップを実行します。バージョンアップを実行します。バージョンアップを実行します。
“Version Up”メニューの操作方法は111ページをお読みください。

POWER USB

PHONES MONITOR OUT

L R

HOLD
OFF

“Version Up”メニュー

ソフトウエアーをコピー

ホームページ

MENUモードの“Setup”メニュー選択画面
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第第第第第22222章　ご使用になる前に章　ご使用になる前に章　ご使用になる前に章　ご使用になる前に章　ご使用になる前に（必ずお読みください！）

ここでは、具体的な操作に入る前に、本機を駆動する「電源」と記録を行うための「メモリー・カード」について
解説しています。安定した電源を供給し、スムーズな記録が行なえるよう、最初に必ずお読みください。特に「メ
モリー・カード」の項には、カードのフォーマットに関する事項が記載されていますので、必ずお読みくださるよ
うお願いします。

＜目　　次＞＜目　　次＞＜目　　次＞＜目　　次＞＜目　　次＞
電源について電源について電源について電源について電源について........................................................................................................................................................20........................................................................................................................................................20........................................................................................................................................................20........................................................................................................................................................20........................................................................................................................................................20

ACアダプタで駆動する......................................................................................................................................20

アダプタの接続...............................................................................................................................................20

電池で駆動する............................................................................................................................................21

単三電池（4本）のセット.....................................................................................................................................21

電池を収納したバッテリー・ケース（またはタミヤバッテリー）のセット.....................................22

パワー・オン...........................................................................................................................................................25

バッテリーの電圧表示について.......................................................................................................................26

メモリーメモリーメモリーメモリーメモリー・・・・・カードの初期フォーマットカードの初期フォーマットカードの初期フォーマットカードの初期フォーマットカードの初期フォーマット......................................................................................................27......................................................................................................27......................................................................................................27......................................................................................................27......................................................................................................27

ディスプレイのバックライトとコントラスト調整ディスプレイのバックライトとコントラスト調整ディスプレイのバックライトとコントラスト調整ディスプレイのバックライトとコントラスト調整ディスプレイのバックライトとコントラスト調整...............................................................................29...............................................................................29...............................................................................29...............................................................................29...............................................................................29

バックライトの点灯／消灯................................................................................................................................29

ディスプレイのコントラスト調整..................................................................................................................30

リアルタイムリアルタイムリアルタイムリアルタイムリアルタイム・・・・・クロッククロッククロッククロッククロック（（（（（内内内内内蔵蔵蔵蔵蔵時時時時時計計計計計）））））についてについてについてについてについて...................................................................................31...................................................................................31...................................................................................31...................................................................................31...................................................................................31

メモリーメモリーメモリーメモリーメモリー・・・・・カードについてカードについてカードについてカードについてカードについて.............................................................................................................................32.............................................................................................................................32.............................................................................................................................32.............................................................................................................................32.............................................................................................................................32

カードの出し入れ..................................................................................................................................................32

カードの取り出し...............................................................................................................................................33

カードの挿入........................................................................................................................................................34

ショルダーの取付けショルダーの取付けショルダーの取付けショルダーの取付けショルダーの取付け...........................................................................................................................................36...........................................................................................................................................36...........................................................................................................................................36...........................................................................................................................................36...........................................................................................................................................36
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電源について電源について電源について電源について電源について
本機を駆動するには、付属の専用ACアダプタを使用するか、市販の単三電池（アルカリ電池、ニッ
ケル水素電池、またはニッカド電池）を4本使用するか、あるいはタミヤバッテリーを使用します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：電池の挿入／交換や、ACアダプタのプラグを抜き差しするときは、必ず本機の電源スイッチを
“OFF”にしてから行ってください。電源が“ON”の状態ではデータのやり取りを行っているため、突然
電源が切られると、メモリー内容がリセットされてしまうことがあります。

ACACACACACアダプタで駆動するアダプタで駆動するアダプタで駆動するアダプタで駆動するアダプタで駆動する

＜＜＜＜＜ACACACACACアダプタを使用する場合のご注意＞アダプタを使用する場合のご注意＞アダプタを使用する場合のご注意＞アダプタを使用する場合のご注意＞アダプタを使用する場合のご注意＞
ACアダプタは、当社指定の専用ACアダプタをご使用ください。
指定以外のACアダプタを使用した場合、電圧の違いやDC出力の違いなどによって、本機が破損す
ることがあり危険です。また、ACアダプタのコネクタを抜き差しするときは、事前に本機の電源を
OFFにしてください。

●アダプタの接続●アダプタの接続●アダプタの接続●アダプタの接続●アダプタの接続

本機の [POWER] スイッチをOFFにした状態で、ACアダプタの二次側プラグを本機に接続し、
その後一次側のプラグをコンセントに接続します。

本機をACアダプタで駆動するときは、付属のACアダプタを使用します。

R

ANALOG IN

LHOT
GND

COLD

1
2
3

REMOTE12V

LINE
MICXLR

PHONE

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：記録中や再生中など、メモリー・カードのアクセス中は、ACアダプタのプラグを抜かな
いでください。強制的に電源を切ると、記録したデータを失うことはもとより、故障の原因となりま
す。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞
★ 規格以上の過電圧が加えられると、本機が壊れる恐れがあります。絶対に規格以上の電圧を供給しないで

ください。

★ 電池を使い切ったときや、過電流で電源に異常が発生すると、保護回路により電源は遮断されます。
このような場合には一旦電源を切り、新しい電池と交換して再度電源を入れ直してください。なお、これ
らの操作を行っても本機が正常に復帰しないときは、回路内部の故障も考えられますので、当社サービス
部門へご相談ください。

[DC IN] ジャック

コンセントへ



21

FR-2LE Field Memory Recorder（第 2章　ご使用になる前に）

本機を電池で駆動するには、付属のバッテリー・ケースに市販の単三電池（アルカリ／ニッカ
ド／ニッケル水素）4本を収納して使用するか、またはタミヤバッテリーを使用します。

＜電池を使用する場合のご注意＞＜電池を使用する場合のご注意＞＜電池を使用する場合のご注意＞＜電池を使用する場合のご注意＞＜電池を使用する場合のご注意＞
* 市販の電池をご使用になるときは、アルカリ電池、アルカリ電池、アルカリ電池、アルカリ電池、アルカリ電池、ニッカド電池またはニッケル水素電池ニッカド電池またはニッケル水素電池ニッカド電池またはニッケル水素電池ニッカド電池またはニッケル水素電池ニッカド電池またはニッケル水素電池をお求

めください。マンガン電池は使用しないでください。マンガン電池は使用しないでください。マンガン電池は使用しないでください。マンガン電池は使用しないでください。マンガン電池は使用しないでください。
* 電池は必ず新品の電池新品の電池新品の電池新品の電池新品の電池（（（（（あああああるるるるるいいいいいはははははフフフフフルルルルルににににに充充充充充電電電電電ささささされれれれれたたたたた電電電電電池池池池池）））））をご用意ください。
* 新品の電池と古い電池をまぜて使用しないでください。
* 液漏れなどしている電池液漏れなどしている電池液漏れなどしている電池液漏れなどしている電池液漏れなどしている電池は使用しないでください。

＜充電式のニッケル水素電池、＜充電式のニッケル水素電池、＜充電式のニッケル水素電池、＜充電式のニッケル水素電池、＜充電式のニッケル水素電池、ニッカド電池、ニッカド電池、ニッカド電池、ニッカド電池、ニッカド電池、またはタミヤバッテリーを使用する場合のご注意＞またはタミヤバッテリーを使用する場合のご注意＞またはタミヤバッテリーを使用する場合のご注意＞またはタミヤバッテリーを使用する場合のご注意＞またはタミヤバッテリーを使用する場合のご注意＞
本機には、電池を充電する機能は搭載されておりません。
充電式のニッケル水素電池、ニッカド電池、またはタミヤバッテリーをお使いになるときは、お買い
求めになった電池専用の充電器を使い、取扱説明書に基づいてフル充電を実施してください（詳細に
ついては充電器の説明書をお読みください）。

電池で駆動する電池で駆動する電池で駆動する電池で駆動する電池で駆動する

●●●●●     単三電池単三電池単三電池単三電池単三電池（（（（（44444本）本）本）本）本）のセットのセットのセットのセットのセット

単三電池（4本）は、付属のバッテリー・ケースに下図の要領で収納します。極性など間違えないよう、
正しい向きで収納してください。

＜重要！＜重要！＜重要！＜重要！＜重要！（（（（（必必必必必ずずずずず実実実実実行行行行行しししししてててててくくくくくだだだだださささささいいいいい）））））＞＞＞＞＞
電池をセット（または入れ替え）して電源を投入した後、MENUモードのSetupメニューにある
“Battery Type”の設定で、使用するバッテリー・タイプ（ニッケル水素電池、ニッカド電池、アル
カリ電池またはタミヤバッテリー）を設定してください。実際に使用する電池とバッテリー・タイプ
が異なっていると、電圧の違いにより、エラー・トーン出力機能などが正常に機能しないことがあり
ます。設定の詳細は、後述の107ページをお読みください。

タミヤバッテリーアルカリ電池、ニッカド電池
またはニッケル水素電池

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：タミヤバッテリーを使用したときは、自動的にMENUモードのSetupメニューにある
“Battery Type”が“RC7.2V”に設定されるようになっています。そのため、タミヤバッテリー
を使った後Ni-CdやNi-MHなどの単三電池を使用するときは、必ず手動で“Battery Type”を設
定し直してご使用ください。 なお、“Battery Type”が“RC7.2V”に設定されたまま単三電池を
使用すると、アラーム音を発して警告します。これはバッテリーのダメージを最小限に抑えるた
めの措置で、“Battery Type”を正しく設定することでアラーム音は出なくなります。
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●●●●●     電池を収納したバッテリー電池を収納したバッテリー電池を収納したバッテリー電池を収納したバッテリー電池を収納したバッテリー・・・・・ケースケースケースケースケース（（（（（まままままたたたたたはははははタタタタタミミミミミヤヤヤヤヤバババババッッッッッテテテテテリリリリリーーーーー）））））のセットのセットのセットのセットのセット

11111））））） FR-2LEFR-2LEFR-2LEFR-2LEFR-2LE本体の底部にある、本体の底部にある、本体の底部にある、本体の底部にある、本体の底部にある、収納蓋を取り外します。収納蓋を取り外します。収納蓋を取り外します。収納蓋を取り外します。収納蓋を取り外します。
収納蓋のツメを矢印方向へ引っ張りながら持ち上げてください。

接続コネクタ
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22222））））） バッテリーバッテリーバッテリーバッテリーバッテリー・・・・・ケースケースケースケースケース（（（（（まままままたたたたたはははははタタタタタミミミミミヤヤヤヤヤバババババッッッッッテテテテテリリリリリーーーーー）））））のケーブルを、のケーブルを、のケーブルを、のケーブルを、のケーブルを、FR-2LEFR-2LEFR-2LEFR-2LEFR-2LE本体の接続コネ本体の接続コネ本体の接続コネ本体の接続コネ本体の接続コネ
クタに接続します。クタに接続します。クタに接続します。クタに接続します。クタに接続します。

33333））））） ケーブルの接続後、ケーブルの接続後、ケーブルの接続後、ケーブルの接続後、ケーブルの接続後、バッテリーバッテリーバッテリーバッテリーバッテリー・・・・・ケースケースケースケースケース（（（（（まままままたたたたたはははははタタタタタミミミミミヤヤヤヤヤバババババッッッッッテテテテテリリリリリーーーーー）））））を収納部へセットを収納部へセットを収納部へセットを収納部へセットを収納部へセット
します。します。します。します。します。
収納部にはケーブルを逃がすエリア（下図の矢印部分）が用意されています。
ケーブルが邪魔にならないよう、逃がしエリアにケーブルを押し込みながらバッテリー・ケース
（またはタミヤバッテリー）を収納してください（下記収納図を参照し、正しく収納します）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：ケーブルがバッテリー・ケースとコネクタの間に挟まらないよう、正しく収納して
ください。

コネクタ
ケーブル

ケーブルの逃がしエリアバッテリー・ケース（またはタミヤバッテリー）

＜重要！＞＜重要！＞＜重要！＞＜重要！＞＜重要！＞：：：：：バッテリーバッテリーバッテリーバッテリーバッテリー・・・・・ケースケースケースケースケース（（（（（タタタタタミミミミミヤヤヤヤヤ・・・・・バッバッバッバッバッ
テリーは除く）テリーは除く）テリーは除く）テリーは除く）テリーは除く）は、は、は、は、は、電池の見える側が下になる電池の見える側が下になる電池の見える側が下になる電池の見える側が下になる電池の見える側が下になる
よう収納してください。よう収納してください。よう収納してください。よう収納してください。よう収納してください。

電池
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＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：使用済み電池を廃棄するときは、環境汚染に悪影響を与えないよう、定められた方
法で処分してください。

●＜覚えておきましょう！＞●＜覚えておきましょう！＞●＜覚えておきましょう！＞●＜覚えておきましょう！＞●＜覚えておきましょう！＞：：：：：電池の消耗を抑えるために電池の消耗を抑えるために電池の消耗を抑えるために電池の消耗を抑えるために電池の消耗を抑えるために

本機では電池の消耗を抑えるため、下記事項を実施することで、省電力の効果が期待できま
すのでご利用ください。

* 出力コネクタ（MONITOR OUT）には、できるだけ小さい負荷の機器を接続する。

* モニターの音量は、なるべく少量に抑える。

* 長時間本機を使用しないときは、電池を取り出しておく（[POWER] スイッチがOFF
でも微少電力を消費しています）。

下記表は、使用する電池のタイプによって連続使用可能な、おおよその時間です。
ご使用になる環境（気温／湿度／録音の回数など）や、メーカーによって異なることが
ありますが、おおよその目安としてご利用ください。
なお、本機にはバッテリーの残量を表示する機能や、電源電圧異常時のエラー・トーン
出力機能を搭載しています。残量表示についてはこの後26ページ記載の「バッテリーの
電圧表示について」を参照し、エラー・トーンの出力については107ページを参照して
ください。

ニッケル水素電池 (4.8V) アルカリ電池 (6V)

約4時間
（2150mAh使用時）

約4時間
（2300mAh使用時）

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：バッテリー・ケース内の端子や電池の端子は、時々乾いた布で拭いてください。ケー
ス内の端子や電池の端子が汚れていると、正常な電圧が供給されないことがあります。

44444））））） バッテリーバッテリーバッテリーバッテリーバッテリー・・・・・ケースケースケースケースケース（（（（（まままままたたたたたはははははタタタタタミミミミミヤヤヤヤヤバババババッッッッッテテテテテリリリリリーーーーー）））））を収納後、を収納後、を収納後、を収納後、を収納後、収納蓋を閉めます。収納蓋を閉めます。収納蓋を閉めます。収納蓋を閉めます。収納蓋を閉めます。

タミヤバッテリー (7.2V)

約8時間
（3600mAh使用時）
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パワーパワーパワーパワーパワー・・・・・オンオンオンオンオン

[POWER] スイッチ

＜電源オン／オフ時のご注意＞＜電源オン／オフ時のご注意＞＜電源オン／オフ時のご注意＞＜電源オン／オフ時のご注意＞＜電源オン／オフ時のご注意＞
本機の [POWER] スイッチは「モメンタリー式」になっており、電源をオフするときはオンするとき
と同様、同じ方向へ操作する構造になっています。また、電源をオフするときは、2秒間 [POWER]
スイッチを押さえてください。

電池を収納またはACアダプタを接続した後、本機の [POWER] スイッチをONにして本機が
正常に立ち上がることを確認してください。下記操作は、工場出荷時カード・スロットにコン
パクトフラッシュ・カードがセットされていることを前提にしています。

POWER USB

PHONES MONITOR OUT

L R

HOLD
OFF

POWER

HOLD
OFF

本機には、工場出荷時あらかじめコンパクトフラッシュ・カード（128MB）がカード・スロッ
トに挿入されているため、その状態で電源を入れると下記ディスプレイが表示されて立ち上が
ります。
この表示は、工場出荷時にセットされているカードが未フォーマットであることを表していま
す。この後27ページ記載の「メモリー・カードの初期フォーマット」を参照して、付属のカー
ドをフォーマットしてからご使用ください。

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT
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バッテリーの電圧表示についてバッテリーの電圧表示についてバッテリーの電圧表示についてバッテリーの電圧表示についてバッテリーの電圧表示について

また本機では、電圧表示以外に電池の消耗を警告する「エラー・トーン機能」を搭載していま
す。これは、電池の電圧が一定以下になると、自動的にモニター・スピーカ（またはヘッドホ
ン）からエラー・トーンを出力して警告する機能です。

エラー・トーンを出力させるには、107ページ記載のMENUモードにある“Setup”メニュー
の“Error Tone”を“On”に設定します（初期設定では“Off”になっています）。

電池の容量は十分にあります。

電池の容量は約半分程度です。

電池の交換が必要です。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：電池の残量に気付かずそのまま使用していると、右図
のような警告メッセージを表示し、自動的にシャット・ダウンし
てしまいます。本機を電池で駆動しているときは、電池の残量に
十分注意してご使用ください。

本機には電池の残量を表示する機能を搭載し、ディスプレイ下にあるバッテリー・アイコンで
残量を表示します。

電池を内蔵してFR-2LEを駆動する場合は、電池の消耗に伴いバッテリー・アイコンの点灯表
示が減少していきます。電池交換のタイミングを逃さないよう、常に注意を払ってご使用くだ
さい。

下記残量表示例はご使用いただく電池によって異なりますが、あくまでも目安として参照して
ください。
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22222））））） “““““FS/BIT Mode = *****/**FS/BIT Mode = *****/**FS/BIT Mode = *****/**FS/BIT Mode = *****/**FS/BIT Mode = *****/**”””””が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
初期設定の記録フォーマットが点滅し、任意に設定可能になります（初期設定：“BWF44/16”が点滅）。

現在の設定が点滅している状態で [+] キーまたは [-] キーを押すと、希望の記録フォーマットが選択で
きます。選択可能なFS/BITモードは、次表を参照してください。

メモリーメモリーメモリーメモリーメモリー・・・・・カードの初期フォーマットカードの初期フォーマットカードの初期フォーマットカードの初期フォーマットカードの初期フォーマット
本機で使用するメモリー・カードのファイル・システムは、FAT32を採用しています。
未フォーマットのメモリー・カード、またはFAT32以外のメモリー・カードを使用する場合は、下
記操作でメモリー・カードを初期フォーマットします。

下記の操作手順は、電源を入れた後本機が立ち上がり、ディスプレイには“Illegal Format!Illegal Format!Illegal Format!Illegal Format!Illegal Format!”が表示さ
れていることを前提にしています。

11111））））） ワーニングワーニングワーニングワーニングワーニング・・・・・メッセージが表示されている状態で、メッセージが表示されている状態で、メッセージが表示されている状態で、メッセージが表示されている状態で、メッセージが表示されている状態で、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
自動的にMENUモードのFormatメニューへ進み、下記例の画面に変ります。
この画面では、フォーマットするメモリー・カードのリール・ナンバーと記録フォーマット（FS/BIT
Mode）を設定することができます。ここでは、リール・ナンバーはそのままで、記録フォーマットのみ
設定してフォーマットの作業を進めます（リール・ナンバーはフォーマット後でも設定可能ですので、詳
細は97ページを参照してください）。

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

1, 2, 3, 4 

3

3, 4, 

5
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BWF44/16BWF44/16BWF44/16BWF44/16BWF44/16

BWF44/24BWF44/24BWF44/24BWF44/24BWF44/24
BWF48/16BWF48/16BWF48/16BWF48/16BWF48/16
BWF48/24BWF48/24BWF48/24BWF48/24BWF48/24
BWF88/24BWF88/24BWF88/24BWF88/24BWF88/24
BWF96/24BWF96/24BWF96/24BWF96/24BWF96/24
MP3-192MP3-192MP3-192MP3-192MP3-192

44.1kHz/16BitのBWFファイル・モード。

33333））））） [+] [+] [+] [+] [+] キー／キー／キー／キー／キー／[-] [-] [-] [-] [-] キーで希望の記録フォーマットを選択してキーで希望の記録フォーマットを選択してキーで希望の記録フォーマットを選択してキーで希望の記録フォーマットを選択してキーで希望の記録フォーマットを選択して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した記録フォーマットに設定され、一つ前の画面に変ります。

44444））））） [-] [-] [-] [-] [-] キーを押してカーソルをキーを押してカーソルをキーを押してカーソルをキーを押してカーソルをキーを押してカーソルを“““““[EXECUTE][EXECUTE][EXECUTE][EXECUTE][EXECUTE]”””””に移動してに移動してに移動してに移動してに移動して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
下記例の警告画面に変ります。フォーマットしないときは“[CANCEL]”を選択して [MENU/ENTER]
キーを押します。

55555））））） [REWIND] [REWIND] [REWIND] [REWIND] [REWIND] キーを押してカーソルをキーを押してカーソルをキーを押してカーソルをキーを押してカーソルをキーを押してカーソルを“““““[EXECUTE][EXECUTE][EXECUTE][EXECUTE][EXECUTE]”””””に移動して、に移動して、に移動して、に移動して、に移動して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押しキーを押しキーを押しキーを押しキーを押し
ます。ます。ます。ます。ます。
フォーマットを開始して、終了すると“Success.”が点灯してカードのアクセスが停止します。

66666））））） 画面の指示に従って、画面の指示に従って、画面の指示に従って、画面の指示に従って、画面の指示に従って、いずれかの操作キーを押します。いずれかの操作キーを押します。いずれかの操作キーを押します。いずれかの操作キーを押します。いずれかの操作キーを押します。
フォーマット後のHome画面に変ります。下記例は記録フォーマット“BWF48/16”でフォーマットし
た場合のHome画面です。

44.1kHz/24BitのBWFファイル・モード。
48kHz/16BitのBWFファイル・モード。

48kHz/24BitのBWFファイル・モード。
88.2kHz/24BitのBWFファイル・モード。
96kHz/24BitのBWFファイル・モード。
MP3-192kbpsの圧縮ファイル・モード。

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞
BWFBWFBWFBWFBWF：：：：：“Broadcast Wave Format”の略称で、EBU（ヨーロッパ放送連合）が判定したオーディオ・
データの交換用標準ファイル・フォーマットです。コンピュータなど相互間でオーディオ・データの
交換ができます。

MP3MP3MP3MP3MP3：：：：：“MPEG-1 Audio Layer3”の略称で、音声圧縮フォーマットをいいます。
MP3はオーディオデータの圧縮率が高いことが最大の利点で、例えば、BWFファイルで記録すると
500MBの容量が必要なオーディオ・データでも、MP3で記録すると70MBに圧縮され、記録容量が
縮小できます。

記録フォーマット

リメイン値

* 記録可能な時間は、記録フォーマットによって異なります。詳細は54ページを参照してください。
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フォーマット直後のディスプレイは、 "<<No Audio Files>><<No Audio Files>><<No Audio Files>><<No Audio Files>><<No Audio Files>>" が点灯します。これは、カード上
に何もオーディオ・ファイルが作成されていないことを示しています。
また、フォーマットしたカードのリメイン（記録可能な領域）も表示され、初期設定では「時
間値（00h 28m 56）」で表示します。リメインの値は、時間で表示する以外に「容量」でも表
示できます。表示の変更は、MENUモードのSetupメニューにある“Remain Display”で行な
えます（104ページ参照）。

このようにFAT32でフォーマットしたメモリー・カードは、本機で記録／再生が可能になりま
す。53ページから記載の「第5章　記録／再生」をお読みください。

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

CONTRAST

LIGHT

本機のディスプレイは、用途に合わせてバックライトを点灯させたりコントラストが調整できます。

バックライトの点灯／消灯バックライトの点灯／消灯バックライトの点灯／消灯バックライトの点灯／消灯バックライトの点灯／消灯

＜注意＞：本機を電池で駆動しているときは、電池の消耗を抑えるためにバックライトの使用は極力控
えてください。

[LIGHT/ CONTRAST ] キー

ディスプレイのバックライトとコントラスト調整ディスプレイのバックライトとコントラスト調整ディスプレイのバックライトとコントラスト調整ディスプレイのバックライトとコントラスト調整ディスプレイのバックライトとコントラスト調整

本機フロント・パネル部にある [LIGHT/ CONTRAST ] キーを押すと、ディスプレイのバックライト
が3秒間点灯した後、自動的に消灯します。
また、 [LIGHT/ CONTRAST ] キーを2秒以上押し続けると連続点灯となり、再度 [LIGHT/ CONTRAST ]
キーを押すとバックライトが消灯します。
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11111））））） 停止中に、停止中に、停止中に、停止中に、停止中に、 [SHIFT]  [SHIFT]  [SHIFT]  [SHIFT]  [SHIFT] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [LIGHT [LIGHT [LIGHT [LIGHT [LIGHT/ CONTRAST ] ] ] ] ] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ディスプレイ上に下記ポップアップ画面が表示されます。

22222））））） [+] [+] [+] [+] [+] キー／キー／キー／キー／キー／ [-]  [-]  [-]  [-]  [-] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、コントラストコントラストコントラストコントラストコントラスト・・・・・レベルを調整します。レベルを調整します。レベルを調整します。レベルを調整します。レベルを調整します。
[+] キーを押すとコントラストが強くなり、 [-] キーを押すと弱くなります。

33333））））） 好みのコントラストに調整した後、好みのコントラストに調整した後、好みのコントラストに調整した後、好みのコントラストに調整した後、好みのコントラストに調整した後、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して決定します。キーを押して決定します。キーを押して決定します。キーを押して決定します。キーを押して決定します。
コントラスト調整に入る前のHome画面に戻り、設定値はFlash ROMに保存されます。

ディスプレイのコントラスト調整ディスプレイのコントラスト調整ディスプレイのコントラスト調整ディスプレイのコントラスト調整ディスプレイのコントラスト調整
ディスプレイのコントラストは、本機が停止中にのみ下記操作方法で調整できます。
適度なコントラストで、本機をご使用ください。

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

CONTRAST

LIGHT

QUICK SET

 MENU/
 ENTER

LOCK

MARK

DEL MARK

SHIFT

[LIGHT/ CONTRAST ] キー

[SHIFT] キー

[MENU/ENTER] キー

[+] キー

[-] キー

ポップアップ画面
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リアルタイムリアルタイムリアルタイムリアルタイムリアルタイム・・・・・クロッククロッククロッククロッククロック（（（（（内内内内内蔵蔵蔵蔵蔵時時時時時計計計計計）））））についてについてについてについてについて
本機にはリアルタイム・クロック機能を搭載し、ディスプレイ上に日月時分をリアルタイムに表示し
ます。リアルタイム・クロックのデータは、カード上に新たなオーディオ・ファイルを作成するとき
のファイル・ネーム／ファイル作成日時、記録するBWFファイルのTIME STAMPとして利用され
ます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：記録時に作成されるオーディオ・ファイルのファイルネーム（本機では、デフォルト・ファイル
ネームと呼んでいます）は、工場出荷時の状態では上記「リアルタイム・クロック」のデータが自動的に記
録されるようになっており、ディスプレイ上に下記例（矢印部分）のように表示されます。
このデフォルト・ファイルネームは、MENUモードの“Setup”メニューにある“File Name Mode”でリ
アルタイム・クロックのデータ以外に、SCENE NAME + TAKE NUMBERまたはReel Number + File Num-
berのいずれかに設定することが可能です。なお、SCENE NAME+TAKE NUMBERは、MENUモードの
“Default File Name”において任意に設定することができます。

*“File Name Mode”の設定および“Default File Name”の設定については、後述MENUモードにある“Setup”
メニューの98～101ページを参照してください。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：本機には、リアルタイム・クロックを駆動するための「「「「「リリリリリチチチチチウウウウウムムムムム電電電電電池池池池池」」」」」が内蔵されています。
電池寿命は、通常4～5年です。このリチウム電池の電圧が一定電圧まで低下すると、下記ワーニング・メッ
セージを表示して、電池の交換を警告します（ワーニング・メッセージは [MENU/ENTER] キーを押すと
消えます）。このようなワーニング・メッセージが表示された場合には、当社サービス部門へ電池の交換を
依頼してください（お客様ご自身では交換できません！）。

ファイルネーム

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：リアルタイム・クロックは、工場出荷時の日月時分に設定されて駆動しています。
製品の開梱後、必ず正しい年月日／時刻に設定し直してご使用ください。
リアルタイム・クロックの設定は、後述108ページMENUモードの“Setup”メニューにある“Real Time
Clock”の設定を参照してください。

リアルタイム・クロックのデータ
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メモリーメモリーメモリーメモリーメモリー・・・・・カードについてカードについてカードについてカードについてカードについて
本機にはTYPE IIのCFカード用スロットを搭載し、コンパクトフラッシュ・カードTMが使用できま
す（本機には、工場出荷時128MBのコンパクトフラッシュ・カードTMが一枚標準で付属しており、
スロットに挿入済みです）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：新品で、かつFAT32でフォーマット済みのメモ
リー・カードであればすぐに使用できますが、ご使用前に本
機のMENUモードにある“Disk”メニューの“Format”で、
フォーマットすることをお勧めします。また、FAT32 で
フォーマット済みのメモリー・カードであっても、PCなど
で使用済みのカードを使う場合は、同様に本機でフォーマッ
トすることをお勧めします。“Disk”メニューの“Format”に
ついては86ページを参照してください。

カードの出し入れカードの出し入れカードの出し入れカードの出し入れカードの出し入れ

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：カードの出し入れは、必ず本機の電源をオフにした状態で行ってください。電源が入った
ままカードを抜き差しすると、データが損失したりカードが破損する恐れがありますので、ご注意く
ださい。また、カードを差し込むときは、方向や表裏を間違えないようご注意ください。誤った取り
扱いでカードを破損させた場合、当社では一切の責任を負えませんので、呉々も取り扱いにはご注意
ください。

メモリー・カードは、フロント・パネル部にあるカード・スロットにセットして使用します。
保護カバーを開けると、奥にスロットとイジェクト・ボタンが装備されています。

RECREC STBY

L RMIC TRIM MONITOR

RL

L

R
OL36122448MIC PEAK

L

R
dB

COMPACTFLASH    CARD

カード・スロット

フロント・パネル部のスロット保護カ
バーを開くと、奥にスロットとイジェク
ト・ボタンが見えます。

イジェクト・ボタン



33

FR-2LE Field Memory Recorder（第 2章　ご使用になる前に）

●カードの取り出し●カードの取り出し●カードの取り出し●カードの取り出し●カードの取り出し

下記操作は、工場出荷時本機に付属のメモリー・カード（または他のメモリー・カード）がスロットに挿
入されていることを前提にしています。

11111））））） 本機の電源がオフの状態で保護カバーを開いた後、本機の電源がオフの状態で保護カバーを開いた後、本機の電源がオフの状態で保護カバーを開いた後、本機の電源がオフの状態で保護カバーを開いた後、本機の電源がオフの状態で保護カバーを開いた後、イジェクトイジェクトイジェクトイジェクトイジェクト・・・・・ボタンを一度押します。ボタンを一度押します。ボタンを一度押します。ボタンを一度押します。ボタンを一度押します。
イジェクト・ボタンは「2ステップ方式」を採用しているため、一度押すとスイッチのみが手前に
出てきます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：カードの取り出しは、必ず本機の電源がオフになっていることを確認して行ってください。

22222））））） もう一度イジェクトもう一度イジェクトもう一度イジェクトもう一度イジェクトもう一度イジェクト・・・・・ボタンを押し込みますボタンを押し込みますボタンを押し込みますボタンを押し込みますボタンを押し込みます（（（（（ボボボボボタタタタタンンンンンががががが奥奥奥奥奥ににににに入入入入入っっっっったたたたたままままままままままににににになななななりりりりりままままますすすすす）））））。。。。。
スロットからメモリー・カードがイジェクトされますので、手でカードをつまんで取り出してくだ
さい。

カードを取り出した状態で電源を入れると、ディスプレイには“““““<<No Disk>><<No Disk>><<No Disk>><<No Disk>><<No Disk>>”””””が表示さ
れます。

軽く押す

ボタンのみが手前に
出てきます

強く押し込みます
カードがイジェクトされると共に
イジェクト・ボタンは押し込まれ

たままになります。
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●カードの挿入●カードの挿入●カードの挿入●カードの挿入●カードの挿入

下記操作は、カードが未挿入で本機の電源がオフの状態を前提にしています。

11111））））） カードカードカードカードカード・・・・・スロットへ、スロットへ、スロットへ、スロットへ、スロットへ、メモリーメモリーメモリーメモリーメモリー・・・・・カードを押し込みます。カードを押し込みます。カードを押し込みます。カードを押し込みます。カードを押し込みます。
カードを挿入した後電源をオンにした場合、セットしたメモリー・カードによってつぎのような画
面が表示されます。

RECREC STBY

L RMIC TRIM MONITOR

RL

L

R
OL36122448MIC PEAK

L

R
dB

COMPACTFLASH    CARD
＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：メモリー・カードは、正しい向
きでスロットの奥までしっかり押し込ん
でください。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：イジェクト・ボタンが手前に出たままカードをセットすると、保護カバーを閉めることが
できません。また、保護カバーが閉まらないからと言って、イジェクト・ボタンを押すとカードがイ
ジェクトされてしまいます。メモリー・カードをスロットに挿入するときは、イジェクト・ボタンが
奥に入っていることを確認してください。万一ボタンが手前に出ているときは、ボタンを奥に押し込
んでからカードをスロットにセットしてください。

●●●●●     フォーマット済みで未記録のカードをセットした場合フォーマット済みで未記録のカードをセットした場合フォーマット済みで未記録のカードをセットした場合フォーマット済みで未記録のカードをセットした場合フォーマット済みで未記録のカードをセットした場合

下記例のようなHome画面で立ち上がり、“<<No Audio Files>><<No Audio Files>><<No Audio Files>><<No Audio Files>><<No Audio Files>>”が点灯します。
これは、セットしたカードに一度も記録を行っていないことを示しています。
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* PC* PC* PC* PC* PCなどで使用済みのカードをロードした場合などで使用済みのカードをロードした場合などで使用済みのカードをロードした場合などで使用済みのカードをロードした場合などで使用済みのカードをロードした場合
FAT32でフォーマットされ、かつPCなどで使用済みのカードをローディングしたときも、前
記のように“<No Audio Files><No Audio Files><No Audio Files><No Audio Files><No Audio Files>”の画面で立ち上がります。しかし、カード上に何らかのデー
タが残ってる場合には、本機で記録するための領域が十分でないことがあります。このように、
PCなどで記録したデータが残ったままのカードを使用するときは、後述MENU モードの
“DiskDiskDiskDiskDisk”メニューにある“FormatFormatFormatFormatFormat”で、強制的にフォーマットを実行してください（詳細は86
ページを参照してください）。

●●●●●     フォーマット済みで記録済みのカードをセットした場合フォーマット済みで記録済みのカードをセットした場合フォーマット済みで記録済みのカードをセットした場合フォーマット済みで記録済みのカードをセットした場合フォーマット済みで記録済みのカードをセットした場合

下記例のように、一番最初に記録されたオーディオ・ファイル（ファイル001）が立ち上がり、現
在位置がファイルの先頭であることを示しています。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：MENUモードの“Disk”メニューにある“Resume”機能が“On”に設定されて
いる記録済みカードをセットした場合、前回電源をオフ（またはディスクをイジェクト）す
る前に立ち上がっていたファイルのポジションで立ち上げることが可能です。“Resume”機
能が“Off”の状態では、常に一番最初に記録されたファイルの先頭で立ち上がります。
“Resume”機能のON/OFFについては90ページを参照してください。

●●●●●     未フォーマット未フォーマット未フォーマット未フォーマット未フォーマット（（（（（まままままたたたたたはははははFAT32FAT32FAT32FAT32FAT32以外でフォーマット済）以外でフォーマット済）以外でフォーマット済）以外でフォーマット済）以外でフォーマット済）のカードをセットした場合のカードをセットした場合のカードをセットした場合のカードをセットした場合のカードをセットした場合

下記例のようなワーニング・メッセージに変わり、"Illegal Format!Illegal Format!Illegal Format!Illegal Format!Illegal Format!" が点灯します。
このメッセージは、本機で使用するためにはフォーマットが必要であることを警告しています。
このメッセージが表示されたときは、前述27ページ記載の「メモリー・カードの初期フォーマッ
ト」を参照して、FAT32でフォーマットを実行してください。



36

FR-2LE Field Memory Recorder（第 2章　ご使用になる前に）

ショルダーの取付けショルダーの取付けショルダーの取付けショルダーの取付けショルダーの取付け
付属のショルダーは、下記図を参照してFR-2LE本体に取付けてご使用ください。
なお、使用中にショルダーが外れたりしないよう、正しく取付けてください。

ショルダー

FR-2LE本体
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フロントフロントフロントフロントフロント・・・・・パネル部パネル部パネル部パネル部パネル部

1)1)1)1)1) スロット保護カバースロット保護カバースロット保護カバースロット保護カバースロット保護カバー

22222））））） カードカードカードカードカード・・・・・スロット／イジェクトスロット／イジェクトスロット／イジェクトスロット／イジェクトスロット／イジェクト・・・・・ボタンボタンボタンボタンボタン
コンパクトフラッシュ・カードTMを挿入します。
カードを取り出すときは、イジェクト・ボタンを押します。詳細は32ページ「メモリー・カード
について」を参照してください。

33333））））） [MIC PEAK] [MIC PEAK] [MIC PEAK] [MIC PEAK] [MIC PEAK] インジケータインジケータインジケータインジケータインジケータ
外部マイク（XLR）入力時の、マイク・アンプのピークを表示します。記録時は、このインジケー
タが点灯しないよう [MIC TRIM] を調整します。

44444））））） レベルレベルレベルレベルレベル・・・・・メーターメーターメーターメーターメーター
録音／再生レベルを表示します。

55555））））） 録音レベル調整つまみ録音レベル調整つまみ録音レベル調整つまみ録音レベル調整つまみ録音レベル調整つまみ
外部マイク／ラインの録音レベル（L／R）を調整します（内蔵マイク使用時は機能しません）。

66666））））） [REC] (Record) [REC] (Record) [REC] (Record) [REC] (Record) [REC] (Record) キーキーキーキーキー
録音を開始するときこのキーを押します。
本機では、記録を開始するごとに新たなオーディオ・ファイルが作成されます。
SetupメニューにあるPRE RECモードがONになっているときは、バッファに蓄えられているデー
タ（2秒間）も含めて記録していきます。

77777））））） [REC STBY] (Record Standby) [REC STBY] (Record Standby) [REC STBY] (Record Standby) [REC STBY] (Record Standby) [REC STBY] (Record Standby) キーキーキーキーキー
記録を開始する前にこのキーを押すと、録音スタンバイ状態となりインプット・モニターになりま
す。もう一度押すとインプットモニターが解除されます。また、記録を停止させるときはこのキー
を押します（ [STOP/CANCEL] キーでも停止できます）。

88888））））） [MONITOR] [MONITOR] [MONITOR] [MONITOR] [MONITOR] つまみつまみつまみつまみつまみ
ヘッドホン、内蔵スピーカー、および [MONITOR OUT] からのモニター音量を調整します。
耳に悪い影響を与えないよう、長時間大音量でモニターしないでください。

99999））））） [MIC TRIM] [MIC TRIM] [MIC TRIM] [MIC TRIM] [MIC TRIM] つまみつまみつまみつまみつまみ
外部マイク（XLR入力）で記録する場合、-50dBu～-10dBuの範囲で“MIC PEAK LED”が点灯
しないよう、マイクの入力レベルを調整します。
トリムは、内蔵マイク使用時およびライン入力（PHONE）時は機能しません。

RECREC STBY

L RMIC TRIM MONITOR

RL

L

R
OL36122448MIC PEAK

L

R
dB

1 2 4

56789
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トップトップトップトップトップ・・・・・パネル部パネル部パネル部パネル部パネル部

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

10 11 12 13 14

15

16

17

1819202122

17

1010101010））））） LCDLCDLCDLCDLCDディスプレイディスプレイディスプレイディスプレイディスプレイ
オーディオ信号の入出力レベル、各種設定モードの内容など、多彩な情報を表示します。
詳細は44ページの「ディスプレイ部の詳細」を参照してください。

1111111111））））） [FILE PREV] / [LOC [FILE PREV] / [LOC [FILE PREV] / [LOC [FILE PREV] / [LOC [FILE PREV] / [LOC ] ] ] ] ] キーキーキーキーキー
複数のオーディオ・ファイルが存在する状態でこのキーを押すと、現在立ち上がっているファイル
の前にエントリされているファイルが選択できます。

また、現在立ち上がっているオーディオ・ファイルにCUEポイント（CUE01～99）が登録されて
いる場合、 [SHIFT] キーを押しながらこのキーを押すと現在位置より前に登録されているCUEポイ
ントへロケートします。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：本機を電池で駆動しているときは、電池の消耗を抑えるため、バックライトの使用は極力
控えてください。なお、常時点灯のまま電源を入れ直すとバックライトは常時点灯の状態で立ち上が
ります。

また、 [SHIFT] キーを押しながら [LIGHT/ CONTRAST ] キーを押すと、ディスプレイのコントラスト
が調整できるようになります。詳細は30ページ「ディスプレイのコントラスト調整」を参照してく
ださい。

1212121212））））） [LIGHT / [LIGHT / [LIGHT / [LIGHT / [LIGHT / CONTRAST ] ] ] ] ] キーキーキーキーキー
[LIGHT/ CONTRAST ] キーを一度押すと、ディスプレイのバックライトが3秒間点灯し、自動的に消
灯します。また、キーを2秒以上押し続けるとバックライトが常時点灯になり、もう一度 [LIGHT/
CONTRAST ] キーを押すと消灯します。
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1313131313））））） [FILE NEXT] / [LOC [FILE NEXT] / [LOC [FILE NEXT] / [LOC [FILE NEXT] / [LOC [FILE NEXT] / [LOC ] ] ] ] ] キーキーキーキーキー
複数のオーディオ・ファイルが存在する状態でこのキーを押すと、現在立ち上がっているファイル
の後にエントリされているファイルが選択できます。

また、現在立ち上がっているオーディオ・ファイルにCUEポイント（CUE01～99）が登録されて
いる場合、 [SHIFT] キーを押しながらこのキーを押すと現在位置より後ろに登録されているCUEポ
イントへロケートします。

1414141414））））） [ [ [ [ [ SHIFT  ]  ]  ]  ]  ] キーキーキーキーキー
SHIFT機能を持った各キーを機能させるとき、このキーを押しながらSHIFT機能を持ったキーを押
します。SHIFT機能を持ったキーは、該当するキーの下に四角枠で表記されています。

1515151515））））） [MENU/ENTER] / [MENU/ENTER] / [MENU/ENTER] / [MENU/ENTER] / [MENU/ENTER] / QUICK SET      キーキーキーキーキー
キーを押すとMENUモードへ入ります。MENUモードにおいては、メニューの確定や実行するとき
に押します。また、 [SHIFT] キーを押しながらこのキーを押すと、クイックセットアップ・モード
へ入り、Home画面上で一部のメニューが設定可能になります（55ページ参照）。

1616161616））））） [+] / [+] / [+] / [+] / [+] / LOCK      キーキーキーキーキー
MENUモードなどの編集時、パラメータのアップ・キーとして機能します。
また、 [SHIFT] キーを押しながらこのキーを押すとパネル・ロックのON/OFFができ、パネル・ロッ
クがONになっているときは下記操作キーのみが有効で、その他のキーは受け付けません。

有効な操作キー有効な操作キー有効な操作キー有効な操作キー有効な操作キー：：：：： [REC]  [REC]  [REC]  [REC]  [REC] キー、キー、キー、キー、キー、 [STANDBY]  [STANDBY]  [STANDBY]  [STANDBY]  [STANDBY] キー、キー、キー、キー、キー、  [+/LOCK]   [+/LOCK]   [+/LOCK]   [+/LOCK]   [+/LOCK] キーキーキーキーキー

1717171717））））） 内蔵マイク内蔵マイク内蔵マイク内蔵マイク内蔵マイク（（（（（LLLLLチャンネル／チャンネル／チャンネル／チャンネル／チャンネル／RRRRRチャンネル）チャンネル）チャンネル）チャンネル）チャンネル）
内蔵マイクを使って記録するには、MENUモードのSetupメニューにある“Source Sel”を内蔵マ
イクに設定します（57ページ／93ページを参照）。内蔵マイクは用途に応じて高感度または低感度
が選択できます。

1818181818））））） [MARK] / [-] / [MARK] / [-] / [MARK] / [-] / [MARK] / [-] / [MARK] / [-] / DEL MARK      キーキーキーキーキー
記録／再生／停止中にこのキーを押すと、押したポイントにCUEが記録できます（注意注意注意注意注意：：：：：MP3MP3MP3MP3MP3ののののの
ファイルでは、ファイルでは、ファイルでは、ファイルでは、ファイルでは、記録できません記録できません記録できません記録できません記録できません）。
CUEは、01～99の99個記録することができます。

再生（または停止中）に、 [SHIFT] キーを押しながらこのキーを押すと、押した位置より手前に記
録されているCUEが削除できます。

1919191919））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーキーキーキーキー
再生を開始します。

2020202020））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーキーキーキーキー
ドライブの動作を停止します。MENUモード時にこのキーを押すと、一気にMENUモードから抜け
出すことができます。また、このキーを押しながら [F FWD] キー（または [REWIND] キー）を押
すと、下記動作を実行します。

[STOP] + [REWIND]

最終記録位置（REC END）へ速やかにロケートします。
複数のオーディオ・ファイルが記録されている場合は、一番最後に記録された
オーディオ・ファイルの最終記録位置へロケートします。

[STOP] + [F FWD]

先頭（ABS 0）へ速やかにロケートします。
複数のオーディオ・ファイルが記録されている場合は、一番最初に記録された
オーディオ・ファイルの先頭（ABS 0）へロケートします。
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＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：MP3モードで記録したオーディオ・ファイルは、CUEモードによる再生（キューイング）
は行なえません。

2121212121））））） [F FWD] [F FWD] [F FWD] [F FWD] [F FWD] キーキーキーキーキー
停止状態で押すとファースト・フォワード走行となり、再生中に押すと最大2倍速でフォワード方
向へキューイングを実行します。また、 [STOP/CANCEL] キーを押しながらこのキーを押すと、ファ
イルの最終記録位置（REC END）へロケートします。

2222222222））））） [REWIND] [REWIND] [REWIND] [REWIND] [REWIND] キーキーキーキーキー
停止状態で押すとリワインド走行となり、再生中に押すと最大1倍速でリワインド方向へキューイ
ングを実行します。また、 [STOP/CANCEL] キーを押しながらこのキーを押すと、ファイルの先頭
（ABS 0）へロケートします。

2323232323））））） DC INDC INDC INDC INDC INジャックジャックジャックジャックジャック
付属のACアダプタを接続します（20ページ参照）。

左サイド左サイド左サイド左サイド左サイド・・・・・パネル部パネル部パネル部パネル部パネル部

2424242424））））） [ANALOG IN (L, R)] [ANALOG IN (L, R)] [ANALOG IN (L, R)] [ANALOG IN (L, R)] [ANALOG IN (L, R)] コネクタコネクタコネクタコネクタコネクタ
マイク・レベルまたはライン・レベルのアナログ・オーディオ信号を入力します。
XLR- Phoneのコンボ・タイプのコネクタを採用し、キャノンタイプのコネクタには外部マイクを
接続し、TSフォーン・ジャックには外部ライン入力を接続します（同時接続は不可）。
外部マイクの使用時は、TRIMつまみでL／R独立した入力レベルが調整できます。

HOT
GND

COLD

1
2
3

R

ANALOG IN

L

REMOTE12V

LINE
MICXLR

PHONE

23

2425

25)25)25)25)25) [REMOTE] [REMOTE] [REMOTE] [REMOTE] [REMOTE] ジャックジャックジャックジャックジャック（（（（（ススススステテテテテレレレレレオオオオオ・・・・・ミニジャック）ミニジャック）ミニジャック）ミニジャック）ミニジャック）
本機付属のリモート・コントローラを接続します（52ページ参照）。
録音、録音スタンバイおよびCUEポイントの記録が、コントローラで操作できます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：[ANALOG IN] コネクタを使うときは、クイックセットアップまたはMENUモードのSetup
メニューにある“Source Sel”を、“Input（外部入力）”に設定してください（55ページ／94ペー
ジを参照）。“Source Sel”が内蔵マイクに設定されているときは内蔵マイクが優先となり、 [ANALOG
IN] コネクタは機能しません。
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3030303030））））） バッテリー収納部バッテリー収納部バッテリー収納部バッテリー収納部バッテリー収納部
本機を駆動する電池を収納します。詳細は20ページ「電源について」を参照してください。

バックバックバックバックバック・・・・・パネル部パネル部パネル部パネル部パネル部

右サイド右サイド右サイド右サイド右サイド・・・・・パネル部パネル部パネル部パネル部パネル部

POWER USB

PHONES MONITOR OUT

L R

HOLD
OFF

26 27

2829
2626262626））））） [POWER] [POWER] [POWER] [POWER] [POWER] スイッチスイッチスイッチスイッチスイッチ

本機の主電源をON/OFFします。電源をOFFするときは、ONしたときと同じ方向へ約2秒間押し
上げてください。

2727272727））））） [USB] [USB] [USB] [USB] [USB] ポートポートポートポートポート（（（（（PC ONLYPC ONLYPC ONLYPC ONLYPC ONLY）））））
パソコン接続専用のUSBポートです。
このポートにホスト・コンピュータを接続することで、オーディオ・ファイルのやり取りが可能に
なります。詳細は、52ページ／72ページを参照してください。

2828282828））））） [MONITOR OUT (L, R)] [MONITOR OUT (L, R)] [MONITOR OUT (L, R)] [MONITOR OUT (L, R)] [MONITOR OUT (L, R)] 端子端子端子端子端子（（（（（RCARCARCARCARCA）））））
アナログ・オーディオ信号が出力されます。

29)29)29)29)29) [PHONES] [PHONES] [PHONES] [PHONES] [PHONES] ジャックジャックジャックジャックジャック（（（（（ススススステテテテテレレレレレオオオオオ・・・・・ミニジャック）ミニジャック）ミニジャック）ミニジャック）ミニジャック）
モニター用のヘッドホンを接続します。
PHONESジャックにヘッドホンを差し込むと、内蔵スピーカはミュートされます。

30
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31

3131313131））））） 内蔵モニター内蔵モニター内蔵モニター内蔵モニター内蔵モニター・・・・・スピーカスピーカスピーカスピーカスピーカ
モニター用のスピーカが内蔵されています。
スピーカの音量は [MONITOR] つまみで調整します。

ボトムボトムボトムボトムボトム・・・・・パネル部パネル部パネル部パネル部パネル部

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： [PHONES] ジャックにヘッドホンが接続されているとき、およびインプットモニター
と記録中は、スピーカの出力はミュートされます

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： MENUモードの“Setup”メニューにある“Speaker Out”で、内蔵スピーカの出力
をON/OFFが設定できます（初期設定はONになっています）。詳細は97ページを参照してく
ださい。
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ディスプレイ部の詳細ディスプレイ部の詳細ディスプレイ部の詳細ディスプレイ部の詳細ディスプレイ部の詳細
本機のディスプレイは、132×64ドットのLCDディスプレイを採用し、録音／再生レベル、ファイ
ル情報、カードのリメイン、電池容量、設定情報や内蔵時計のタイム情報などを表示します。

電源投入後のディスプレイ電源投入後のディスプレイ電源投入後のディスプレイ電源投入後のディスプレイ電源投入後のディスプレイ

●メモリー●メモリー●メモリー●メモリー●メモリー・・・・・カードがスロットにセットされていないときカードがスロットにセットされていないときカードがスロットにセットされていないときカードがスロットにセットされていないときカードがスロットにセットされていないとき

カードがセットされていない状態で本機の電源を投入したと
きは、右記表示例で本機が立ち上がります。ディスプレイに
は“<<No Disk>><No Disk>><No Disk>><No Disk>><No Disk>>”が表示され、スロットにメモリー・カー
ドがセットされていないことを示しています。

このように、電源投入後本機が立ち上がった後表示されるディスプレイを「Home画面」と呼び、次
ページ記載の各情報を表示します。通常、録音／再生時などではこのHome画面を表示します。

●●●●●     フォーマット済みで未記録のメモリーフォーマット済みで未記録のメモリーフォーマット済みで未記録のメモリーフォーマット済みで未記録のメモリーフォーマット済みで未記録のメモリー・・・・・カードがセットされているときカードがセットされているときカードがセットされているときカードがセットされているときカードがセットされているとき

FAT32でフォーマットされている未使用のメモリー・カー
ドがセットされている状態で電源を投入（または電源投入後
カードを挿入）すると、右図のようにファイル・ネーム表示
部には“<<No Audio Files>><No Audio Files>><No Audio Files>><No Audio Files>><No Audio Files>>”が点灯し、メモリー・カー
ドの記録可能な容量（Remain）が表示されます。
Remainの表示は、現在MENUモードの“SetupSetupSetupSetupSetup”メニュー
にある“Remain DisplayRemain DisplayRemain DisplayRemain DisplayRemain Display”の設定に基づいて表示され、初期
設定の“TimeTimeTimeTimeTime”（時間表示）以外に“MByteMByteMByteMByteMByte”（容量表示）に
設定することができます（104ページ参照）。

●●●●●     本機で記録済みのメモリー本機で記録済みのメモリー本機で記録済みのメモリー本機で記録済みのメモリー本機で記録済みのメモリー・・・・・カードがセットされているときカードがセットされているときカードがセットされているときカードがセットされているときカードがセットされているとき

既に本機で記録済みのメモリー・カードがセットされている
状態で電源を投入（または電源投入後カードを挿入）する
と、現在記録されているオーディオ・ファイル（File 001）
の先頭を示す、Home画面が表示されます。

本機のディスプレイには、バックライト機能とコントラスト調整機能を搭載しており、ご使用
になる環境に合わせてライトを点灯させたり、コントラストの調整が可能です。
詳しくは、29/30ページをお読みください。
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1

2

ファイルファイルファイルファイルファイル・・・・・ナンバーナンバーナンバーナンバーナンバー/CUE/CUE/CUE/CUE/CUE表示表示表示表示表示

タイム表示タイム表示タイム表示タイム表示タイム表示

3

5

6

7

8

9

10

動作状況の表示動作状況の表示動作状況の表示動作状況の表示動作状況の表示

記録フォーマットの表示記録フォーマットの表示記録フォーマットの表示記録フォーマットの表示記録フォーマットの表示

バッテリーの残量表示バッテリーの残量表示バッテリーの残量表示バッテリーの残量表示バッテリーの残量表示

リアルタイムリアルタイムリアルタイムリアルタイムリアルタイム・・・・・クロック表示クロック表示クロック表示クロック表示クロック表示

レベルレベルレベルレベルレベル・・・・・メータメータメータメータメータ

メモリーカードのリメイン表示メモリーカードのリメイン表示メモリーカードのリメイン表示メモリーカードのリメイン表示メモリーカードのリメイン表示

ファイルファイルファイルファイルファイル・・・・・ネーム表示ネーム表示ネーム表示ネーム表示ネーム表示

現在立ち上がっているオーディオ・ファイルのファイル・ナン
バーと、記録されているCUEナンバーを表示します。

ファイルの現在位置をABS、PRGまたは24H (Time Stamp)で
表示します。表示モードは、MENUモードの“Setup”メニュー
にある“Time Display”で変更できます（初期設定ではABSの
表示モードになっています）。

停止中は“■”、録音中は“●”というように、現在の動作状況
を示すアイコンが表示されます。

フォーマット時設定した記録フォーマットを表示します。

本機をバッテリーで駆動しているとき、内蔵バッテリーの残量を
表示します。バッテリーの交換が必要になったときは、バッテ
リー・アイコンが点滅して警告します。なお、ACアダプタ使用
時はアイコンがフル点灯になります。

本機に内蔵されている、リアルタイム・クロックの時刻・日付を
表示します。正しい時刻・日付は、MENUモードの“Setup”メ
ニューにある“Adjust Real Time Clock”で設定できます。

録音／再生時のレベルを表示します
本機のリファレンス・レベルは-12dBになっています。

メモリー・カードの記録可能な領域を、時間または容量で表示し
ます。表示モードは、MENUモードの“Setup”メニューにある
“Remain Display”で設定できます（初期設定は、時間表示になっ
ています）。

現在立ち上がっているオーディオ・ファイルの、ファイル・ネー
ムを最大16文字まで表示します。ファイル・ネームは、MENU
モードのFile Name ModeおよびDefault File Nameの設定に準
じて記録時自動的に付加され、記録後でもMENUモードの“File”
メニューにある“Rename”で変更することが可能です。

4 QUICK SETUPQUICK SETUPQUICK SETUPQUICK SETUPQUICK SETUPモードのモードのモードのモードのモードの
設定表示設定表示設定表示設定表示設定表示

MENUモードの“Setup”ニューにある設定状況を表示します。
ここに表示されている設定メニューは、 [SHIFT] キーを押しなが
ら [MENU/ENTER] キーを押すとことで、MENUモードへ入る
ことなくHome画面上で設定が可能になります。

1 2 3

4

567

8
9

10
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現在使用しているメモリー・カードには、オーディオ・ファ
イルが作成できないことを警告しています。
不要なファイルを削除するか、別のカードに取り替えてく
ださい。

ワーニングワーニングワーニングワーニングワーニング・・・・・ディスプレイディスプレイディスプレイディスプレイディスプレイ

本機に対する操作の誤りがあったり、入力したデータに不具合があったり、あるいは各種エラー発
生したとき、ディスプレイに「警告表示」を表示します。
ここでは、具体的な警告表示と意味、そして対策方法を記載してあります。万一このような警告表
示が現れたときは、速やかに対処するようにしてください。

本機を駆動しているバッテリーの交換を警告しています。
このメッセージを表示した後、自動的にシャット・ダウン
します。速やかに新しいバッテリーと交換してください。

リアルタイム・クロックを駆動しているバッテリーの交換
を警告しています。このメッセージは電投入時に表示され
ます。当社サービス部門へ電池交換を依頼してください。

スロットに挿入したメモリー・カードの不良を警告してい
ます。他のメモリー・カードと交換してください。

現在使用しているメモリー・カードの空き容量不足を警告
しています。
十分な記録容量のあるメモリー・カードに取り替えてくだ
さい。

MENUMENUMENUMENUMENUモードのディスプレイモードのディスプレイモードのディスプレイモードのディスプレイモードのディスプレイ

停止状態で [MENU/ENTER] キーを押すとMENUモードに
入り、Home画面から右図のMENUモード画面に変ります。
MENUモードのメイン・メニューには、Fileメニュー、Disk
メニュー、Setupメニュー、そしてUSB Modeメニューが
あり、用途に応じた各種設定が行なえます。
メニュー・タイトルの右に表示されている“ ”は、複数の
階層ページがあることを示しています。
MENUモードの詳細は、77ページからの説明をお読みくだ
さい。
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オーディオ・ファイルのファイル・ネームを再登録しよう
としたとき、既に同じネームのファイルが存在すること
を警告しています。別のネームを入力して登録してくだ
さい。

オーディオ・ファイルのファイル・ネームを再登録しよう
としたとき、入力したネームが不正であることを警告し
ています。正しいネームを入力して登録してください。

カード・スロットに、メモリー・カードがセットされてい
ないことを警告します。MENUモードの設定（Setupメ
ニュー除く）を実行しようとしたときに表示されます。
メモリー・カードをセットしてから設定を行ってくださ
い。
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第第第第第44444章　基章　基章　基章　基章　基     本本本本本     接接接接接     続続続続続

＜目　　次＞＜目　　次＞＜目　　次＞＜目　　次＞＜目　　次＞
オーディオ信号の接続オーディオ信号の接続オーディオ信号の接続オーディオ信号の接続オーディオ信号の接続......................................................................................................................................50......................................................................................................................................50......................................................................................................................................50......................................................................................................................................50......................................................................................................................................50

外部マイクロホンの接続....................................................................................................................................50

外部オーディオ機器のライン出力を接続....................................................................................................50

モニター出力の接続.............................................................................................................................................51

ヘッドホンの接続..................................................................................................................................................51

その他の接続その他の接続その他の接続その他の接続その他の接続........................................................................................................................................................52........................................................................................................................................................52........................................................................................................................................................52........................................................................................................................................................52........................................................................................................................................................52

PCとの接続.............................................................................................................................................................52

リモート・コントローラの接続.......................................................................................................................52

ここでは、基本的な本機の接続について説明します。



50

FR-2LE Field Memory Recorder（第 4章　基本接続）

外部オーディオ機器のライン出力を接続外部オーディオ機器のライン出力を接続外部オーディオ機器のライン出力を接続外部オーディオ機器のライン出力を接続外部オーディオ機器のライン出力を接続

外部オーディオ機器のライン出力は、 [ANALOG IN] のTS PHONEジャックに接続します。
TS PHONEジャックを使用するときは、基準入力 -10dBVのアナログ・オーディオ信号が入
力できます。

オーディオ信号の接続オーディオ信号の接続オーディオ信号の接続オーディオ信号の接続オーディオ信号の接続

R

ANALOG IN

LHOT
GND

COLD

1
2
3

REMOTE12V

LINE
MICXLR

PHONE

本機の [ANALOG IN] は、バランス式のXLR-3-31タイプ（2番ホット）コネクタとTS PHONEジャッ
クのコンボ・タイプを採用し、マイク・レベルまたはライン・レベルの音源が入力できます。

[ANALOG IN] に外部マイクロホン、または外部オーディ機器のライン出力を接続して記録する場合
は、MENUモードの“Setup”メニューにある“Source Sel”を、外部入力（Input）に設定します
（内蔵マイクで記録するときは“Source Sel”を“I. MIC L”または“I. MIC H”に設定します）。詳
細は57ページ／94ページを参照してください。

外部マイクロホンは、 [ANALOG IN] のXLRコネクタに接続します。
XLRコネクタを使用するときは、基準入力 -50dBu～ -10dBuのアナログ・オーディオ信号が
入力でき、 [TRIM] つまみでL/R独立した入力レベルを調整します。

外部マイクロホンの接続外部マイクロホンの接続外部マイクロホンの接続外部マイクロホンの接続外部マイクロホンの接続

外部マイクロホンでの記録時に有効な HPF（ハイパス・フィルター）機能や、リミッタ機能を
搭載し、高音質での録音が可能です。さらにはコンデンサ・タイプのマイクに必要なファンタ
ム電源（+48V）も供給できます。HPF機能／リミッタ機能のON/OFFについては55ページ/
92ページ、ファンタム電源のON/OFFについては95ページを参照してください。

R

ANALOG IN

LHOT
GND

COLD

1
2
3

REMOTE12V

LINE
MICXLR

PHONE

[ANALOG IN] の
XLRコネクタ

外部オーディオ機器

[ANALOG IN] の
PHONEジャック
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モニター出力の接続モニター出力の接続モニター出力の接続モニター出力の接続モニター出力の接続

外部モニター機器などは、右サイド・パネルの {MONITOR OUT] 端子（RCAピンジャック）
に接続します。モニターの音量は [MONITOR] つまみで調整します。

POWER USB

PHONES MONITOR OUT

L R

HOLD
OFF

ヘッドホンの接続ヘッドホンの接続ヘッドホンの接続ヘッドホンの接続ヘッドホンの接続

モニター用のヘッドホンは、右サイド・パネルの [PHONES] 端子（ミニPHONE）に接続しま
す。ヘッドホンの音量は [MONITOR] つまみで調整できます。

POWER USB

PHONES MONITOR OUT

L R

HOLD
OFF

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： [PHONES] ジャックにヘッドホンを接続すると、内蔵モニター・スピーカからは出力さ
れなくなります。

モニター信号は、MENUモードの“Setup”メニューにある“Monitor Mode”で、ステレオま
たはモノラル信号の選択が可能です（初期設定はステレオ出力になっています）。
また、 [MONITOR OUT] 端子からは、オーディオ信号以外にエラー・トーンも出力されます。
“Monitor Mode”の設定については96ページ、エラー・トーン出力については107ページを
参照してください。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： [PHONES] ジャックにヘッドホンを接続すると、内蔵モニター・スピーカからは出力さ
れなくなります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：大音量で長時間ヘッドホンを使用しないでください。耳に悪い影響を与えることがありま
す。

パーソナル・モニターパーソナル・モニター

[PHONES] ジャック

[MONITOR OUT L, R] ジャック
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FR-2LEには、PCとダイレクトに接続可能な [USB] 端子を備えています。
PCと本機の [USB] 端子を接続することで、PC側から本機のメモリー・カードをコントロー
ルして、オーディオ・ファイルの取り込みが可能になります。パソコンと接続してオーディオ・
ファイルを取り込むには、後述69ページ「第6章PCへのインポート」を参照してください。

FR-2LEには、本機付属のリモート・コントローラ専用の [REMOTE] 端子を搭載しています。
リモート・コントローラを接続することで、記録スタンバイ／オーディオ信号の記録／CUEの
記録をコントローラで操作できます。

PCPCPCPCPCとの接続との接続との接続との接続との接続

リモートリモートリモートリモートリモート・・・・・コントローラの接続コントローラの接続コントローラの接続コントローラの接続コントローラの接続

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：PCと接続して使用するには、あらかじめMENUモードの“Setup”メニューにある“USB
MODE”メニューのUSB Device Modeを設定します（詳細は71ページを参照してください）。

その他の接続その他の接続その他の接続その他の接続その他の接続

POWER USB

PHONES MONITOR OUT

L R

HOLD
OFF

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：接続用のUSBケーブルは本機に付属されていません。
本機 [USB] ポートの規格に適合した、市販のUSBケーブルをお買い求めください。

R

ANALOG IN

LHOT
GND

COLD

1
2
3

REMOTE12V

LINE
MICXLR

PHONE

STBYRECMARK

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：本機付属の「リモコン固定ベ
ルト」は、右図のようにリモコン本体裏へ取付け、ショ
ルダーや外部マイクに固定してご使用いただけます。

また、右図矢印部分には、ストラップも取り付けが可能
になっています。用途に合わせてご利用ください。

[REMOTE] ジャック リモート・コントローラ

リモコン固定ベルト

[USB] ポート

USBケーブル
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第第第第第55555章　記章　記章　記章　記章　記     録録録録録     ／／／／／     再再再再再     生生生生生
ここでは、FR-2LEの基本的なオーディオ信号の記録／再生、さらにはCUEポイントの記録、スキップ／ロケート
機能などについて記載しています。

＜目　　次＞＜目　　次＞＜目　　次＞＜目　　次＞＜目　　次＞
記録方式について記録方式について記録方式について記録方式について記録方式について...............................................................................................................................................54...............................................................................................................................................54...............................................................................................................................................54...............................................................................................................................................54...............................................................................................................................................54

記録開始前の設定について記録開始前の設定について記録開始前の設定について記録開始前の設定について記録開始前の設定について.............................................................................................................................55.............................................................................................................................55.............................................................................................................................55.............................................................................................................................55.............................................................................................................................55

クイックセットアップ・モードでの設定....................................................................................................55
クイックセットアップ・モードの設定手順.............................................................................................56
ALC (Auto Level Control) 機能の設定（必要に応じて設定）...........................................................57
HPF (High Pass Filter) 機能の設定（必要に応じて設定）..................................................................57
ファンタム電源の供給（必要に応じて設定）..........................................................................................57
記録ソースの設定（記録時は必ず設定）...................................................................................................57

MENUモードでの設定........................................................................................................................................58
デフォルト・ファイル・ネーム（必要に応じて設定）........................................................................58
プリ・レコーディング機能（必要に応じて設定）.................................................................................58
ファイルの最大記録容量（必要に応じて設定）.....................................................................................59
モニターの出力モード（必要に応じて設定）..........................................................................................59
エラー・トーンの出力モード（必要に応じて設定）............................................................................59
ディスプレイの表示モード（必要に応じて設定）.................................................................................59

オーディオ信号の記録オーディオ信号の記録オーディオ信号の記録オーディオ信号の記録オーディオ信号の記録......................................................................................................................................60......................................................................................................................................60......................................................................................................................................60......................................................................................................................................60......................................................................................................................................60
入力ゲインの調整..................................................................................................................................................60
録音レベルの調整..................................................................................................................................................60

外部入力（外部マイクまたはライン入力）での記録時......................................................................60
内蔵マイクでの記録時......................................................................................................................................61

記録の開始................................................................................................................................................................62

CUECUECUECUECUEポイントの記録ポイントの記録ポイントの記録ポイントの記録ポイントの記録.........................................................................................................................................63.........................................................................................................................................63.........................................................................................................................................63.........................................................................................................................................63.........................................................................................................................................63
任意の位置にCUEを記録..................................................................................................................................63
記録したCUEポイントの確認..................................................................................................................64
CUEポイントをリアルタイムに削除.....................................................................................................64

オーディオオーディオオーディオオーディオオーディオ・・・・・ファイルの再生ファイルの再生ファイルの再生ファイルの再生ファイルの再生........................................................................................................................65........................................................................................................................65........................................................................................................................65........................................................................................................................65........................................................................................................................65
通常の再生................................................................................................................................................................65
キューイング・モードによる再生..................................................................................................................66

ロケート機能ロケート機能ロケート機能ロケート機能ロケート機能........................................................................................................................................................66........................................................................................................................................................66........................................................................................................................................................66........................................................................................................................................................66........................................................................................................................................................66
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記録方式について記録方式について記録方式について記録方式について記録方式について
本機の記録方式は、FAT32 (File Allocation Table 32) のファイル・システムに準拠し、ファイル・
フォーマットは最も一般的なBWF (Broadcast Wave File) と、MP3 (MPEG-1 Audio Layer3) を採
用しています。

トラック・モードはステレオ（L/R）での記録が可能で、L、R 2つのオーディオ・データが１つのBWF
ファイル（またはMP3ファイル）として保存されます。

そして、記録したBWFファイルはCFC上に作成される“BWFF”フォルダー内に格納され、MP3ファ
イルは“MP3F”フォルダー内に格納されます（下図を参照）。なお、なお、なお、なお、なお、本機は本機は本機は本機は本機は「「「「「11111テイクテイクテイクテイクテイク・・・・・11111ファイル」ファイル」ファイル」ファイル」ファイル」
方式で、方式で、方式で、方式で、方式で、記録を開始するごとに新たなオーディオ記録を開始するごとに新たなオーディオ記録を開始するごとに新たなオーディオ記録を開始するごとに新たなオーディオ記録を開始するごとに新たなオーディオ・・・・・ファイルがカード上に作成され、ファイルがカード上に作成され、ファイルがカード上に作成され、ファイルがカード上に作成され、ファイルがカード上に作成され、上書きは行えま上書きは行えま上書きは行えま上書きは行えま上書きは行えま
せん。せん。せん。せん。せん。

本機で記録したオーディオ・ファイルは、本機とPCを接続して相互間でファイルのやり取りができ
ます。そのため、記録したオーディオ・ファイルをPCのハードディスクへコピーしたり、Digidesign
Pro Toolsなどのコンピュータ・ソフトへインポートすることが可能になります。

下記表は、記録容量1GBのメモリー・カードを使用した場合の記録可能な時間をまとめたものです。
この時間はメーカなどによって異なる場合がありますので、あくまでもおおよその「目安」としてご
利用ください。

記録フォーマット記録フォーマット記録フォーマット記録フォーマット記録フォーマットFS/BITFS/BITFS/BITFS/BITFS/BIT

44.1kHz / 16bitのBWFファイル・モード

44.1kHz / 24bitのBWFファイル・モード

48kHz / 16bitのBWFファイル・モード

最大記録時間最大記録時間最大記録時間最大記録時間最大記録時間

約96分

約64分

約90分

CFC

BWFF

*****.wav

*****.wav

*****.wav

CFC

MP3F

*****.mp3

*****.mp3

*****.mp3

48kHz / 24bitのBWFファイル・モード

88.2kHz / 24bitのBWFファイル・モード

96kHz / 24bitのBWFファイル・モード

約60分

約32分

約30分

PM3 /192kbpsの圧縮ファイル・モード 約670分
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上記表の1～4は、MENUモードのSetupメニュー以外に、クイックセットアップ・モードで設定す
ることができます。具体的な設定方法については次ページを参照してください。

記録開始前の設定について記録開始前の設定について記録開始前の設定について記録開始前の設定について記録開始前の設定について
オーディオ信号を記録する前に、用途に合わせた動作環境を設定します。
記録時に必要な「動作環境の設定」には下記の項目があり、必要に応じて初期設定を変更してご使用
いただけます。これらの設定は、MENUモードの “Setup”メニューで行うことができますが、下記
1～4はクイックセットアップ・モードで設定することが可能です。

設　定　内　容設　定　内　容設　定　内　容設　定　内　容設　定　内　容 選択可能な設定項目選択可能な設定項目選択可能な設定項目選択可能な設定項目選択可能な設定項目
OFF、ON、LIMIT11111

初期設定初期設定初期設定初期設定初期設定
Auto Level Control/Limiter機能

22222

33333

44444

55555

66666

77777

88888

99999

High Pass Filter機能

ファンタム電源

ファイル・ネーム・モード

Pre Record機能

ファイルの最大記録容量

モニターの出力モード

エラー・トーンの出力モード

OFF、ON

OFF、ON

Take、Date、Reel

OFF、ON

2G、4G

L/R (stereo)、MONO

OFF、ON

OFF

OFF

OFF

Date

OFF

2G

L/R

OFF

クイックセットアップクイックセットアップクイックセットアップクイックセットアップクイックセットアップ・・・・・モードでの設定モードでの設定モードでの設定モードでの設定モードでの設定

クイックセットアップクイックセットアップクイックセットアップクイックセットアップクイックセットアップ・・・・・モードモードモードモードモード：：：：：
クイックセットアップ・モードとは、記録に必要な設定をHome画面上で行うためのモー
ドで、MENUモードへ入るための操作を省いて、速やかに設定を行なうモードです。

具体的な設定は、下記Home画面に表示されている4つのアイコンを使います。
次ページの「設定手順」を参照してください。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：クイックセットアップ・モードで設定した内容は、リアルタイムにMENUモードの
“Setup”メニューにある各メニューにも反映されます。逆に、MENUモードで設定した内容は
Home画面上のアイコンに表示されます。

1010101010 内蔵スピーカの出力モード OFF、ON ON

記録ソース INPUT、I. MIC L、I. MIC H INPUT

1111111111 ディスプレイの表示モード ABS、PGM、24H ABS
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クイックセットアップ・モードの設定は、下記の操作キーを使用します。

クイックセットアップクイックセットアップクイックセットアップクイックセットアップクイックセットアップ・・・・・モードの設定手順モードの設定手順モードの設定手順モードの設定手順モードの設定手順

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

MARK

DEL MARK

QUICK SET

ENTER
MENU /

LOCK

STOP/CANCEL

SHIFT

1)1)1)1)1) 停止している状態で、停止している状態で、停止している状態で、停止している状態で、停止している状態で、 [SHIFT]  [SHIFT]  [SHIFT]  [SHIFT]  [SHIFT] キーを押しながらキーを押しながらキーを押しながらキーを押しながらキーを押しながら [MENU/ENTER] / [MENU/ENTER] / [MENU/ENTER] / [MENU/ENTER] / [MENU/ENTER] / QUICK SET キーを押しキーを押しキーを押しキーを押しキーを押し
ます。ます。ます。ます。ます。
Home画面上にある“ ”アイコンの“ ”のみが点滅します。

これは、現在設定可能なメニューが “ALC (Auto Level Control)”になっていることを示し、 [+]
キー／ [-] キーを押すことで点滅するアイコンが下記順で移動します。

2)2)2)2)2) [+] [+] [+] [+] [+] キー／キー／キー／キー／キー／[-] [-] [-] [-] [-] キーで希望のメニューを選択して、キーで希望のメニューを選択して、キーで希望のメニューを選択して、キーで希望のメニューを選択して、キーで希望のメニューを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したメニューの現在の設定が点滅して、変更可能な状態になります。
例として、“ ”を選択して [MENU/ENTER] キーを押すと、初期設定の“ ”が点滅します。

3)3)3)3)3) [+] [+] [+] [+] [+] キー／キー／キー／キー／キー／[-] [-] [-] [-] [-] キーで希望の設定を選択して、キーで希望の設定を選択して、キーで希望の設定を選択して、キーで希望の設定を選択して、キーで希望の設定を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した項目に設定され、メニュー・アイコンの点滅に変ります。
他のメニューを設定するには、同じ要領で操作2と3を繰り返します。

4)4)4)4)4) 設定後設定後設定後設定後設定後 [STOP/CANCEL]  [STOP/CANCEL]  [STOP/CANCEL]  [STOP/CANCEL]  [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、クイックセットアップクイックセットアップクイックセットアップクイックセットアップクイックセットアップ・・・・・モードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出しモードから抜け出し
ます。ます。ます。ます。ます。
各メニューの詳細については、次ページからの説明を参照してください。

 [ - ] キー

 [ + ] キー

 [MENU/ENTER] キー [SHIFT] キー

 [STOP/CANCEL] キー
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記録時のオート・レベル・コントロールのON/OFFまたはリミッター機能を有効にします。
特にマイクで記録するときは、リミッター機能を使うことで、安定した信号レベルを確保する
ことができます（L、R両チャンネルに有効です）。

ALC (Auto Level Control) ALC (Auto Level Control) ALC (Auto Level Control) ALC (Auto Level Control) ALC (Auto Level Control) 機能の設定機能の設定機能の設定機能の設定機能の設定（（（（（必必必必必要要要要要ににににに応応応応応じじじじじててててて設設設設設定定定定定）））））

ONONONONON オート・レベル・コントロール機能が有効になります。

LIMITLIMITLIMITLIMITLIMIT

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：ALC (Auto Level Control) 機能の設定は、MENUモードの“Setup”メ
ニューにある“ALC”でも設定できます（91ページ参照）。

リミッター機能が有効になります。

OFFOFFOFFOFFOFF（（（（（初初初初初期期期期期設設設設設定定定定定））））） ALC機能はすべて無効になります。

フィルター機能のON/OFFを設定します（初期設定は“OFF”になっています）。
本機のフィルター回路は、カットオフ周波数100Hzのハイパス・フィルターで、-12dB/octに
調整できます。外部マイクを使って屋外で記録するときなど、風のノイズや不要な低周波ノイ
ズを除去するのに効果を発揮します（L、R両チャンネルに有効です）。

HPF (High Pass Filter) HPF (High Pass Filter) HPF (High Pass Filter) HPF (High Pass Filter) HPF (High Pass Filter) 機能の設定機能の設定機能の設定機能の設定機能の設定（（（（（必必必必必要要要要要ににににに応応応応応じじじじじててててて設設設設設定定定定定）））））

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：HPF (High Pass Filter) 機能の設定は、MENUモードの“Setup”メニュー
にある“HPF”でも設定できます（92ページ参照）。

ファンタム電源のON/OFFを設定します（初期設定は“OFF”になっています）。
ファンタム電源を必要とするコンデンサ・タイプの外部マイクで記録するときは、必ず “ON”
に設定してご使用ください。ファンタム電源は、 [ANALOG IN] のXLRコネクタに供給されま
す（L、R両チャンネルに有効です）。

ファンタム電源の供給ファンタム電源の供給ファンタム電源の供給ファンタム電源の供給ファンタム電源の供給（（（（（必必必必必要要要要要ににににに応応応応応じじじじじててててて設設設設設定定定定定）））））

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：ファンタム電源の設定は、MENU モードの“Setup”メニューにある
“Phantom”でも設定できます（95ページ参照）。

記録する音源を外部入力（外部マイクまたはライン入力）にするか、内蔵マイクにするかを設
定します（初期設定は外部入力になっています）。なお、内蔵マイクを使うときは、記録する音
の大きさや距離に応じて、高感度マイクまたは低感度マイクのいずれかに選択できます。

記録ソースの設定記録ソースの設定記録ソースの設定記録ソースの設定記録ソースの設定（（（（（記記記記記録録録録録時時時時時ははははは必必必必必ずずずずず設設設設設定定定定定）））））

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：記録ソースの設定は、MENUモードの“Setup”メニューにある“Source
Sel”でも設定できます（94ページ参照）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：内蔵マイクでの記録時は、 [MIC TRIM] つまみや録音レベルつまみは機能しません。

I MIC LI MIC LI MIC LI MIC LI MIC L 低感度（16dB）での内蔵マイクが有効になります。

I MIC HI MIC HI MIC HI MIC HI MIC H 高感度（32dB）での内蔵マイクが有効になります。

INPUTINPUTINPUTINPUTINPUT（（（（（初初初初初期期期期期設設設設設定定定定定））））） [ANALOG IN] に接続する外部入力（マイクまたはライン入力）が有効になります。



58

FR-2LE Field Memory Recorder（第 5章　記録／再生）

プリ・レコーディング機能とは、記録を開始する前にバッファに貯えられていたオーディオ・
データ（約2秒間）も含めて記録していく機能で、記録開始時の記録漏れを防止することがで
きます。

プリ・レコーディング機能を“ON”（初期設定は“OFF”）に設定して記録を開始すると、バッ
ファに貯えられているオーディオ・データも含めて記録し、記録の終了時には記録開始時の遅
延分Post Recordingを実行してから停止します。

使用上の都合で、プリ・レコーディング機能を“ON”に設定するには、MENUモードの“Setup”
メニューにある“Pre Rec”で設定を変更してご使用ください（102ページ参照）。

プリプリプリプリプリ・・・・・レコーディング機能レコーディング機能レコーディング機能レコーディング機能レコーディング機能（（（（（必必必必必要要要要要ににににに応応応応応じじじじじててててて設設設設設定定定定定）））））

前述のクイックセットアップ・モード以外に、MENUモードの“Setup”メニューで用途に応じた動
作環境を設定します。

MENUMENUMENUMENUMENUモードでの設定モードでの設定モードでの設定モードでの設定モードでの設定

記録を開始すると、メモリー・カード上にオーディオ・ファイルが作成され、自動的にファイ
ル・ネームが付加されます。ファイル・ネームは、MENUモードの“Setup”メニューにある
“File Name Mode”と“Def. File Name”で設定します。
初期設定の状態では“File Name Mode”が“Date”に設定されているため、下記例のように
記録開始時のタイム情報がフォルト・ファイル・ネームとして付加されます。

● BWFで記録した場合：B15h20m35s20jun2006.wav

● MP3で記録した場合：B15h20m35s20jun2006.mp3

必要に応じて“File Name Mode”を “Take”または “Reel”に設定することで、下記ファ
イル・ネームに変更することができます。

“““““TakeTakeTakeTakeTake”””””設定時設定時設定時設定時設定時：：：：：

● BWFで記録した場合：Scene Name + Take Number.wav

● MP3で記録した場合：Scene Name + Take Number.mp3

* Scene NameとTake Numberは、“Setup”メニューの“Def. File Name”で設定します。

“““““ReelReelReelReelReel”””””設定時設定時設定時設定時設定時：：：：：

● BWFで記録した場合：Reel Number + File Number.wav

● MP3で記録した場合：Reel Number + File Number.mp3

デフォルトデフォルトデフォルトデフォルトデフォルト・・・・・ファイルファイルファイルファイルファイル・・・・・ネームネームネームネームネーム（（（（（必必必必必要要要要要ににににに応応応応応じじじじじててててて設設設設設定定定定定）））））

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：作成されたオーディオ・ファイルのファイル・ネームは、記録後でもMENU
モードの“File”メニューにある“Rename”で変更できます（詳細は81ページ参照）。
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本機では、記録するオーディオ・ファイルの最大記録容量に制限があり、初期設定では“2GB”
に設定されています。これは、FR-2LEで記録したオーディオ・ファイルをパソコンへインポー
トする際、使用するパソコン側のインポート可能な容量に合わせるための設定です。

ファイルの最大記録容量は、初期設定の“2GB”以外に“4GB”が選択できます。
用途に合わせて変更するときは、MENUモードの“Setup”メニューにある “Max File Size”
で変更してください（105ページ参照）。

ファイルの最大記録容量ファイルの最大記録容量ファイルの最大記録容量ファイルの最大記録容量ファイルの最大記録容量（（（（（必必必必必要要要要要ににににに応応応応応じじじじじててててて設設設設設定定定定定）））））

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：設定されている最大記録容量まで記録すると、自動的に記録を終了して停止します。なお、
最大記録容量以下のメモリー・カードを使用している場合は、設定に関わらずカードの残容量が無く
なった時点で記録を終了します。

ヘッドホン、および [MONITOR OUT] 端子からは、記録／再生中のオーディオ信号がモニター
できます。なお、記録時は内蔵スピーカの出力はOFFになります。出力するモニター音は、
MENUモードの“Setup”メニューにある“Monitor Mode”で、ステレオ出力またはモノラル
出力の選択ができます。初期設定ではステレオ出力になっています（96ページ参照）。

モニターの出力モードモニターの出力モードモニターの出力モードモニターの出力モードモニターの出力モード（（（（（必必必必必要要要要要ににににに応応応応応じじじじじててててて設設設設設定定定定定）））））

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：本機を電池で駆動しているときは、電池の消耗を抑えるため、必要以上にモニターの音量
を上げないようにしてください。

メモリー・カードの記録可能な容量が少なくなったとき、および電池の残量が少なくなったと
き、エラー・トーンを出力して警告します。

エラー・トーンの出力モードはMENUモードの“Setup”メニューにある“Error Tone”でON/
OFFが設定できます。初期設定は“Off”に設定されていていますので、エラー・トーンを出力
したい場合は、“Error Tone”を“On”に設定し直してご使用ください（後述107ページを参
照）。

エラーエラーエラーエラーエラー・・・・・トーンの出力モードトーンの出力モードトーンの出力モードトーンの出力モードトーンの出力モード（（（（（必必必必必要要要要要ににににに応応応応応じじじじじててててて設設設設設定定定定定）））））

初期設定の状態では、本機ディスプレイのタイム表示モードはABSになっています。
このモードは、一番最初に記録するオーディオ・ファイルの先頭を0（ABS 0）としてカウン
トアップしていき、つぎに記録するオーディオ・ファイルも連続してカウントする表示になっ
ています。

このタイム表示は、ABSモード以外に“PRG”または“24H”モードに切り換えてご使用いた
だけますので、用途に応じて設定してください（103ページを参照）。

ディスプレイのタイム表示ディスプレイのタイム表示ディスプレイのタイム表示ディスプレイのタイム表示ディスプレイのタイム表示（（（（（必必必必必要要要要要ににににに応応応応応じじじじじててててて設設設設設定定定定定）））））
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オーディオ信号の記録オーディオ信号の記録オーディオ信号の記録オーディオ信号の記録オーディオ信号の記録
下記操作は、前述のクイックセットアップ・モードやMENUモードにおいて、記録に必要な動作環境
の設定が行われ、メモリー・カードには何も記録されていない状態（“<<No Audio Files>>”を表示）
を前提にしています。

[ANALOG IN] のXLRコネクタに外部マイクを接続して記録するときは、 [MIC TRIM] つまみで最適
な入力ゲインを調整します（ライン入力、および内蔵マイクでの記録時は、 [MIC TRIM] は機能しま
せん）。

入力ゲインの調整入力ゲインの調整入力ゲインの調整入力ゲインの調整入力ゲインの調整

RECREC STBY

L RMIC TRIM MONITOR

RL

L

R
OL36122448MIC PEAK

L

R
dB

L RMIC TRIM [MIC TRIM] は -50dBu～ -10dBuの範囲で
調整でき、時計方向いっぱいに回すと -50dBu
の入力で適切なゲインが得られ、反時計方向
いっぱいに回すと-10dBuの入力で適切なゲイ
ンが得られます。

記録する音源に合わせて、最適な録音レベルを調整します。

録音レベルの調整録音レベルの調整録音レベルの調整録音レベルの調整録音レベルの調整

●●●●●     外部入力外部入力外部入力外部入力外部入力（（（（（マママママイイイイイクククククまままままたたたたたはははははララララライイイイインンンンン入入入入入力力力力力）））））での記録時での記録時での記録時での記録時での記録時

[REC STBY] キーを押して本機をインプットモニター状態にして、フロント・パネル部のLEDレベ
ル・メータおよびディスプレイのレベル・メータを監視しながら、録音レベル調整つまみで最適な録
音レベルを調整します。

特にマイク入力時では、レベル・メータの [MIC PEAK] インジケータが点灯しないよう、 [MIC TRIM]
を調整します（次ページ参照）。

RECREC STBY

L RMIC TRIM MONITOR

RL

L

R
OL36122448MIC PEAK

L

R
dB

[REC STBY] キー 録音レベル調整つまみ
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●●●●●     内蔵マイクでの記録時内蔵マイクでの記録時内蔵マイクでの記録時内蔵マイクでの記録時内蔵マイクでの記録時

[REC STBY] キーを押して本機をインプットモニター状態にして、フロント・パネル部のLEDレベ
ル・メータおよびディスプレイのレベル・メータを監視しながら、内蔵マイクの向きや音源との距離
を調整しながら、最適な録音レベルを決定します（注意：内蔵マイク使用時は、レベル調整つまみは
機能しません）。

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

MIC RMIC L

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：　　　　　録音レベルは、ディスプレイのレベル・メータ、およびフロントパネル部のLEDレベル・メー
タが、“0dB0dB0dB0dB0dB”を越えないように設定してください。
最善なS/Nを実現するためには、“0dB0dB0dB0dB0dB”に近くかつ“0dB0dB0dB0dB0dB”を越えないように設定することをお薦めしま
す。各レベル・メータの“OLOLOLOLOL (Over Level)”部が頻繁に点滅する場合は、音に歪みを生じてしまいます。
また、LEDレベル・メータの“MIC PEAKMIC PEAKMIC PEAKMIC PEAKMIC PEAK”インジケータは、マイク・アンプ部のピークを表示します。マ
イク入力時ではこの“MIC PEAK”インジケータが点灯しないよう、 [MIC TRIM] を調整してください。
なお、本機のリファレンス・レベルは“-12dBFS-12dBFS-12dBFS-12dBFS-12dBFS”になっており、24bitフル・スケール・レベル（0dB）
から“-12dB-12dB-12dB-12dB-12dB”のポイントが、リファレンス・マーカーになっています。

L
-dB

R
OL36122448MIC PEAK

L

R
LEDレベル・メータ

ディスプレイのレベル・メータ

リファレンス
マーカー

リファレンス
マーカー

OL

OL

“MIC PEAK”
インジケータ
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＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：本機では、 [SHIFT] キーを押
しながら [+] / LOCK  キーを押すと、操作パネルをロッ
クすることができます。パネル・ロックされると、 [REC]
キーと [REC STBY] キーの操作キー以外はすべてロッ
クされるため、誤操作を防ぐことができます。なお、パ
ネル・ロックされるとディスプレイには“鍵”アイコン
が点灯します。

最適な録音レベルが調整できたら、記録を開始します。

本機では、記録を繰り返すごとに新たなオーディオ・ファイルがメモリー・カード上に作成されます。
なお、本機では同一のオーディオ・ファイルに追記録することはできません。

記録の開始記録の開始記録の開始記録の開始記録の開始

RECREC STBY

L RMIC TRIM MONITOR

RL

L

R
OL36122448MIC PEAK

L

R
dB

1)1)1)1)1) インプットモニターの状態から、インプットモニターの状態から、インプットモニターの状態から、インプットモニターの状態から、インプットモニターの状態から、 [REC]  [REC]  [REC]  [REC]  [REC] キーを横へスライドさせます。キーを横へスライドさせます。キーを横へスライドさせます。キーを横へスライドさせます。キーを横へスライドさせます。
メモリー・カード上に新たなオーディオ・ファイルを作成して、記録を開始します。
前述の「Pre Rec」モードを“On”に設定して記録したときは、バッファに貯えられているオーディオ・
データも含めて記録することができます。

作成されるオーディオ・ファイルのファイル・ネームは、前述58ページに記載した「デフォルト・ファ
イル・ネームの設定」に準じて付加されます。

[REC] キー

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：インプットモニターを解除した状態から [REC] キーを押して記録を開始すると、記録開始
まで約1秒程度の遅延が生じます。記録漏れを防ぐには、本機をインプットモニターにしてから 記録
を開始することをお薦めします。

2)2)2)2)2) 記録を終了するときは、記録を終了するときは、記録を終了するときは、記録を終了するときは、記録を終了するときは、 [REC STBY]  [REC STBY]  [REC STBY]  [REC STBY]  [REC STBY] キーキーキーキーキー（（（（（まままままたたたたたははははは [STOP/CANCEL]  [STOP/CANCEL]  [STOP/CANCEL]  [STOP/CANCEL]  [STOP/CANCEL] キー）キー）キー）キー）キー）を押します。を押します。を押します。を押します。を押します。
[REC STBY] キーで終了したときはインプットモニターの状態を継続しますが、 [STOP/CANCEL] キー
で終了したときはインプットモニターは解除されます。

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：記録したオーディオ・ファイル（BWFおよびMP3）は、FR-2LEにパソ
コンを接続してパソコンへインポートすることが可能です（69ページを参照）。

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：本機では、記録時1分ごとにファイルをクローズ処理する機能を搭載しています。
そのため、ACアダプタを使用しての記録時など、予期せぬ停電や不測の事故が発生しても、事故が発生する
までの記録データは消滅することはありません。

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：本機で記録したオーディオ・ファイルは、記録する順番で自動的にADL
(Audio Decision List) に組み込まれ、再生時は記録した順番に連続再生が可能です。
また、このADLから任意のオーディオ・ファイルを外したり、一旦外したオーディオ・ファイルを任
意の順番位置に戻すことが可能です。詳細は83/84ページを参照してください。
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CUECUECUECUECUEポイントの記録ポイントの記録ポイントの記録ポイントの記録ポイントの記録
本機では“CUEポイント”を記録する機能を搭載していて、登録したCUEはマーカーとして利用で
きます。CUEポイントは、オーディオ信号の記録中（または停止）、任意の位置に手動で記録します。

記録／再生／停止中に [MARK/ DEL MARK ] キーを押すことで、押したポイントに“CUE”が記録でき
ます（CUEは１つのオーディオ・ファイルに最大99個記録できます）。

記録したCUEはロケート動作に利用され、不要なCUEはリアルタイムに削除することができます。

CUEの削除についてはこの後64ページを参照し、CUEを利用したロケート動作についてはこの後66
ページの「ロケート機能」をお読みください。

連続してCUEを記録すると、CUEナンバーはカウント・アップして登録されていきます。

任意の位置に任意の位置に任意の位置に任意の位置に任意の位置にCUECUECUECUECUEを記録を記録を記録を記録を記録

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

MARK

DEL MARK

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：MP3の記録フォーマットで記録したファイルでは、実行できません。

ファイル上に記録されたCUEポイントは、Home画面の矢印部分に表示されます。
下記例は、レコーダーの現在位置がファイルの先頭（ABS 0）にある状態で、最も近い位置にCUE01
が記録されていることを示しています。

記録した記録した記録した記録した記録したCUECUECUECUECUEの確認の確認の確認の確認の確認

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：表示するCUEナンバーは、レコーダーの現在位置の後で最も近いCUEが表示されます。

 [MARK/ DEL MARK ] キー
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FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

MARK

DEL MARK

SHIFT

再生中（または停止中）に、 [SHIFT] キーを押しながら [MARK/ DEL MARK ] キーを押すと、現在ディ
スプレイに表示されているCUEをリアルタイムに削除します。
例として、下の図のようにCUEナンバー表示部に“C 03”が表示されているとき操作すると、CUE03
が削除されます。

 [MARK/ DEL MARK ] キー

 [SHIFT] キー

リアルタイムに不要なリアルタイムに不要なリアルタイムに不要なリアルタイムに不要なリアルタイムに不要なCUECUECUECUECUEを削除を削除を削除を削除を削除
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オーディオオーディオオーディオオーディオオーディオ・・・・・ファイルの再生ファイルの再生ファイルの再生ファイルの再生ファイルの再生

11111））））） [PLAY] [PLAY] [PLAY] [PLAY] [PLAY] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、再生を開始します再生を開始します再生を開始します再生を開始します再生を開始します（（（（（PLAYPLAYPLAYPLAYPLAYイイイイインンンンンジジジジジケケケケケーーーーータタタタタががががが点点点点点灯灯灯灯灯しししししままままますすすすす）））））。。。。。

●●●●● [PREV] /  [PREV] /  [PREV] /  [PREV] /  [PREV] /      キーまたはキーまたはキーまたはキーまたはキーまたは [NEXT] /  [NEXT] /  [NEXT] /  [NEXT] /  [NEXT] /      キーでの選択キーでの選択キーでの選択キーでの選択キーでの選択

停止状態で[PREV] / [PREV] / [PREV] / [PREV] / [PREV] /      キーまたはキーまたはキーまたはキーまたはキーまたは [NEXT] /  [NEXT] /  [NEXT] /  [NEXT] /  [NEXT] /      キーキーキーキーキーを押すと、現在立ち上がっているファイ
ルの前後にエントリーされているオーディオ・ファイルの先頭にロケートして、再生を開始するオー
ディオ・ファイルが選択できます。

●●●●● [MENU]  [MENU]  [MENU]  [MENU]  [MENU] モードでの選択モードでの選択モードでの選択モードでの選択モードでの選択

通常の再生通常の再生通常の再生通常の再生通常の再生

下記操作は、カードに複数のオーディオ・ファイルが記録され、一番最初に記録したオーディオ・ファ
イルの先頭で立ち上がっていることを前提にしています。

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：本機で記録した複数のオーディオ・ファイルは、記録する順番で自動的に
ADL (Audio Decision List) ファイル・リストに組み込まれるため、再生時はファイル・リストの順
番に連続再生することが可能です。なお、再生の開始するオーディオ・ファイルを選択するには、下
記「オーディオ・ファイルの選択方法」をお読みください。

22222））））） 再生音は、再生音は、再生音は、再生音は、再生音は、ヘッドホンヘッドホンヘッドホンヘッドホンヘッドホン（（（（（まままままたたたたたははははは内内内内内蔵蔵蔵蔵蔵スススススピピピピピーーーーーカカカカカ）））））でモニターします。でモニターします。でモニターします。でモニターします。でモニターします。
モニターの音量は [MONITOR] つまみで調整してください。

33333））））） 再生を停止するには、再生を停止するには、再生を停止するには、再生を停止するには、再生を停止するには、 [STOP/CANCEL]  [STOP/CANCEL]  [STOP/CANCEL]  [STOP/CANCEL]  [STOP/CANCEL] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。

＜オーディオ＜オーディオ＜オーディオ＜オーディオ＜オーディオ・・・・・ファイルの選択方法＞ファイルの選択方法＞ファイルの選択方法＞ファイルの選択方法＞ファイルの選択方法＞
再生を開始するオーディオ・ファイルを選択するには、下記いずれかの方法で行なえます。

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：ADLファイル・リストに組み込まれているファイルの連続再生が終了す
ると、本機は自動的に停止します。

（（（（（11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENU
モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。モードへ入ります。

（（（（（22222））））） “““““File >File >File >File >File >”””””が反転している状態でが反転している状態でが反転している状態でが反転している状態でが反転している状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーキーキーキーキー
を押します。を押します。を押します。を押します。を押します。
メモリー・カードに記録されているオーディオ・ファ
イルのリスト画面に変ります。

（（（（（33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーを押して希望のファイルを選択して、キーを押して希望のファイルを選択して、キーを押して希望のファイルを選択して、キーを押して希望のファイルを選択して、キーを押して希望のファイルを選択して、
[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Fileメニューのサブ・メニューを選択する画面に変り
ます。

（（（（（44444））））） “““““Locate >Locate >Locate >Locate >Locate >”””””が反転している状態でが反転している状態でが反転している状態でが反転している状態でが反転している状態で [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したオーディオ・ファイルの先頭を示すHome画
面に変ります。

ファイル・セレクトの詳細は80ページにも記載してあります
ので、参照してください。
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ロケート機能ロケート機能ロケート機能ロケート機能ロケート機能

メモリー・カードに複数のオーディオ・ファイルが作成されているとき、速やかに希望のオーディオ・
ファイルの先頭（PGM 0）にロケートすることができます。
停止状態で、 [PREV] /  キーまたは [NEXT] /  キーを押すと、現在立ち上がっているオーディ
オ・ファイルの前後にあるオーディオ・ファイルへロケートします。
前述「再生」で記載した「オーディオ・ファイルの選択」などに便利で、キーを押した回数前（また
は後）にエントリーされているオーディオ・ファイルの先頭にロケートします。

本機には多彩なロケート機能を搭載しており、用途に応じて使い分けることができます。

現在立ち上がっているオーディオ・ファイルに記録されている“CUE”を対象に、CUEの記録されて
いるポジションへ速やかにロケートします。
停止状態で [SHIFT] キーを押しながら [PREV] /  キーまたは [NEXT] /  キーを押すと、現在
のポジションから前後に記録されているCUEへロケートします。

ファイル単位のロケートファイル単位のロケートファイル単位のロケートファイル単位のロケートファイル単位のロケート

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

NEXT

PREV

CUECUECUECUECUEポイントのロケートポイントのロケートポイントのロケートポイントのロケートポイントのロケート

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：MP3の記録フォーマットで記録したファイルでは、実行できません。

再生中、 [F FWD] キー（または [REW] キー）を押すとキューイング・モードに入り、フォワード方
向またはリワインド方向へは、最大2倍速のキューイング（モニターしながら早送り／逆戻し）がで
きます。

キューイングキューイングキューイングキューイングキューイング・・・・・モードによる再生モードによる再生モードによる再生モードによる再生モードによる再生

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

NEXT

PREV

SHIFT
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停止状態で [STOP/CANCEL] キーを押しながら [REWIND] キーを押すと、オーディオ・ファイル
の先頭（ABS 0 )へ速やかにロケートします。

停止状態で [STOP/CANCEL] キーを押しながら [F FWD] キーを押すと、最終記録位置（REC END）
へ速やかにロケートします。

ファイルの先頭ファイルの先頭ファイルの先頭ファイルの先頭ファイルの先頭（（（（（ABS 0ABS 0ABS 0ABS 0ABS 0）））））へのロケートへのロケートへのロケートへのロケートへのロケート

ファイルの最終記録位置ファイルの最終記録位置ファイルの最終記録位置ファイルの最終記録位置ファイルの最終記録位置（（（（（REC ENDREC ENDREC ENDREC ENDREC END）））））へのロケートへのロケートへのロケートへのロケートへのロケート

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

STOP/CANCEL

REWIND

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

F FWD

STOP/CANCEL

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：複数のオーディオ・ファイルが記録されている場合は、一番最初に記録したオーディオ・
ファイルの先頭（ABS 0）へロケートします。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：複数のオーディオ・ファイルが記録されている場合は、一番最後に記録したオーディオ・
ファイルの最終記録位置へロケートします。
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第第第第第66666章　章　章　章　章　PCPCPCPCPCへのインポートへのインポートへのインポートへのインポートへのインポート
ここでは本機とPCを接続して、FR-2LEで記録したオーディオ・ファイルをPCへ取り込む方法を記載しています。

＜目　　次＞＜目　　次＞＜目　　次＞＜目　　次＞＜目　　次＞
パソコンとの接続パソコンとの接続パソコンとの接続パソコンとの接続パソコンとの接続......................................................................................................................................70......................................................................................................................................70......................................................................................................................................70......................................................................................................................................70......................................................................................................................................70

USB Modeの接続手順........................................................................................................................................71

ハードディスクへのコピー................................................................................................................................72

メモリー・カードへのコピー...........................................................................................................................72

コンピュータ・ソフトへのインポート例....................................................................................................73

カードのプロテクト設定／解除カードのプロテクト設定／解除カードのプロテクト設定／解除カードのプロテクト設定／解除カードのプロテクト設定／解除...................................................................................................................76...................................................................................................................76...................................................................................................................76...................................................................................................................76...................................................................................................................76
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USBポートを使用してパソコンに接続することで、FR-2LEとパソコン間でメモリー・カードに記録
したオーディオ・ファイル（BWFファイル／PM3ファイル）の転送が可能になります。
FR-2LEで記録したオーディオ・データをパソコンのハードディスクへコピーしたり、Digidesign Pro
Toolsなどのコンピュータ・ソフトへインポートすることができます。

パソコンとの接続は、下図のようにFR-2LEのPC専用 [USB] ポートとPCの [USB] ポートをUSB
ケーブルで接続（注意：USBケーブルは付属しておりません）し、MENUモードの“USB Mode”メ
ニューで接続設定を行います（次ページの「接続手順」を参照してください）。

パソコンとの接続パソコンとの接続パソコンとの接続パソコンとの接続パソコンとの接続

＜接続時のご注意＞＜接続時のご注意＞＜接続時のご注意＞＜接続時のご注意＞＜接続時のご注意＞
● 本機とパソコンを接続してご使用になる場合は、FR-2LEの安定した動作を確保するため、AC

アダプタで本機を駆動してください。

● オーディオ・ファイルの取り込みに使用できるPCは、Windows ME、2000、XPのOSを搭載し
た、USB対応のPCのみに限られます。これ以外のOSおよびMacintoshのPCでは使用できませ
ん。あらかじめ、お使いになるPCをご確認の上操作を行ってください。

● USB端子を搭載していないPC（Windowsのみ）であっても、市販のWindows対応CFC専用カー
ド・リーダー等を使うことで、メモリー・カードに記録されているデータをバックアップできます。

* 本書に記載されている会社名および製品名などは、一般的に各社の商標または登録商標となっております。

POWER USB

PHONES MONITOR OUT

L R

HOLD
OFF

＜メモリー＜メモリー＜メモリー＜メモリー＜メモリー・・・・・カードのプロテクトについて＞カードのプロテクトについて＞カードのプロテクトについて＞カードのプロテクトについて＞カードのプロテクトについて＞
本機MENUモードの“USB Mode”メニューには、メモリー・カードのプロテクトを設定／解除する
“Card Protect”を搭載しています。パソコンと接続してオーディオ・ファイルのやり取りを行う際に
は、FR-2LE側のメモリー・カードに記録されているオーディオ・ファイルを保護するため、プロテク
トを設定してご使用いただくことをお勧めします（詳細は、この後76ページを参照してください）。

[USB] ポート

USBケーブル



71

FR-2LE Field Memory Recorder（第 6章　PCへのインポート）

33333））））） [-] [-] [-] [-] [-] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、画面下にある画面下にある画面下にある画面下にある画面下にある“““““USB Mode >USB Mode >USB Mode >USB Mode >USB Mode >”””””を選択してを選択してを選択してを選択してを選択して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
USB Modeメニューのサブ・メニューを選択する画面に変ります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：FR-2LEが“USB Mode”に設定されているときは、本体の [STOP/CANCEL] キーの
みを除く他の操作キー／スイッチなどは機能しなくなります。

55555））））） USBUSBUSBUSBUSBケーブルでケーブルでケーブルでケーブルでケーブルでFR-2LEFR-2LEFR-2LEFR-2LEFR-2LEとととととPCPCPCPCPCを接続します。を接続します。を接続します。を接続します。を接続します。

44444））））） [-] [-] [-] [-] [-] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、“““““USB Device Mode >USB Device Mode >USB Device Mode >USB Device Mode >USB Device Mode >”””””を選択してを選択してを選択してを選択してを選択して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
FR-2LEがUSB Modeに設定され、下記画面に変ります。この画面が表示されている状態で、FR-2LEと
パソコン間でデータのやり取りが可能になります。

USB ModeUSB ModeUSB ModeUSB ModeUSB Modeの接続手順の接続手順の接続手順の接続手順の接続手順

11111））））） PCPCPCPCPCおよび本機の電源をオンしますおよび本機の電源をオンしますおよび本機の電源をオンしますおよび本機の電源をオンしますおよび本機の電源をオンします

22222））））） FR-2LEFR-2LEFR-2LEFR-2LEFR-2LEののののの [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードへ切り換えます。モードへ切り換えます。モードへ切り換えます。モードへ切り換えます。モードへ切り換えます。
MENUモードのメイン・メニューを選択する画面に変ります。

ここでは、例としてWindows MEを搭載したパソコンに接続することを前提にしています。
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＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：「フォルダーへコピー」ではなく「フォルダーへ移動」を実行したときは、カード上の元
ファイルはなくなりますので、ご注意ください。

33333））））） ファイルファイルファイルファイルファイル・・・・・データの取り込みが終ったら、データの取り込みが終ったら、データの取り込みが終ったら、データの取り込みが終ったら、データの取り込みが終ったら、PCPCPCPCPCからからからからからUSBUSBUSBUSBUSBケーブルの接続を外します。ケーブルの接続を外します。ケーブルの接続を外します。ケーブルの接続を外します。ケーブルの接続を外します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：取り込み終了後、PCからFR-2LEを取り外すには、Windowsの「ハードウエアー取り外
し」を実行してから、指示に従ってUSBケーブルを外してください。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押してキーを押してキーを押してキーを押してキーを押してUSB ModeUSB ModeUSB ModeUSB ModeUSB Modeを解除します。を解除します。を解除します。を解除します。を解除します。
USB Modeが解除されると同時にMENUモードから抜け出します。

11111））））） PCPCPCPCPCののののの「「「「「マママママイイイイイ・・・・・コンピュータ」コンピュータ」コンピュータ」コンピュータ」コンピュータ」を開くと、を開くと、を開くと、を開くと、を開くと、PCPCPCPCPC上に上に上に上に上に「「「「「リリリリリムムムムムーーーーーバババババブブブブブルルルルル・・・・・ディスク」ディスク」ディスク」ディスク」ディスク」というドライブというドライブというドライブというドライブというドライブ
が追加されます。が追加されます。が追加されます。が追加されます。が追加されます。
PCに初めてFR-2LEを接続した場合は、デバイス・ドライバーのインストールが行われます。

22222））））） 追加されたリムーバブル追加されたリムーバブル追加されたリムーバブル追加されたリムーバブル追加されたリムーバブル・・・・・ディスクディスクディスクディスクディスク・・・・・ドライブを開き、ドライブを開き、ドライブを開き、ドライブを開き、ドライブを開き、目的のフォルダーからオーディオ目的のフォルダーからオーディオ目的のフォルダーからオーディオ目的のフォルダーからオーディオ目的のフォルダーからオーディオ・・・・・フフフフフ
ァイルを選択してァイルを選択してァイルを選択してァイルを選択してァイルを選択してPCPCPCPCPCへコピーします。へコピーします。へコピーします。へコピーします。へコピーします。
追加されたリムーバブル・ディスク・ドライブを開くと、FR-2LEにセットされているカレント・ドライ
ブのカード内容が表示され、現在記録されているオーディオ・ファイルの一覧が確認できます。

ハードディスクへのコピーハードディスクへのコピーハードディスクへのコピーハードディスクへのコピーハードディスクへのコピー

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：「フォルダーへコピー」ではなく「フォルダーへ移動」を実行したときは、PC上の元ファ
イルはなくなりますので、ご注意ください。

33333））））） ファイルファイルファイルファイルファイル・・・・・データのコピーが終ったら、データのコピーが終ったら、データのコピーが終ったら、データのコピーが終ったら、データのコピーが終ったら、PCPCPCPCPCからからからからからUSBUSBUSBUSBUSBケーブルの接続を外します。ケーブルの接続を外します。ケーブルの接続を外します。ケーブルの接続を外します。ケーブルの接続を外します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：取り込み終了後、PCからFR-2LEを取り外すには、Windowsの「ハードウエアー取り外
し」を実行してから、指示に従ってUSBケーブルを外してください。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押してキーを押してキーを押してキーを押してキーを押してUSB ModeUSB ModeUSB ModeUSB ModeUSB Modeを解除します。を解除します。を解除します。を解除します。を解除します。
USB Modeが解除されると同時にMENUモードから抜け出します。

11111））））） PCPCPCPCPCののののの「「「「「マママママイイイイイ・・・・・コンピュータ」コンピュータ」コンピュータ」コンピュータ」コンピュータ」を開くと、を開くと、を開くと、を開くと、を開くと、PCPCPCPCPC上に上に上に上に上に「「「「「リリリリリムムムムムーーーーーバババババブブブブブルルルルル・・・・・ディスク」ディスク」ディスク」ディスク」ディスク」というドライブというドライブというドライブというドライブというドライブ
が追加されます。が追加されます。が追加されます。が追加されます。が追加されます。
PCに初めてFR-2LEを接続した場合は、デバイス・ドライバーのインストールが行われます。

22222））））） 追加されたリムーバブル追加されたリムーバブル追加されたリムーバブル追加されたリムーバブル追加されたリムーバブル・・・・・ディスクディスクディスクディスクディスク・・・・・ドライブのドライブのドライブのドライブのドライブの“““““ルルルルルーーーーートトトトト・・・・・フォルダー”フォルダー”フォルダー”フォルダー”フォルダー”に、に、に、に、に、ダウンロードしダウンロードしダウンロードしダウンロードしダウンロードし
たバージョンアップのファイルをコピーします。たバージョンアップのファイルをコピーします。たバージョンアップのファイルをコピーします。たバージョンアップのファイルをコピーします。たバージョンアップのファイルをコピーします。

メモリーメモリーメモリーメモリーメモリー・・・・・カードへのコピーカードへのコピーカードへのコピーカードへのコピーカードへのコピー

パソコンからFR-2LEのメモリー・カードへファイル・データをコピーします。
特に、FR-2LEをバージョンアップする際、当社ホームページからダウンロードしたバージョンアッ
プ用のファイル・データをメモリー・カードにコピーするときにご利用ください（バージョンアップ
の方法は111ページを参照）。下記操作は、バージョンアップ用のファイルがパソコンのデスクトッ
プ上にダウンロードされていることを前提にしています。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：パソコンからメモリー・カードへデータをコピーするときは、お使いいただいているメモリー・
カードにプロテクトがかかっていないことを確認してください。プロテクトがかかっていると、コピーする
ことができません。
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44444））））） デスクトップ上にあるデスクトップ上にあるデスクトップ上にあるデスクトップ上にあるデスクトップ上にある“““““CFC000CFC000CFC000CFC000CFC000”””””を選択して、を選択して、を選択して、を選択して、を選択して、クリックしますクリックしますクリックしますクリックしますクリックします（（（（（矢矢矢矢矢印印印印印33333）））））。。。。。
下記例のディスク・ボリューム・ラベルは、初期設定における「仮ラベル」を表示しています。
メモリー・カードのボリューム・ラベルを、MENUモードの“Disk”メニューにある“Reel No”におい
て任意にエディットしている場合には、そのボリューム・ラベルが表示されます。

ここでは例として、コンピュータ・ソフトのDigidesign Pro Toolsへ、オーディオ・データをインポー
トする方法を記載しており、Windows版のPro Toolsを使うことを前提にしています。Pro Toolsの
詳しい操作については、ソフト・ウェアーに付属されている説明書を参照してください（ここに記載
の画面表示などは一例として記載しているため、実際と異なる場合があります）。

11111））））） PCPCPCPCPC側のコンピュータ側のコンピュータ側のコンピュータ側のコンピュータ側のコンピュータ・・・・・ソフトソフトソフトソフトソフト（（（（（Pro ToolsPro ToolsPro ToolsPro ToolsPro Tools）））））を立ち上げます。を立ち上げます。を立ち上げます。を立ち上げます。を立ち上げます。

22222））））） Pro ToolsPro ToolsPro ToolsPro ToolsPro Toolsの画面内にあるの画面内にあるの画面内にあるの画面内にあるの画面内にある“““““AudioAudioAudioAudioAudio”””””部分を選択して、部分を選択して、部分を選択して、部分を選択して、部分を選択して、オーディオオーディオオーディオオーディオオーディオ・・・・・リージョンリージョンリージョンリージョンリージョン・・・・・リストのポッリストのポッリストのポッリストのポッリストのポッ
プアッププアッププアッププアッププアップ・・・・・メニューを表示させますメニューを表示させますメニューを表示させますメニューを表示させますメニューを表示させます（（（（（矢矢矢矢矢印印印印印11111）））））。。。。。

33333））））） ポップアップポップアップポップアップポップアップポップアップ・・・・・メニューからメニューからメニューからメニューからメニューから“““““Import AudioImport AudioImport AudioImport AudioImport Audio”””””メニューを選択して、メニューを選択して、メニューを選択して、メニューを選択して、メニューを選択して、クリックしますクリックしますクリックしますクリックしますクリックします（（（（（矢矢矢矢矢印印印印印22222）））））。。。。。

❸

❶

❷

コンピュータコンピュータコンピュータコンピュータコンピュータ・・・・・ソフトへのインポート例ソフトへのインポート例ソフトへのインポート例ソフトへのインポート例ソフトへのインポート例
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55555））））） カード内のカード内のカード内のカード内のカード内の“““““bwffbwffbwffbwffbwff”””””ディレクトリにあるオーディオディレクトリにあるオーディオディレクトリにあるオーディオディレクトリにあるオーディオディレクトリにあるオーディオ・・・・・ファイルを選択して、ファイルを選択して、ファイルを選択して、ファイルを選択して、ファイルを選択して、クリックしますクリックしますクリックしますクリックしますクリックします
（（（（（矢矢矢矢矢印印印印印44444）））））。。。。。
“Region in current file”に、選択したオーディオ・ファイルが表示されます。

66666））））） “““““Convert ->Convert ->Convert ->Convert ->Convert ->”””””をクリックした後、をクリックした後、をクリックした後、をクリックした後、をクリックした後、“““““DoneDoneDoneDoneDone”””””をクリックしますをクリックしますをクリックしますをクリックしますをクリックします（（（（（矢矢矢矢矢印印印印印55555）））））
保存ファイルを選択する画面に変ります。

77777））））） 保存ファイルを選択して、保存ファイルを選択して、保存ファイルを選択して、保存ファイルを選択して、保存ファイルを選択して、“““““開開開開開くくくくく”””””をクリックしますをクリックしますをクリックしますをクリックしますをクリックします（（（（（矢矢矢矢矢印印印印印66666）））））。。。。。
選択したファイルへの保存が始まります。

保存したファイルは、オーディオ・リージョン・リストに表示されます（矢印7）。

❹

❺

❻

❼

❺
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88888））））） “““““SpotSpotSpotSpotSpot”””””を有効にした後、を有効にした後、を有効にした後、を有効にした後、を有効にした後、オーディオオーディオオーディオオーディオオーディオ・・・・・リージョンリージョンリージョンリージョンリージョン・・・・・リストをトラックリストをトラックリストをトラックリストをトラックリストをトラック・・・・・エリアにドラッグ＆エリアにドラッグ＆エリアにドラッグ＆エリアにドラッグ＆エリアにドラッグ＆
ダウンしますダウンしますダウンしますダウンしますダウンします（（（（（矢矢矢矢矢印印印印印88888）））））。。。。。
RTCを元に記録してTIME STAMPに従って張り付ける場合は、“Spot”を有効にします。
ドラッグ＆ダウンすると、スポット・ダイアログ設定画面が表示されます。

99999））））） スポットスポットスポットスポットスポット・・・・・ダイアログのダイアログのダイアログのダイアログのダイアログの“““““▲▲▲▲▲”””””をクリックして、をクリックして、をクリックして、をクリックして、をクリックして、“““““OKOKOKOKOK”””””をクリックしますをクリックしますをクリックしますをクリックしますをクリックします（（（（（矢矢矢矢矢印印印印印99999）））））。。。。。
“▲”をクリックすると、現在表示されているOriginal Time Stampの時間が“Start”時間に設定されま
す。その後、“OK”をクリックすることで、指定した位置からオーディオ・データがインポートされます。

❽

❾

❾
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カードのプロテクトは、FR-2LEとパソコンを接続する“USB Mode”においてのみ有効で、現在FR-
2LEにセットされているメモリー・カードを“Read/Write”可能にするか、“Read”のみを可能にす
ることができます。

誤った操作でパソコンからFR-2LEへファイル・データを取り込んだりすると、FR-2LEのオーディ
オ・ファイルが破壊される恐れがあります。そのため、オーディオ・ファイルの破壊を防止するため
にも、メモリー・カードにプロテクトをかけてご使用になることをお薦めします。

カードのプロテクト設定／解除カードのプロテクト設定／解除カードのプロテクト設定／解除カードのプロテクト設定／解除カードのプロテクト設定／解除

11111））））） PCPCPCPCPCおよび本機の電源をオンしますおよび本機の電源をオンしますおよび本機の電源をオンしますおよび本機の電源をオンしますおよび本機の電源をオンします

22222））））） FR-2LEFR-2LEFR-2LEFR-2LEFR-2LEののののの [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードへ切り換えます。モードへ切り換えます。モードへ切り換えます。モードへ切り換えます。モードへ切り換えます。
MENUモードのメイン・メニューを選択する画面に変ります。

33333））））） [-] [-] [-] [-] [-] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、画面下にある画面下にある画面下にある画面下にある画面下にある“““““USB Mode >USB Mode >USB Mode >USB Mode >USB Mode >”””””を選択してを選択してを選択してを選択してを選択して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
USB Modeメニューのサブ・メニューを選択する画面に変ります。

44444））））） [-] [-] [-] [-] [-] キーを押してキーを押してキーを押してキーを押してキーを押して“““““Card ProtectCard ProtectCard ProtectCard ProtectCard Protect”””””を選択してを選択してを選択してを選択してを選択して、、、、、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在の設定が点滅して、変更可能な画面に変ります（初期設定では“Off”が点滅します）。

55555））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““OnOnOnOnOn”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
プロテクトがONに設定され、一つ前の画面に変ります。プロテクトを解除する場合も、同じ要領で設定
してください。

66666））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、 MENU MENU MENU MENU MENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

OnOnOnOnOn

OffOffOffOffOff（（（（（初初初初初期期期期期設設設設設定定定定定）））））

Readのみ可能（FR-2LEからパソコンへデータのインポートのみが可能）。

Read/Writeが可能（パソコンとFR-2LE間の双方でデータのやり取りが可能）。
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MENUMENUMENUMENUMENUモードの操作方法モードの操作方法モードの操作方法モードの操作方法モードの操作方法
MENUモードを操作するには、本機が停止状態で [MENU/ENTER] キーを押します。
本機がMENUモードへ入り、メイン・メニューを選択する画面に変ります。

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

QUICK SET

ENTER
MENU /

FR-2LE  FIELD MEMORY RECORDER

LOCK
REWIND F FWD MARK

DEL MARK

PLAY STOP/CANCEL

REC END
ABS0

LOC

CONTRAST QUICK SET

LIGHT ENTER
MENU /

MIC L MIC R

PREV NEXTFILE
SHIFT

LOCK

MARK

DEL MARK

希望のメイン・メニューは、 [+] キー／ [-] キーを押して選択します。
[+] キーを押すとカーソルが上に移動し、 [-] キーを押すとカーソルは下に移動します。

希望のメイン・メニューを選択した後 [MENU/ENTER] キーを押すと、選択したメイン・メニューに
用意されているサブ・メニューを選択する画面に変ります（下記＜注意＞を参照）。
用途に応じて希望のサブ・メニューを選択して実行します。

＜注意＞：メイン・メニューを選択して [MENU/ENTER] キーを押したとき、サブ・メニューが表示され
るのはDiskメニュー／SetupメニューおよびUSB Modeメニューで、Fileメニューではサブ・メニューの
前に設定／編集などを対象とするオーディオ・ファイルを選択する画面が表示されます。詳細はFileメニュー
の項をお読みください。
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サブサブサブサブサブ・・・・・メニューの詳細メニューの詳細メニューの詳細メニューの詳細メニューの詳細

Fileメニューのサブ・メニュー

Diskメニューのサブ・メニュー

Setupメニューのサブ・メニュー

USB modeメニューのサブ・メニュー

Card Protect： メモリー・カードのプロテクト設定／解除
USB Device Mode：USB接続モードの設定／解除

Locate： 選択したオーディオ・ファイルの先頭にロケート
Rename：選択したオーディオ・ファイルのファイル・ネームをリ

ネーム
Remove：任意のオーディオ・ファイルをADL (Audio Decision

List) から外す
Prev. Insert/Next Insert： ADL (Audio Decision List) から外し

たオーディオ・ファイルを、再度復活

Format： メモリー・カードのフォーマット（初期化）
Reel No.：メモリー・カードのReel Numberをエディット
Resume：レジューム機能のON/OFFを設定

ALC：ALC／Limiter機能の設定／解除
HPF：HPF機能の設定／解除
Def, FS/BIT：フォーマット時のデフォルト記録フォーマット

（FS/BIT）を設定
Source Sel： 入力ソースの選択
Phantom： ファンタム電源の設定／解除
Monitor Mode：モニターの出力モードを設定
Speaker Out：内蔵スピーカのON/OFF設定
File Name Mode：記録時に作成されるファイル・ネーム・モード

を選択
Default File Name： FileNameModeをTake設定時の、デフォルト・

ファイル・ネームを設定
Pre Rec：Pre RecモードのON/OFFを設定
Time Display：タイム表示モードの設定
Remain Display： リメインの表示モードを設定
Max File Size： ファイルの最大記録容量を設定
Battery Type： 電源に使用する電池の設定
Error Tone： エラー・トーン出力の設定／解除
Adjust Real Time Clock： リアルタイム・クロックの設定
Version：本機搭載のROMバージョンを確認
Intial Setup： Setupメニューのイニシャライズ
Version Up： ソフトウエアーのバージョンアップ

サブサブサブサブサブ・・・・・メニューメニューメニューメニューメニュー サブサブサブサブサブ・・・・・メニューの機能メニューの機能メニューの機能メニューの機能メニューの機能
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FileFileFileFileFile メニューメニューメニューメニューメニュー
Fileメニューでは、記録済みのオーディオ・ファイルに関する、以下4項目の編集や設定が行なえま
す。

1. 選択したオーディオ・ファイルの先頭にロケート
2. 選択したオーディオ・ファイルのファイル・ネームをリネームして再登録
3. 任意のオーディオ・ファイルをADL (Audio Decision List) から外す
4. ADLから外したフリー・ファイルを、再度ADLへ組み込む

＜注意＞：Fileメニューを実行するには、メモリー・カードにオーディオ・ファイルが記録されてい
ることが必要です。何も記録されていない状態でFileメニューを実行しようとしても“<No Entries><No Entries><No Entries><No Entries><No Entries>”
が表示されます。

ADLに組み込まれたオーディオ・ファイルのリストから任意のオーディオ・ファイルを選択し
て、そのファイルの先頭へロケートします。下記操作は、本機が MENUモードに入り、メイ
ン・メニューの選択画面（メイン・メニューの “File >”が反転）が表示されていることを前
提にしています。

11111））））） “““““File >File >File >File >File >”””””が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ADLに組み込まれているオーディオ・ファイルのリストが表示されます。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでロケートしたいファイルを選択して、キーでロケートしたいファイルを選択して、キーでロケートしたいファイルを選択して、キーでロケートしたいファイルを選択して、キーでロケートしたいファイルを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Fileメニューのサブ・メニューを選択する画面に変ります。下記画面は、ファイル・ナンバー002
を選択した場合の例です。

選択したオーディオ選択したオーディオ選択したオーディオ選択したオーディオ選択したオーディオ・・・・・ファイルの先頭にロケートファイルの先頭にロケートファイルの先頭にロケートファイルの先頭にロケートファイルの先頭にロケート

＜覚えておきましょう＞：オーディオ・ファイルの先頭にロケートするには、上記操作以外に
[PREV] キーまたは [NEXT] キーでも操作できます（65ページ参照）。

＜注意＞：希望のオーディオ・ファイルの先頭にロケートできるのは、ADLに組み込まれたオーディ
オ・ファイルのみが対象で、後述の“Remove”でADLから外されたフリー・ファイルは対象になり
ません。

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：本機で記録したオーディオ・ファイルは、記録する順番で自動的にADL
(Audio Decision List) に組み込まれます。ADLに組み込まれたオーディオ・ファイルは、記録した
順番で連続再生したり、任意に選択したオーディオ・ファイルの先頭にロケートしたり、ファイル・
ネームの編集が可能です。また、任意のオーディオ・ファイルをADLから外したり、一旦外したオー
ディオ・ファイルを再度ADLに加えることができます。本機では、ADLに組み込まれたオーディオ・
ファイルを「再生可能なオーディオ・ファイル」と呼び、ADLから外したオーディオ・ファイルを「フ
リー・ファイル」と呼んでいます。
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ADLに組み込まれたオーディオ・ファイルのリストから任意のオーディオ・ファイルを選択し、
そのファイルのファイル・ネームを編集して再登録します。

下記操作は、本機が MENUモードに入り、メイン・メニューの選択画面（メイン・メニューの
“File >”が反転）が表示されていることを前提にしています。

ファイルファイルファイルファイルファイル・・・・・ネームをリネームして再登録ネームをリネームして再登録ネームをリネームして再登録ネームをリネームして再登録ネームをリネームして再登録

11111））））） “““““File >File >File >File >File >”””””が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ADLに組み込まれているオーディオ・ファイルのリストが表示されます。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで編集したいファイルを選択して、キーで編集したいファイルを選択して、キーで編集したいファイルを選択して、キーで編集したいファイルを選択して、キーで編集したいファイルを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Fileメニューのサブ・メニューを選択する画面に変ります。下記画面は、ファイル・ナンバー002
を選択した場合の例です。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで     “““““Rename >Rename >Rename >Rename >Rename >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したオーディオ・ファイルの、ファイル・ネームが編集可能な画面に変ります。

33333））））） “““““Locate >Locate >Locate >Locate >Locate >”””””が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Please Wait”のポップアップ表示が点灯した後、選択したオーディオ・ファイルのHome画面
に変ります。下記Home画面は、タイム表示部が“PRG (Program)”になっている場合の例です。

＜注意＞：ファイル・ネームを編集できるのは、ADLに組み込まれたオーディオ・ファイルのみが
対象で、後述の“Remove”でADLから外されたフリー・ファイルは対象になりません。
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44444））））） 希望のファイル希望のファイル希望のファイル希望のファイル希望のファイル・・・・・ネームを入力後、ネームを入力後、ネームを入力後、ネームを入力後、ネームを入力後、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
入力したネームの再登録処理が始まり、“Completed!”を表示した後再生可能なオーディオ・ファ
イルのリスト画面に変ります。

＜ファイル＜ファイル＜ファイル＜ファイル＜ファイル・・・・・ネームの入力方法＞ネームの入力方法＞ネームの入力方法＞ネームの入力方法＞ネームの入力方法＞
編集画面の [  ] 内にあるカーソルを「File NameFile NameFile NameFile NameFile Nameカーソルカーソルカーソルカーソルカーソル」と呼び、文字／記号候補にある
カーソルを「文字候補カーソル文字候補カーソル文字候補カーソル文字候補カーソル文字候補カーソル」と呼んでいます。 File Nameカーソルは [REWIND] / [F FWD]
キーで移動でき、文字候補カーソルは [+] / [-] キーで移動できます（ [+] / [-] キーを長押し
すると、カーソルを早く移動できます）。

File Nameカーソル
文字候補カーソル

＜ファイル＜ファイル＜ファイル＜ファイル＜ファイル・・・・・ネームの入力例＞ネームの入力例＞ネームの入力例＞ネームの入力例＞ネームの入力例＞
1） [REWIND] / [F FWD] キーで“File Nameカーソル”を希望の位置に移動します。
2） [+] / [-] キーで“文字候補カーソル”を希望の文字／記号へ移動します。
3） 操作1～2を繰り返し、希望のファイル・ネームを入力します。

文字は最大19文字まで入力できます。

＜ファイル＜ファイル＜ファイル＜ファイル＜ファイル・・・・・ネームの削除例＞ネームの削除例＞ネームの削除例＞ネームの削除例＞ネームの削除例＞
1） [REWIND] / [F FWD] キーで削除したい位置に“File Nameカーソル”を移動します。
2） [+] / [-] キーで “文字候補カーソル”を“[DEL]”へ移動します。
3） [MENU/ENTER] キーを押して選択した文字を削除します。

＜ファイル＜ファイル＜ファイル＜ファイル＜ファイル・・・・・ネームの挿入例＞ネームの挿入例＞ネームの挿入例＞ネームの挿入例＞ネームの挿入例＞
1） [REWIND] / [F FWD] キーで挿入したい位置に“File Nameカーソル”を移動します。
2） [+] / [-] キーで “文字候補カーソル”を“[INS]”へ移動します。
3） [MENU/ENTER] キーを押します。
4) [+] / [-] キーで挿入したい文字／記号を選択します。

画面下にある [INS] / [DEL] / [OK] / [QUIT] は、それぞれ下記の目的で選択します。

[INS] ：“File Nameカーソル”位置に文字／記号を挿入するとき選択。
[DEL] ：“File Nameカーソル”位置の文字／記号を削除するとき選択。
[OK] ：入力したFile Nameを決定するとき選択。
[QUIT] ：File Nameの編集を中止するとき選択。
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ADLに組み込まれたオーディオ・ファイルのリストから、任意のオーディオ・ファイルを外し
ます。

下記操作は、本機が MENUモードに入り、メイン・メニューの選択画面（メイン・メニューの
“File >”が反転）が表示されていることを前提にしています。

任意のオーディオ任意のオーディオ任意のオーディオ任意のオーディオ任意のオーディオ・・・・・ファイルをファイルをファイルをファイルをファイルをADLADLADLADLADLから外すから外すから外すから外すから外す

11111））））） “““““File >File >File >File >File >”””””が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ADLに組み込まれているオーディオ・ファイルのリストが表示されます。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで外したいファイルを選択して、キーで外したいファイルを選択して、キーで外したいファイルを選択して、キーで外したいファイルを選択して、キーで外したいファイルを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Fileメニューのサブ・メニューを選択する画面に変ります。下記画面は、ファイル・ナンバー002
を選択した場合の例です。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：ADLから外したオーディオ・ファイルは「フリー・ファイル」となってメモリー・カード
上に残っていますが、再生したりファイル・ネームの編集は行なえません。再生／編集を可能にする
には、後述の“Prev. Insert”または“Next Insert”を使い、再度ADLに組み込んでください。

＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞＜覚えておきましょう＞：：：：：入力したファイル・ネー
ムを決定するには、右図のように“文字候補カーソ
ル”を画面下の“[OK]”に移動した後、 [MENU/
ENTER] キーを押すことでも実行できます。

55555））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：既に存在するネームを入力して再登録しようとすると、ディスプレイに“Same
name exist!”が点滅表示して、登録操作はできないことを示します。また、不正なネームを
入力して登録しようとしたときも、“Illegal name!”を表示して、操作は無効になります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：“Disk”メニューの“Format”を実行すると、メモリー・カード上に存在するすべてのオー
ディオ・ファイルが削除されます。



84

FR-2LE Field Memory Recorder (第 7章　MENUモード／ Fileメニュー )

ADLから外したフリー・ファイルを、再度ADLに組み込みます。
フリー・ファイルは、現在ADLに組み込まれているオーディオ・ファイルの前（または後）に
インサートできます。再生ADLに再度組み込まれたオーディオ・ファイルは、再生したりファ
イル・ネームの編集が可能になります。

下記操作は、本機が MENUモードに入り、メイン・メニューの選択画面（メイン・メニューの
“File >”が反転）が表示されていることを前提にしています。

ADLADLADLADLADLから外したフリーから外したフリーから外したフリーから外したフリーから外したフリー・・・・・ファイルを再度ファイルを再度ファイルを再度ファイルを再度ファイルを再度ADLADLADLADLADLに組み込むに組み込むに組み込むに組み込むに組み込む

11111））））） “““““File >File >File >File >File >”””””が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ADLに組み込まれているオーディオ・ファイルのリストが表示されます。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで挿入位置のファイルを選択して、キーで挿入位置のファイルを選択して、キーで挿入位置のファイルを選択して、キーで挿入位置のファイルを選択して、キーで挿入位置のファイルを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Fileメニューのサブ・メニューを選択する画面に変ります。下記画面は、ファイル・ナンバー002
を選択した場合の例です。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで     “““““Remove >Remove >Remove >Remove >Remove >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したオーディオ・ファイルが速やかにADLから外され、下記例のように後にエントリーされ
ていたオーディオ・ファイルが繰り上がります。

ここでは例として、現在ADLには5つのオーディオ・ファイルが組み込まれており、ADL
から外したフリー・ファイルが3つあることを前提にして記載しています。

＜現在＜現在＜現在＜現在＜現在ADLADLADLADLADLに組み込まれているファイル＞に組み込まれているファイル＞に組み込まれているファイル＞に組み込まれているファイル＞に組み込まれているファイル＞ ＜リストから外されたフリー＜リストから外されたフリー＜リストから外されたフリー＜リストから外されたフリー＜リストから外されたフリー・・・・・ファイル＞ファイル＞ファイル＞ファイル＞ファイル＞
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44444））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで挿入したいフリーキーで挿入したいフリーキーで挿入したいフリーキーで挿入したいフリーキーで挿入したいフリー・・・・・ファイルを選択して、ファイルを選択して、ファイルを選択して、ファイルを選択して、ファイルを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押しキーを押しキーを押しキーを押しキーを押し
ます。ます。ます。ます。ます。
選択したフリー・ファイルが、前述の操作-2で選択したオーディオ・ファイルの前または後ろに
挿入され、ADLへの組み込みが完了したリスト画面に変ります。

●●●●●     ファイルファイルファイルファイルファイル002002002002002の前にの前にの前にの前にの前に“““““File Name_7.wavFile Name_7.wavFile Name_7.wavFile Name_7.wavFile Name_7.wav”””””を挿入した例を挿入した例を挿入した例を挿入した例を挿入した例

●●●●●     ファイルファイルファイルファイルファイル002002002002002の後にの後にの後にの後にの後に“““““File Name_6.wavFile Name_6.wavFile Name_6.wavFile Name_6.wavFile Name_6.wav”””””を挿入した例を挿入した例を挿入した例を挿入した例を挿入した例

55555））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押してキーを押してキーを押してキーを押してキーを押してMENUMENUMENUMENUMENUモードから抜け出モードから抜け出モードから抜け出モードから抜け出モードから抜け出します。します。します。します。します。
MENUモードに入る前に立ち上がっていた、オーディオ・ファイルのHome画面に変ります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：カード上にフリー・ファイルが無い場合は、“No free files”が点灯して、フリー・
ファイルのリスト画面は表示されません。

●●●●●     選択したオーディオ選択したオーディオ選択したオーディオ選択したオーディオ選択したオーディオ・・・・・ファイルの前に挿入する場合ファイルの前に挿入する場合ファイルの前に挿入する場合ファイルの前に挿入する場合ファイルの前に挿入する場合（（（（（“““““Prev.InsertPrev.InsertPrev.InsertPrev.InsertPrev.Insert”””””選択時）選択時）選択時）選択時）選択時）

●●●●●     選択したオーディオ選択したオーディオ選択したオーディオ選択したオーディオ選択したオーディオ・・・・・ファイルの後に挿入する場合ファイルの後に挿入する場合ファイルの後に挿入する場合ファイルの後に挿入する場合ファイルの後に挿入する場合（（（（（“““““Next InsertNext InsertNext InsertNext InsertNext Insert”””””選択時）選択時）選択時）選択時）選択時）

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで     “““““Prev. Insert >Prev. Insert >Prev. Insert >Prev. Insert >Prev. Insert >”””””またはまたはまたはまたはまたは“““““Next InsertNext InsertNext InsertNext InsertNext Insert”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER]
キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したオーディオ・ファイルの前にフリー・ファイルを挿入するときは“““““Prev. InsertPrev. InsertPrev. InsertPrev. InsertPrev. Insert”””””を選択
し、後ろに挿入するときは“““““Next InsertNext InsertNext InsertNext InsertNext Insert”””””を選択します。

“Prev. Insert”または“Next Insert”を選択して [MENU/ENTER] キーを押すと、フリー・ファ
イルのリスト画面に変ります。
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DiskDiskDiskDiskDiskメニューメニューメニューメニューメニュー
Diskメニューでは、メモリー・カードに関する以下3項目の編集や設定が行なえます。

1. メモリー・カードのフォーマット
2. メモリー・カードのReel Number（ボリューム・ラベル）を設定
3. レジューム機能のON/OFF設定

＜注意＞：Dsikメニューは、本機にメモリー・カードがセットされていないと実行できません。

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Disk >Disk >Disk >Disk >Disk >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Diskメニューのサブ・メニューを選択する画面に変ります。

22222））））） “““““Format >Format >Format >Format >Format >”””””が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
フォーマット・モードを設定する画面に変り、Reel NumberやFS/BIT Modeの設定が可能にな
ります。

33333））））） [+] [+] [+] [+] [+] キーを押してキーを押してキーを押してキーを押してキーを押して“““““Reel NoReel NoReel NoReel NoReel No”””””を反転させて、を反転させて、を反転させて、を反転させて、を反転させて、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在のReel Number先頭が点滅し、編集が可能になります。入力方法は次ページを参照してくだ
さい。

メモリー・カードをFAT32 (File Allocation Table 32) でフォーマットします。
下記操作は、本機がMENUモードに入り、メイン・メニューの選択画面（“File >”が反転）に
なっていることを前提にしています。

メモリーメモリーメモリーメモリーメモリー・・・・・カードのフォーマットカードのフォーマットカードのフォーマットカードのフォーマットカードのフォーマット
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44444））））） Reel NumberReel NumberReel NumberReel NumberReel Number の入力後、の入力後、の入力後、の入力後、の入力後、[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押して決定します。キーを押して決定します。キーを押して決定します。キーを押して決定します。キーを押して決定します。
入力したReel Numberが設定され、下記例の画面に変ります。

＜＜＜＜＜Reel NumberReel NumberReel NumberReel NumberReel Numberの入力方法＞の入力方法＞の入力方法＞の入力方法＞の入力方法＞
編集画面の [  ] 内にあるカーソルを「Reel NumberReel NumberReel NumberReel NumberReel Numberカーソルカーソルカーソルカーソルカーソル」と呼び、文字／記号候補にあ
るカーソルを「文字候補カーソル文字候補カーソル文字候補カーソル文字候補カーソル文字候補カーソル」と呼んでいます。 Reel Numberカーソルは [REWIND] /
[F FWD] キーで移動でき、文字候補カーソルは [+] / [-] キーで移動できます（ [+] / [-] キー
を長押しすると、カーソルを早く移動できます）。

Reel Numberカーソル
文字候補カーソル

画面下にある [INS] / [DEL] / [OK] / [QUIT] は、それぞれ下記の目的で選択します。

[INS] ：“Reel Numberカーソル”位置に文字／記号を挿入するとき選択。
[DEL] ：“Reel Numberカーソル”位置の文字／記号を削除するとき選択。
[OK] ：入力したReel Numberを決定するとき選択。
[QUIT] ：Reel Numberの編集を中止するとき選択。

＜＜＜＜＜Reel NumberReel NumberReel NumberReel NumberReel Numberの入力例＞の入力例＞の入力例＞の入力例＞の入力例＞
1） [REWIND] / [F FWD] キーで“Reel Numberカーソル”を希望の位置に移動します。
2） [+] / [-] キーで“文字候補カーソル”を希望の文字／記号へ移動します。
3） 操作1～2を繰り返し、希望のReel Numberを入力します。

Reel Numberは最大8文字まで入力できます。

＜＜＜＜＜Reel NumberReel NumberReel NumberReel NumberReel Numberの削除例＞の削除例＞の削除例＞の削除例＞の削除例＞
1） [REWIND] / [F FWD] キーで削除したい位置に“Reel Numberカーソル”を移動しま

す。
2） [+] / [-] キーで “文字候補カーソル”を“[DEL]”へ移動します。
3） [MENU/ENTER] キーを押して選択したReel Numberを削除します。

＜＜＜＜＜Reel NumberReel NumberReel NumberReel NumberReel Numberの挿入例＞の挿入例＞の挿入例＞の挿入例＞の挿入例＞
1） [REWIND] / [F FWD] キーで挿入したい位置に“Reel Numberカーソル”を移動しま

す。
2） [+] / [-] キーで “文字候補カーソル”を“[INS]”へ移動します。
3） [MENU/ENTER] キーを押します。
4) [+] / [-] キーで挿入したいReel Numberを選択します。

55555））））） [-] [-] [-] [-] [-] キーを押してキーを押してキーを押してキーを押してキーを押して“““““FS/BIT ModeFS/BIT ModeFS/BIT ModeFS/BIT ModeFS/BIT Mode”””””を反転させて、を反転させて、を反転させて、を反転させて、を反転させて、[MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
FS/BIT Modeの設定が可能になります。
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66666））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““FS/BIT ModeFS/BIT ModeFS/BIT ModeFS/BIT ModeFS/BIT Mode”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した“FS/BIT Mode”が決定され、下記例の画面に変ります。

77777））））） [-] [-] [-] [-] [-] キーを押してキーを押してキーを押してキーを押してキーを押して“““““[EXECUTE][EXECUTE][EXECUTE][EXECUTE][EXECUTE]”””””     を反転させて、を反転させて、を反転させて、を反転させて、を反転させて、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
下記警告画面に変り、“Are you sure?”が点滅します。

FS/BIT Modeは、 [+] / [-] キーを押すことで下記モードが選択できます。

BWF44/16（44.1kHz/16BitのBWFファイル・モード）
BWF48/16（48kHz/16BitのBWFファイル・モード）
BWF44/24（44.1kHz/24BitのBWFファイル・モード）
BWF48/24（48kHz/24BitのBWFファイル・モード）
BWF88/24（88.2kHz/24BitのBWFファイル・モード）
BWF96/24（96kHz/24BitのBWFファイル・モード）
MP3-192（MP3-192kbpsのMP3圧縮ファイル・モード）

なお、ここで設定するFS/BIT Modeは、Setupメニューにある“Default FS/BIT”にリアルタ
イムに反映され、フォーマット後のHome画面にも表示されます。

88888））））） [REWIND] [REWIND] [REWIND] [REWIND] [REWIND] キーを押してキーを押してキーを押してキーを押してキーを押して“““““[EXECUTE][EXECUTE][EXECUTE][EXECUTE][EXECUTE]”””””を反転させて、を反転させて、を反転させて、を反転させて、を反転させて、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押しまキーを押しまキーを押しまキーを押しまキーを押しま
す。す。す。す。す。
フォーマットを開始して、終了すると“Success.”が点灯してカードのアクセスが停止します。

99999））））） 画面の指示に従って、画面の指示に従って、画面の指示に従って、画面の指示に従って、画面の指示に従って、いずれかの操作キーを押します。いずれかの操作キーを押します。いずれかの操作キーを押します。いずれかの操作キーを押します。いずれかの操作キーを押します。
フォーマット後のHome画面に変り、 “<<No Audio Files>>”を表示します。
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11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Disk >Disk >Disk >Disk >Disk >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Diskメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Reel No >Reel No >Reel No >Reel No >Reel No >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在セットされているメモリー・カードのReel Numberが、エディット可能な画面に変ります。

フォーマット時に設定したReel Numberを、エディットして再登録します。
下記操作は、本機がMENUモードに入り、メイン・メニューの選択画面（“File >”が反転）に
なっていることを前提にしています。

メモリーメモリーメモリーメモリーメモリー・・・・・カードのカードのカードのカードのカードのReel NumberReel NumberReel NumberReel NumberReel Numberをリネームして再登録をリネームして再登録をリネームして再登録をリネームして再登録をリネームして再登録

33333））））） 希望の希望の希望の希望の希望のReel NumberReel NumberReel NumberReel NumberReel Number を入力します。を入力します。を入力します。を入力します。を入力します。
前述87ページの入力方法を参照して、新たなReel Numberを入力します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：不正なReel Numberを入力して登録しようとしたときは、“Illegal name!Illegal name!Illegal name!Illegal name!Illegal name!”を表示
して操作は無効になります。

44444））））） 希望の希望の希望の希望の希望のReel NumberReel NumberReel NumberReel NumberReel Numberを入力した後、を入力した後、を入力した後、を入力した後、を入力した後、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して再登録します。キーを押して再登録します。キーを押して再登録します。キーを押して再登録します。キーを押して再登録します。

55555））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、 MENU MENU MENU MENU MENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。
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33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““OnOnOnOnOn”””””またはまたはまたはまたはまたは“““““OffOffOffOffOff”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した項目（OnまたはOff）に設定され、一つ前の画面に変ります。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

レジューム機能とは、FR-2LEの電源をOFFにする、または現在使用しているメモリー・カー
ドを取り出す際、現在の再生ポイント位置をレジューム・ファイルに記憶させる機能です。
このレジューム機能を“On”にしておくと、改めて電源を投入したり、レジューム・ファイル
に記憶させたメモリー・カードをロードすると、自動的に前回停止していた位置で立ち上げる
ことが可能になります（初期設定ではOffになっています）。

下記操作は、本機がMENUモードに入り、メイン・メニューの選択画面（“File >”が反転）に
なっていることを前提にしています。

レジューム機能のレジューム機能のレジューム機能のレジューム機能のレジューム機能のON/OFFON/OFFON/OFFON/OFFON/OFF設定設定設定設定設定

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Disk >Disk >Disk >Disk >Disk >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Diskメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Resume >Resume >Resume >Resume >Resume >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在の設定（OnまたはOff）が点滅し、エディット可能な画面に変ります。
初期設定では“Off”が点滅します。
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SetupSetupSetupSetupSetupメニューメニューメニューメニューメニュー
Setupメニューでは、FR-2LEの動作に関する下記19のサブ・メニューが用意されています。

1. Auto Level Control、Limiter機能のON/OFF設定
2. HPF (High Pass Filetr) 機能のON/OFF設定
3. 記録オーディオ・フォーマットの設定
4. 入力ソース（外部入力／内蔵マイク）の設定
5. ファンタム電源のON/OFF設定
6. モニターの出力モードを設定
7. 内蔵スピーカーのON/OFFを設定
8. 記録時作成されるファイルの、ファイル・ネーム・モードを設定
9. デフォルト・ファイル・ネームを設定
10. Pre Rec（プリ・レコーディング）機能のON/OFF設定
11. タイム表の表示モード設定
12. リメインの表示モードを設定
13. ファイルの最大記録容量を設定
14. 内蔵バッテリーのタイプ設定
15. エラー・トーン出力のON/OFF設定
16. リアルタイム・クロックの設定
17. 本機搭載ROMのバージョン確認
18. Setupメニューのイニシャライズ
19. ソフトウエアーのバージョンアップ

Auto Level ControlAuto Level ControlAuto Level ControlAuto Level ControlAuto Level Control、、、、、LimiterLimiterLimiterLimiterLimiter 機能の機能の機能の機能の機能のON/OFFON/OFFON/OFFON/OFFON/OFF設定設定設定設定設定
Auto Level Control機能のON/OFFおよびLimiter機能を設定します。
下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） “““““ALC : OffALC : OffALC : OffALC : OffALC : Off”””””が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在の設定が点滅し、任意に設定が可能になります（初期設定では“Off”が点滅します）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：この設定メニューは、クイックセットアップ・モードでも設定できます（55ページ参照）。
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33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで希望の設定項目を選択して、キーで希望の設定項目を選択して、キーで希望の設定項目を選択して、キーで希望の設定項目を選択して、キーで希望の設定項目を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した項目に設定され、一つ前の画面に変ります。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

初期設定の “Off”以外に、下記項目が選択できます。

Off（初期設定）

On

Limit

ALC (Auto Level Control) が機能します。

ATACK最小、Release最大に設定されたリミッターとして機能します。

ALC (Auto Level Control) ／Limiterともに機能しません。

HPF (High Pass Filter) HPF (High Pass Filter) HPF (High Pass Filter) HPF (High Pass Filter) HPF (High Pass Filter) 機能の機能の機能の機能の機能のON/OFFON/OFFON/OFFON/OFFON/OFF設定設定設定設定設定

ハイ・パス・フィルターのON/OFFを設定します。
下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““SetupSetupSetupSetupSetup”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““HPF : OffHPF : OffHPF : OffHPF : OffHPF : Off”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在の設定が点滅し、任意に設定が可能になります（初期設定ではOffが点滅します）。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““OnOnOnOnOn”””””またはまたはまたはまたはまたは“““““OffOffOffOffOff”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した項目に設定され、一つ前の画面に変ります。

ここでは、初期設定の“Off”または“On”が選択できます。

Off（初期設定）

On Fc: 100Hz -12dB/oct.のHPFが機能します。

HPFは機能しません。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：この設定メニューは、クイックセットアップ・モードでも設定できます（55ページ参照）。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。
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デフォルト記録フォーマットの設定デフォルト記録フォーマットの設定デフォルト記録フォーマットの設定デフォルト記録フォーマットの設定デフォルト記録フォーマットの設定

フォーマット時のデフォルト記録フォーマットを設定します。
下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Def. FS/BIT: ***Def. FS/BIT: ***Def. FS/BIT: ***Def. FS/BIT: ***Def. FS/BIT: ***”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
フォーマット時の記録フォーマット・タイプが点滅し、任意に設定が可能になります（下記例は、
フォーマット時の記録フォーマット・タイプがBWF44/16であることを示しています）。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで希望の記録フォーマットを選択して、キーで希望の記録フォーマットを選択して、キーで希望の記録フォーマットを選択して、キーで希望の記録フォーマットを選択して、キーで希望の記録フォーマットを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した項目に設定され、一つ前の画面に変ります。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

記録フォーマット・タイプは、フォーマット時と同様以下のタイプから選択できます。

BWF44/16

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：ここで設定するデフォルト記録フォーマットは、“Disk”メニューの“Format”における設
定画面上に表示されますが、設定画面上で任意に変更することが可能です。詳細は92ページを参照し
てください。

44.1kHz/16bitのBWFフォーマット
BWF48/16 48kHz/16bitのBWFフォーマット

BWF44/24 44.1kHz/24bitのBWFフォーマット

BWF48/24 48kHz/24bitのBWFフォーマット

BWF88/24 88.2kHz/24bitのBWFフォーマット

BWF96/24 96kHz/24bitのBWFフォーマット

MP3-192 MP3-192kbpsの圧縮フォーマット

* MP3 (MPEG Layer-3): MPEG Layer-3オーディオ・レコーディング技術は、Fraunhofer IIS
およびThomsonから実施許諾されています。
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入力ソースの設定入力ソースの設定入力ソースの設定入力ソースの設定入力ソースの設定

記録ソースを内蔵マイク入力にするか、外部入力ソースにするかを設定します。
下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““SetupSetupSetupSetupSetup”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Source SelSource SelSource SelSource SelSource Sel”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在の設定が点滅し、任意に設定が可能になります（初期設定では INPUTが点滅）。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで希望の入力ソースを選択して、キーで希望の入力ソースを選択して、キーで希望の入力ソースを選択して、キーで希望の入力ソースを選択して、キーで希望の入力ソースを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した項目に設定され、一つ前の画面に変ります。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

ここでは、初期設定の“INPUT”以外に下記入力ソースが選択できます。

INPUT（初期設定）

I. MIC H 高感度（32dB）での内蔵マイクが優先となり、 [ANALOG IN] からの入
力は無効になります。

[ANOLOG IN] 端子に入力する音源（外部マイクまたはライン）が優先と
なり、内蔵マイクは機能しません。

I. MIC L 低感度（16dB）での内蔵マイクが優先となり、 [ANALOG IN] からの入
力は無効になります。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：入力ソースを内蔵マイクに設定したときは、本体トリムや入力つまみは機能しません。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：この設定メニューは、クイックセットアップ・モードでも設定できます（55ページ参照）。
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ファンタム電源のファンタム電源のファンタム電源のファンタム電源のファンタム電源のON/OFFON/OFFON/OFFON/OFFON/OFF設定設定設定設定設定

外部入力ソースにコンデンサ・マイクを使用する場合、ファンタム電源を供給するかしないか
を設定します。

下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Phantom >Phantom >Phantom >Phantom >Phantom >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在の設定が点滅し、任意に設定が可能になります（初期設定ではOffが点滅）。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““OnOnOnOnOn”””””またはまたはまたはまたはまたは“““““OffOffOffOffOff”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した項目に設定され、一つ前の画面に変ります。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

ここでは、初期設定の“Off”以外に“On”が選択できます。

OffOffOffOffOff（（（（（初初初初初期期期期期設設設設設定定定定定）））））

OnOnOnOnOn [ANALOG IN] のXLRコネクタにファンタム電源が供給されます。

ファンタム電源は供給されません。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：ファンタム電源は、 [ANALOG INPUT] の L/R同時にON/OFFします。

＜ファンタム電源使用時のご注意＞＜ファンタム電源使用時のご注意＞＜ファンタム電源使用時のご注意＞＜ファンタム電源使用時のご注意＞＜ファンタム電源使用時のご注意＞
● ファンタム電源は、 [ANALOG IN] のXLRコネクタにのみ供給されます。
● コンデンサ・マイクを [ANALOG INPUT] のXLRコネクタに接続するときは、�ファンタム電源が

使える機種であることを確認してください。
● ファンタム電源は、 [ANOLOG INPUT] のXLRコネクタにマイクを接続してから供給してください。
● ファンタム電源のOn/Off、およびマイクを抜き差しする場合は、事前に本機入力つまみや

[MONITOR] つまみを最小に絞ってください。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：この設定メニューは、クイックセットアップ・モードでも設定できます（55ページ参照）。
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モニターの出力モード設定モニターの出力モード設定モニターの出力モード設定モニターの出力モード設定モニターの出力モード設定

 [MONITOR OUT] 、 [PHONES] および内蔵スピーカからの出力モード（ステレオまたはモノ）
を設定します。

下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： [PHONES] ジャックにヘッドホンを接続した場合、内蔵スピーカは遮断されます。

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Monitor Mode: **Monitor Mode: **Monitor Mode: **Monitor Mode: **Monitor Mode: **”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在の設定が点滅し、任意に設定が可能になります（初期設定では“L/R”が点滅）。

ここでは、初期設定の“L/R”以外に“MONO”が選択できます。

L/RL/RL/RL/RL/R（（（（（初初初初初期期期期期設設設設設定定定定定）））））

MONOMONOMONOMONOMONO モニター音がモノラルで出力されます。

モニター音がステレオ（L／R）で出力されます。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで希望の出力モードを選択して、キーで希望の出力モードを選択して、キーで希望の出力モードを選択して、キーで希望の出力モードを選択して、キーで希望の出力モードを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した出力モードに設定され、一つ前の画面に変ります。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。
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内蔵スピーカの内蔵スピーカの内蔵スピーカの内蔵スピーカの内蔵スピーカのON/OFFON/OFFON/OFFON/OFFON/OFF設定設定設定設定設定

再生時内蔵スピーカからモニター音を出力するか、しないかを設定します。初期設定はONに
設定されていて、再生時にモニター音が内蔵スピーカから出力するようになっています。

下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Speaker OutSpeaker OutSpeaker OutSpeaker OutSpeaker Out”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在の設定が点滅し、任意に設定が可能になります（初期設定では“On”が点滅）。

ここでは、初期設定の“On”または“Off”が選択できます。

OnOnOnOnOn（（（（（初初初初初期期期期期設設設設設定定定定定）））））

OffOffOffOffOff 内蔵スピーカからモニター音を出力しません。

再生時のみ、内蔵スピーカからモニター音を出力します。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““OnOnOnOnOn”””””またはまたはまたはまたはまたは“““““OffOffOffOffOff”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したモードに設定され、一つ前の画面に変ります。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：： 設定が“On”になっていても、 [PHONES] ジャックにヘッドホンを接続すると内蔵
スピーカからの出力は遮断されます。なお、記録スタンバイおよび記録時も内蔵スピーカは遮断
されます。
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記録時新規に作成されるオーディオ・ファイルのファイル・ネームを日付けにするか、Scene
name + Take No.にするか、あるいはReel No. + File No.にするかの、ファイル・ネーム・
モードを設定します。

下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでファイルネームキーでファイルネームキーでファイルネームキーでファイルネームキーでファイルネーム・・・・・モードを選択して、モードを選択して、モードを選択して、モードを選択して、モードを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
“Date”または“Reel”に設定した場合は一つ前の画面に戻りますので、つぎの操作4）でMENU
モードから抜け出します。また、“Take”に設定した場合は自動的に“Default File Name”を設
定する画面へ進みますので、次ページ「デフォルト・ファイル・ネームの設定」を参照して、任意
のシーン・ネームとTake Numberを設定します。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

DateDateDateDateDate
（（（（（初初初初初期期期期期設設設設設定定定定定）））））

リアルタイム・クロックのタイム・データを基にしたファイル・ネームが記録され
ます。例としてBWFファイルでは“““““B12h30m25s25jan2007y.wavB12h30m25s25jan2007y.wavB12h30m25s25jan2007y.wavB12h30m25s25jan2007y.wavB12h30m25s25jan2007y.wav”””””、MP3ファイ
ルでは“““““B12h30m25s25jan2007y.mp3B12h30m25s25jan2007y.mp3B12h30m25s25jan2007y.mp3B12h30m25s25jan2007y.mp3B12h30m25s25jan2007y.mp3”””””となり、15文字まで表示されます。

TakeTakeTakeTakeTake

後述の“DefaultSceneNameDefaultSceneNameDefaultSceneNameDefaultSceneNameDefaultSceneName”で設定したScene Name + Take No.がファイル・
ネームとして記録されます。例えば、Scene Nameが“Original NameOriginal NameOriginal NameOriginal NameOriginal Name”でTake No
が“001001001001001”に設定されている場合、BWFファイルのファイル・ネームは“OriginalOriginalOriginalOriginalOriginal
Name_001.wavName_001.wavName_001.wavName_001.wavName_001.wav”、MP3ファイルのファイル・ネームは“Original Name_001.mp3Original Name_001.mp3Original Name_001.mp3Original Name_001.mp3Original Name_001.mp3”
が記録されます。

記録時作成されるファイルの、記録時作成されるファイルの、記録時作成されるファイルの、記録時作成されるファイルの、記録時作成されるファイルの、ファイルファイルファイルファイルファイル・・・・・ネームネームネームネームネーム・・・・・モードを設定モードを設定モードを設定モードを設定モードを設定

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““FileNameMode: **FileNameMode: **FileNameMode: **FileNameMode: **FileNameMode: **”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在の設定が点滅し、任意に設定が可能になります（初期設定では“Date”が点滅）。

ここでは、初期設定の“Date”以外に“Take”または“Reel”が選択できます。

ReelReelReelReelReel

コンパクトフラッシュ・カードのボリューム・ラベル（Reel Number） + File No.が
ファイル・ネームとして記録されます。例えば、Reel Numberが“*************************”でFile No
が“001001001001001”の場合、BWFファイルのファイル・ネームは“*****_001.wav*****_001.wav*****_001.wav*****_001.wav*****_001.wav”、MP3
ファイルのファイル・ネームは“*****_001.mp3*****_001.mp3*****_001.mp3*****_001.mp3*****_001.mp3”が記録されます。
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ファイル・ネームに使用するScene NameとTake No.を設定します。
ここで設定したScene Name+Take No.は、前述のファイルネーム・モードを“Take”に設定
することで反映されます。

下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで希望のファイル希望のファイル希望のファイル希望のファイル希望のファイル・・・・・ネームを選択して、ネームを選択して、ネームを選択して、ネームを選択して、ネームを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ここでは例として“02: Scene02_00102: Scene02_00102: Scene02_00102: Scene02_00102: Scene02_001”を選択します。

上記画面にある各パラメータは、以下の用途に使用します。

Take No.Take No.Take No.Take No.Take No. 希望のTake Noを設定します（001～999)

次ページからの設定例は、“02: Scene02_001”を選択して、任意のScene NameとTake
Noを設定して、そのScene Name+Take Noを有効にするまでの手順を記載しています。

RenameRenameRenameRenameRename 新たなScene Nameを設定し直します。

ResetResetResetResetReset 選択したScene Name+Take Noをデフォルト（Scene01-001など）に設定します。
SelectSelectSelectSelectSelect 選択したScene Name+Take Noをデフォルト・ファイル・ネームに設定します。

デフォルトデフォルトデフォルトデフォルトデフォルト・・・・・ファイルファイルファイルファイルファイル・・・・・ネームを設定ネームを設定ネームを設定ネームを設定ネームを設定

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““SetupSetupSetupSetupSetup”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Default File NameDefault File NameDefault File NameDefault File NameDefault File Name”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
デフォルト・ファイル・ネームを選択する画面に変ります。一番上にある“* 01: Scene_001”は、
現在選択されているデフォルトのScene Name + Take Numberを示しています。
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●●●●● Take No Take No Take No Take No Take Noを設定を設定を設定を設定を設定
11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Take No.: _001Take No.: _001Take No.: _001Take No.: _001Take No.: _001”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。

現在設定されているTake No.が点滅します（初期設定では“001001001001001”が点滅します）。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで希望のナンバーを選択して、キーで希望のナンバーを選択して、キーで希望のナンバーを選択して、キーで希望のナンバーを選択して、キーで希望のナンバーを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Take No.は001～999から任意に選択でき、 [MENU/ENTER] キーを押すとナンバーが確定し
て一つ前の画面に戻ります（ここでは例として、初期値の001のままつぎの操作を実行します）。

●●●●●     オリジナルのオリジナルのオリジナルのオリジナルのオリジナルのScene NameScene NameScene NameScene NameScene Nameを設定を設定を設定を設定を設定
11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Rename >Rename >Rename >Rename >Rename >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。

選択したScene Name（Scene02）が編集可能な画面に変ります。

22222））））） 希望のシーン希望のシーン希望のシーン希望のシーン希望のシーン・・・・・ネームを入力します。ネームを入力します。ネームを入力します。ネームを入力します。ネームを入力します。
下記操作を参照して、新たなシーン・ネームを入力します。最大13文字まで入力可能です。

[   ] 内にあるカーソルは「「「「「SceneNameSceneNameSceneNameSceneNameSceneNameカーソル」カーソル」カーソル」カーソル」カーソル」と呼び、文字／記号候補にあるカーソルを「「「「「文文文文文
字候補カーソル」字候補カーソル」字候補カーソル」字候補カーソル」字候補カーソル」と呼んでいます。SceneNameカーソルは [REWIND] キー／[F FWD] キーで移
動でき、文字候補カーソルは [+] / [-] キーで移動できます。

SceneNameSceneNameSceneNameSceneNameSceneNameカーソカーソカーソカーソカーソ
ル位置の文字を変更ル位置の文字を変更ル位置の文字を変更ル位置の文字を変更ル位置の文字を変更

[+] / [-] キーで選択した文字／記号に変更できます。

スペースを作るスペースを作るスペースを作るスペースを作るスペースを作る
スペースはSceneNameカーソルの後ろに作ることができます。
希望の位置にSceneNameカーソルを移動した後、文字候補カーソルを一
番下にある“[INS]”に移動して [MENU/ENTER] キーを押します。

SceneNameSceneNameSceneNameSceneNameSceneNameカーソカーソカーソカーソカーソ
ル位置の文字を削除ル位置の文字を削除ル位置の文字を削除ル位置の文字を削除ル位置の文字を削除

削除したい文字にSceneNameカーソルを移動した後、文字候補カーソル
を“[DEL]”に移動して [MENU/ENTER] キーを押します。

SceneNameSceneNameSceneNameSceneNameSceneNameカーソカーソカーソカーソカーソ
ル位置の前に文字をル位置の前に文字をル位置の前に文字をル位置の前に文字をル位置の前に文字を
インサートインサートインサートインサートインサート

希望の位置にSceneNameカーソルを移動した後、文字候補カーソルを一
番下にある“[INS]”に移動して [MENU/ENTER] キーを押します。その
後、文字候補カーソルから文字を選択して [MENU/ENTER] キーを押し
ます。

SceneNameSceneNameSceneNameSceneNameSceneNameカーソカーソカーソカーソカーソ
ルの移動ルの移動ルの移動ルの移動ルの移動 [REWIND] キー/[F FWD] キーを押して移動します。

文字候補カーソルの文字候補カーソルの文字候補カーソルの文字候補カーソルの文字候補カーソルの
移動移動移動移動移動 [+] キー/[-] キーを押して移動します。
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●●●●●     編集したファイル編集したファイル編集したファイル編集したファイル編集したファイル・・・・・ネームネームネームネームネーム (Scene Name+Take Number)  (Scene Name+Take Number)  (Scene Name+Take Number)  (Scene Name+Take Number)  (Scene Name+Take Number) を使用可能にするを使用可能にするを使用可能にするを使用可能にするを使用可能にする
11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Select >Select >Select >Select >Select >”””””を選択してを選択してを選択してを選択してを選択して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。

編集したScene Name + Take Noがデフォルト・ファイル・ネームに設定され、下記例の画面
に変ります（ここでは例として“Original Name_001”が設定されます）。

22222））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

上記のように、シーン・ネームを“Original Name”、Take No.を“001”に設定したファイル・ネー
ムを、デフォルト・ファイル・ネームに選択して記録すると、最初に記録したファイルのファイル・
ネームは“Original Name_001”となります。
また、この状態で再度記録を繰り返すと、つぎのファイル・ネームは“Original Name_002”となり、
記録を繰り返すごとにTake No.のみがカウント・アップして登録されます。

●●●●●     デフォルトデフォルトデフォルトデフォルトデフォルト・・・・・ファイルファイルファイルファイルファイル・・・・・ネームを初期設定値に戻すにはネームを初期設定値に戻すにはネームを初期設定値に戻すにはネームを初期設定値に戻すにはネームを初期設定値に戻すには
11111））））） 初期設定にしたいファイル初期設定にしたいファイル初期設定にしたいファイル初期設定にしたいファイル初期設定にしたいファイル・・・・・ネームを選択してネームを選択してネームを選択してネームを選択してネームを選択して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。

例として、前述の操作で設定した“Original Name_001”を選択します。

33333））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

33333））））） 入力後、入力後、入力後、入力後、入力後、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
リネーム処理が終り、１つ前の画面に変ります（例として“Original Name”を入力します）。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Reset >Reset >Reset >Reset >Reset >”””””を選択してを選択してを選択してを選択してを選択して [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したファイル・ネームが初期設定のネームにリセットされます。
“Original Name_001”をリセットすると、“Scene02_001”に設定されます。
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Pre RecモードのON/OFFを設定します（初期設定ではOffに設定されています）。
Pre Recモードとは、バッファに貯えられたオーディオ・データ（約2秒）を含めて記録する
機能です。そのため、Pre RecモードをONにして記録することで、記録開始時の記録漏れを
防止することができます。

下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

Pre RecPre RecPre RecPre RecPre RecモードのモードのモードのモードのモードのON/OFFON/OFFON/OFFON/OFFON/OFFを設定を設定を設定を設定を設定

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““SetupSetupSetupSetupSetup”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Pre Rec: **Pre Rec: **Pre Rec: **Pre Rec: **Pre Rec: **”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されている、Pre Recモードが点滅します（初期設定では“Off”が点滅します）

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““OnOnOnOnOn”””””またはまたはまたはまたはまたは“““““OffOffOffOffOff”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したモードに設定され、一つ前の画面に戻ります。

OnOnOnOnOn

OffOffOffOffOff（（（（（初初初初初期期期期期設設設設設定定定定定））））） 記録を開始した時点からのオーディオ・データを記録していきます。

記録を開始すると、バッファに貯えられたオーディオ・データ（約2秒）
も含めて記録していきます。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。
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ディスプレイのタイム表示を設定します。時間表示は、ABS、プログラム・タイム、またはTIME
STAMP (24H)  から選択できます（初期設定はABS表示になっています）。

下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

タイム表示の表示モードを設定タイム表示の表示モードを設定タイム表示の表示モードを設定タイム表示の表示モードを設定タイム表示の表示モードを設定

表示モードは、初期設定の“ABSABSABSABSABS”以外に“PGMPGMPGMPGMPGM”または“24H24H24H24H24H”が選択できます。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで希望の表示モードを選択して、キーで希望の表示モードを選択して、キーで希望の表示モードを選択して、キーで希望の表示モードを選択して、キーで希望の表示モードを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した表示モードが確定して、一つ前の画面に変ります。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

ABSABSABSABSABS
（（（（（初初初初初期期期期期設設設設設定定定定定）））））

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Time Display: **Time Display: **Time Display: **Time Display: **Time Display: **”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されている表示モードが点滅します（初期設定では“ABS”が点滅します）

一番最初にエントリーされているオーディオ・ファイルの先頭を0としてカウント
アップしていき、エントリーされている全てのオーディオ・ファイルを通して、連
続してカウントします。

PGMPGMPGMPGMPGM オーディオ・ファイルごとに0からカウント・アップし、次のファイル先頭から0
に戻ってカウント・アップします。

24H24H24H24H24H
内蔵RTCを記録するBWFのTime Stampの値を基準にして、オーディオ・ファイ
ル単位で表示します。
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記録時（または再生／停止中）、ディスプレイに表示されるメモリー・カードの残量（リメイン）
を示す表示モードを設定します。

下記操作は、本機がMENUモードに入り、メイン・メニューの選択画面（“File >”が反転）が
表示されていることを前提にしています。

表示モードは、初期設定の“TimeTimeTimeTimeTime”の他に“MByteMByteMByteMByteMByte”が選択できます。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで希望の表示モードを選択して、キーで希望の表示モードを選択して、キーで希望の表示モードを選択して、キーで希望の表示モードを選択して、キーで希望の表示モードを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択後 [MENU/ENTER] キーを押すと、表示モードが確定して一つ前の画面に変ります。

MByteMByteMByteMByteMByte メモリー・カードの残量を、MByteで表示します。

TimeTimeTimeTimeTime（（（（（初初初初初期期期期期設設設設設定定定定定））））） メモリー・カードの残量を、時間で表示します。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：リメイン表示の詳細については、前述「第3章　各部の名称と機能」の45ページを
参照してください。

リメインの表示モードを設定リメインの表示モードを設定リメインの表示モードを設定リメインの表示モードを設定リメインの表示モードを設定

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““SetupSetupSetupSetupSetup”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““RemainDisplayRemainDisplayRemainDisplayRemainDisplayRemainDisplay”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されている、表示モードが点滅します（初期設定ではTimeが点滅します）

設定するリメインの表示モードによって、ディスプレイには下記例のように表示されます。

＜表示モード＜表示モード＜表示モード＜表示モード＜表示モード= Time= Time= Time= Time= Time＞＞＞＞＞ ＜表示モード＜表示モード＜表示モード＜表示モード＜表示モード= MByte= MByte= MByte= MByte= MByte＞＞＞＞＞
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１つのオーディオ・ファイルに記録可能な最大容量（2GBまたは4GB）を設定します（初期設
定では2GBになっています）。

下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：設定されている最大記録容量まで記録すると、自動的に記録を終了して停止します。
なお、最大記録容量以下のメモリー・カードを使用している場合は、設定に関わらずカードの残容量が
無くなった時点で記録を終了します。

ファイルの最大記録容量を設定ファイルの最大記録容量を設定ファイルの最大記録容量を設定ファイルの最大記録容量を設定ファイルの最大記録容量を設定

ファイル・サイズは、初期設定の“2GB2GB2GB2GB2GB”の他に“4GB4GB4GB4GB4GB”が選択できます。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで希望のファイルキーで希望のファイルキーで希望のファイルキーで希望のファイルキーで希望のファイル・・・・・サイズを選択して、サイズを選択して、サイズを選択して、サイズを選択して、サイズを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したファイル・サイズが確定して、一つ前の画面に変ります。

2GB2GB2GB2GB2GB（（（（（初初初初初期期期期期設設設設設定定定定定）））））

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューあを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Max File SizeMax File SizeMax File SizeMax File SizeMax File Size”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されている、ファイル・サイズが点滅します（初期設定では“2GB”が点滅します）

ファイル・サイズを最大2GBに設定します。

4GB4GB4GB4GB4GB ファイル・サイズを最大4GBに設定します。
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本機をバッテリー（ニッケル水素電池、ニッカド電池、アルカリ電池、またはタミヤバッテリー）
で駆動する場合、使用するバッテリーのタイプを設定します。

下記操作は、本機がMENUモードに入り、メイン・メニューの選択画面（“File >”が反転）が
表示されていることを前提にしています。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：バッテリーで本機を駆動するときは、必ずバッテリー・タイプを設定してからご使用くださ
い。使用する電池と設定が異なっていると、電源電圧の違いなどによって、エラー・トーンの出力機能
などが正常に機能しなくなります。そのため、ご使用前には、必ずバッテリー・タイプを合わせるよう
にしてください。

本機を駆動するためのバッテリー本機を駆動するためのバッテリー本機を駆動するためのバッテリー本機を駆動するためのバッテリー本機を駆動するためのバッテリー・・・・・タイプを設定タイプを設定タイプを設定タイプを設定タイプを設定

バッテリー・タイプは、初期設定の“NiMHNiMHNiMHNiMHNiMH”の他に“NiCdNiCdNiCdNiCdNiCd”、“AlkaliAlkaliAlkaliAlkaliAlkali”または“RC7.2VRC7.2VRC7.2VRC7.2VRC7.2V”が選択で
きます。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーで希望のバッテリーキーで希望のバッテリーキーで希望のバッテリーキーで希望のバッテリーキーで希望のバッテリー・・・・・タイプを選択して、タイプを選択して、タイプを選択して、タイプを選択して、タイプを選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択したバッテリー・タイプが確定して、一つ前の画面に変ります。

NiMHNiMHNiMHNiMHNiMH（（（（（初初初初初期期期期期設設設設設定定定定定）））））

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Battery Type: **Battery Type: **Battery Type: **Battery Type: **Battery Type: **”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されている、バッテリー・タイプが点滅します（初期設定では“NiMH”が点滅します）

ニッケル水素電池を使うとき選択します。

NiCdNiCdNiCdNiCdNiCd ニッカド電池を使うとき選択します。

AlkaliAlkaliAlkaliAlkaliAlkali アルカリ電池を使うとき選択します。

RC7.2VRC7.2VRC7.2VRC7.2VRC7.2V
タミヤバッテリーを使うとき選択します。
タミヤバッテリーを使用したときは、自動的に“Battery Type”
が“RC7.2V”に設定されるようになっています。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：タミヤバッテリーを使用したときは、自動的に“Battery Type”が“RC7.2V”に設
定されるようになっています。そのため、タミヤバッテリーを使った後Ni-CdやNi-MHなどの
単三電池を使用するときは、必ず手動で“Battery Type”を設定し直してご使用ください。 な
お、“Battery Type”が“RC7.2V”に設定されたまま単三電池を使用すると、アラーム音を発
して警告します。これはバッテリーのダメージを最小限に抑えるための措置で、“Battery Type”
を正しく設定することでアラーム音は出なくなります。
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バッテリー電圧が許容以下になったとき、およびメモリー・カードの記録可能な残時間がある
一定時間になったとき、内蔵スピーカ（またはヘッドホン）からエラー・トーンを出力するか、
しないかを設定します。

下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““OnOnOnOnOn”””””またはまたはまたはまたはまたは“““““OffOffOffOffOff”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
選択した出力モードが設定され、一つ前の画面に戻ります。

エラーエラーエラーエラーエラー・・・・・トーン出力の設定／解除トーン出力の設定／解除トーン出力の設定／解除トーン出力の設定／解除トーン出力の設定／解除

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Error Tone: **Error Tone: **Error Tone: **Error Tone: **Error Tone: **”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されているエラートーンの出力モードが点滅します（初期設定では“Off”が点滅します）

エラー・トーンは、本機が下記状態に達した時点で出力します。

出力する環境出力する環境出力する環境出力する環境出力する環境 エラートーンの種類エラートーンの種類エラートーンの種類エラートーンの種類エラートーンの種類

現在本機を駆動している電池が規定電圧以下に達したとき、エラー
トーンを出力します。

メモリー・カードのリメインが1分以下になったとき、RECおよびREC
STANDBY時にエラートーンを出力します。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

OnOnOnOnOn

OffOffOffOffOff（（（（（初初初初初期期期期期設設設設設定定定定定））））） エラートーンは出力しません。

エラートーンが出力できます。
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本機内蔵の「リアルタイム・クロック」を設定します。
タイム・データは工場出荷時の日時で動作していますので、正しいタイム・データに設定し直
すことができます。タイム・データは、オーディオ・ファイル作成時のファイル・ネーム／ファ
イル作成日時や、BWFファイルのTIME STAMPに利用されます。

下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

33333））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで一番下にある一番下にある一番下にある一番下にある一番下にある“““““Edit  >Edit  >Edit  >Edit  >Edit  >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在表示されているタイム・データがホールドされ、エディット可能になります。
エディットする桁は [REWIND] キー／ [F FWD] キーで移動します。

44444））））） 希望のタイム希望のタイム希望のタイム希望のタイム希望のタイム・・・・・データを入力します。データを入力します。データを入力します。データを入力します。データを入力します。
[+] / [-] キーで数値を入力して [MENU/ENTER] キーを押すと、カーソルが自動的に次の値に移
動します。同じ要領で希望のタイムデータを設定していきます。
一番右端の秒の値を入力して [MENU/ENTER] キーを押すと、カーソルが“[ENTER]”に移動し
ます。カーソルが秒以外の桁にあるときは、 [MENU/ENTER] キーを押していくか、 [F FWD] キー
を押していくと、カーソルを“[ENTER]”に移動できます。

リアルタイムに時刻を刻んでいる状態で、パラメータ“Set 00s >Set 00s >Set 00s >Set 00s >Set 00s >”を選択して [MENU/
ENTER] キーを押すと、リアルタイム・クロックの秒の値を“0000000000”にリセットできます（29
秒以下では秒のみ00にリセットし、30秒以上では分を繰り上げて秒を00にリセットします）。

リアルタイムリアルタイムリアルタイムリアルタイムリアルタイム・・・・・クロックの設定クロックの設定クロックの設定クロックの設定クロックの設定

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““AdjustRealTimeClock >AdjustRealTimeClock >AdjustRealTimeClock >AdjustRealTimeClock >AdjustRealTimeClock >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されているタイム・データで、年月日／時間がリアルタイムに刻まれる画面に変ります。
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本機搭載のROMバージョンを確認します。

下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

33333））））） バージョン確認後バージョン確認後バージョン確認後バージョン確認後バージョン確認後、、、、、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
一つ前の画面に戻ります。

44444））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

本体本体本体本体本体ROMROMROMROMROMのバージョン確認のバージョン確認のバージョン確認のバージョン確認のバージョン確認

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
Setupメニューのサブ・メニューを選択する画面に変ります。

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Version >Version >Version >Version >Version >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在搭載されているROMのバージョン／日付が表示されます。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：本機ソフトウェアは、性能改善などにより予告無くバージョンアップされることがあります。
最新のバージョンについては、当社のホームページ（http: www.fostex.jp）で確認するか、当社サービ
ス部門へお問い合わせください。

55555））））） “““““[ENTER][ENTER][ENTER][ENTER][ENTER]”””””     が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、が反転している状態で、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
設定したタイム・データが確定し、一つ前の画面に戻ります。
時報に合わせて [MENU/ENTER] キーを押すことで、正確な時間が設定できます。

66666））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、MENUMENUMENUMENUMENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。
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22222））））） [+]  / [-] [+]  / [-] [+]  / [-] [+]  / [-] [+]  / [-] キーでキーでキーでキーでキーで“““““Initial Setup >Initial Setup >Initial Setup >Initial Setup >Initial Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
イニシャライズの実行を確認する画面に変わり、“Are you sure?Are you sure?Are you sure?Are you sure?Are you sure?”が点滅します。

33333））））） イニシャライズを実行するにはイニシャライズを実行するにはイニシャライズを実行するにはイニシャライズを実行するにはイニシャライズを実行するには [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
イニシャライズが実行され、終了と同時に“Completed!Completed!Completed!Completed!Completed!”が点灯します。

44444））））） [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] [MENU/ENTER] キーを押した後、キーを押した後、キーを押した後、キーを押した後、キーを押した後、 [STOP/CANCEL]  [STOP/CANCEL]  [STOP/CANCEL]  [STOP/CANCEL]  [STOP/CANCEL] キーを押してキーを押してキーを押してキーを押してキーを押してMENUMENUMENUMENUMENUモードから抜けモードから抜けモードから抜けモードから抜けモードから抜け
出します。出します。出します。出します。出します。

File Name ModeFile Name ModeFile Name ModeFile Name ModeFile Name Mode

Default File NameDefault File NameDefault File NameDefault File NameDefault File Name
Take Number

ALCALCALCALCALC
HPFHPFHPFHPFHPF

Scene Name

Def. FS/BITDef. FS/BITDef. FS/BITDef. FS/BITDef. FS/BIT BWF 44/16
Source SelSource SelSource SelSource SelSource Sel INPUT

Error ToneError ToneError ToneError ToneError Tone Off
Pre RecPre RecPre RecPre RecPre Rec Off
Remain DisplayRemain DisplayRemain DisplayRemain DisplayRemain Display Time

Date

Off

Scene01 - Scene20
001

* 上記以外に、コントラスト値も初期値に設定されます。

Setupメニューの全ての設定を、工場出荷時の初期設定に戻します。
下記操作は、本機がMENUモードに入りメイン・メニューの選択画面（“File >”が反転）が表
示されていることを前提にしています。

Time DisplayTime DisplayTime DisplayTime DisplayTime Display ABS

Max File SizeMax File SizeMax File SizeMax File SizeMax File Size 2GB
Battery TypeBattery TypeBattery TypeBattery TypeBattery Type NiMH

Off

PhantomPhantomPhantomPhantomPhantom Off

サブサブサブサブサブ・・・・・メニューメニューメニューメニューメニュー 初期設定値初期設定値初期設定値初期設定値初期設定値

SetupSetupSetupSetupSetupメニューのイニシャライズメニューのイニシャライズメニューのイニシャライズメニューのイニシャライズメニューのイニシャライズ

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
実行メニューを選択する画面に変ります。

Monitor ModeMonitor ModeMonitor ModeMonitor ModeMonitor Mode L/R

Speaker OutSpeaker OutSpeaker OutSpeaker OutSpeaker Out On
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本機搭載のソフトウエアをバージョンアップします。
下記操作は、当社ホームページからダウンロード（または当社サービス部門より提供）した最
新のソフトウエアを記録したメモリー・カードがスロットにセットされ、MENUモードのメイ
ン・メニュー選択画面（“File >”が反転）が表示されていることを前提にしています。

ソフトウエアのバージョンアップソフトウエアのバージョンアップソフトウエアのバージョンアップソフトウエアのバージョンアップソフトウエアのバージョンアップ

22222））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Version Up >Version Up >Version Up >Version Up >Version Up >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
メモリー・カードに記録されているソフトウエア（例“FR2V100.MOTFR2V100.MOTFR2V100.MOTFR2V100.MOTFR2V100.MOT”）が表示されます。

33333）））））      続けて続けて続けて続けて続けて [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
バージョンアップの実行を確認する画面に変り、“Are You Sure?Are You Sure?Are You Sure?Are You Sure?Are You Sure?”が点滅します。

44444））））） [RECORD] [RECORD] [RECORD] [RECORD] [RECORD] キーを押しながら、キーを押しながら、キーを押しながら、キーを押しながら、キーを押しながら、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
ソフトウエアの書き込みが始まり、終了と同時に“CompletedCompletedCompletedCompletedCompleted”が点灯します。

11111））））） [+] / [-] [+] / [-] [+] / [-] [+] / [-] [+] / [-] キーでキーでキーでキーでキーで“““““Setup >Setup >Setup >Setup >Setup >”””””を選択して、を選択して、を選択して、を選択して、を選択して、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
実行メニューを選択する画面に変ります。

55555））））） [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] [STOP/CANCEL] キーを押してキーを押してキーを押してキーを押してキーを押して MENU MENU MENU MENU MENUモードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。モードから抜け出します。

66666））））） FR-2LEFR-2LEFR-2LEFR-2LEFR-2LEの電源を入れ直します。の電源を入れ直します。の電源を入れ直します。の電源を入れ直します。の電源を入れ直します。
バージョンアップ後は、必ず電源を入れ直してください。確実にバージョンアップされたかどうかは、
前述109ページの操作でバージョンを確認してください。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：当社のホームページ（http: www.fostex.jp）からダウンロードするソフト・ウエアは、72ぺー
ジ「第6章　PCへのインポート」に記載されている「メモリー・カードへのコピー」を参照して、FR-
2LEのメモリー・カードへソフトウエアのファイルをコピーしてください。
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第第第第第88888章　製品の主な仕様章　製品の主な仕様章　製品の主な仕様章　製品の主な仕様章　製品の主な仕様
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* 0dBu = 0.775Vrms、0dBV = 1Vrms

入出力入出力入出力入出力入出力

ANALOG IN <L/R>ANALOG IN <L/R>ANALOG IN <L/R>ANALOG IN <L/R>ANALOG IN <L/R>
コネクタ ： XLR-PHONEコンボ・タイプ

＜＜＜＜＜LINELINELINELINELINE入力＞入力＞入力＞入力＞入力＞
コネクタ ： φ6mm TS PHONEジャック（アンバランス）
入力インピーダンス ： 10kΩ以上
基準入力レベル ： -10dBV
最大入力レベル ： +2dBV

＜＜＜＜＜MICMICMICMICMIC入力＞入力＞入力＞入力＞入力＞
コネクタ ： XLR-3-31タイプ（バランス、2番ホット）
入力インピーダンス ： 6kΩ以上
基準入力レベル ： -50dBu～ -10dBu
最大入力レベル ： +2dBu
ファントム ： P48

MONITOR OUT <L, R>MONITOR OUT <L, R>MONITOR OUT <L, R>MONITOR OUT <L, R>MONITOR OUT <L, R>
コネクタ ： RCAピンジャック（アンバランス）
適合負荷インピーダンス ： 10kΩ以上
基準出力レベル ： -10dBV

PHONESPHONESPHONESPHONESPHONES
コネクタ ： ステレオ・ミニフォーン・ジャック
適合負荷インピーダンス ： 32Ω以上
最大出力レベル ： 15mW + 15mW（32Ω）

USB 2.0USB 2.0USB 2.0USB 2.0USB 2.0（（（（（PCPCPCPCPC接続用）接続用）接続用）接続用）接続用）
コネクタ ： Series “B” Receptacle

内蔵スピーカ内蔵スピーカ内蔵スピーカ内蔵スピーカ内蔵スピーカ
最大出力 ： 300mW

記録／再生記録／再生記録／再生記録／再生記録／再生

記録メディア記録メディア記録メディア記録メディア記録メディア ： コンパクトフラッシュTM・カード

ファイルファイルファイルファイルファイル・・・・・フォーマットフォーマットフォーマットフォーマットフォーマット ： BWF (Broadcast Wave Format)、MP3 (MPEG Layer-3)

FSFSFSFSFS／量子化／量子化／量子化／量子化／量子化 ： 44.1kHz / 48kHz 16bit
： 44.1kHz / 48kHz / 88.2kHz / 96kHz 24bit
： MP3-192kbps

* MPEG Layer-3オーディオ・コーディング技術は、Fraunholer IISおよびThomsonから
実施許諾されています。
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記録トラック記録トラック記録トラック記録トラック記録トラック ： ステレオ

記録／再生周波数記録／再生周波数記録／再生周波数記録／再生周波数記録／再生周波数 ： 20Hz～20kHz ±2dB (FS 44.1/48kHz)
： 20Hz～40kHz ±3dB (FS 88.2/96kHz)

S/NS/NS/NS/NS/N（ADC DAC間、24bit、Fs: 48kHz）
LINE ： 95dB (Typical)
MIC (MIC TRIM: Max) ： 85dB (Typical)

ダイナミックダイナミックダイナミックダイナミックダイナミック・・・・・レンジレンジレンジレンジレンジ（ADC-DAC間、24bit、Fs: 48kHz）
： 95dB (Typical)

T.H.D.T.H.D.T.H.D.T.H.D.T.H.D.（ADC-DAC間、24bit、Fs: 48kHz）
LINE ： 0.008％以下（at 1kHz -1dB,  Typical）
MIC (MIC TRIM: Max) ： 0.01％以下（at 1kHz -1dB,  Typical）

チャンネルチャンネルチャンネルチャンネルチャンネル・・・・・セパレーションセパレーションセパレーションセパレーションセパレーション ： 90dB以上at 1kHz 0dB （24bit, Fs: 48kHz）

リファレンスリファレンスリファレンスリファレンスリファレンス・・・・・レベルレベルレベルレベルレベル ： -12dBFS

ロケートロケートロケートロケートロケート・・・・・メモリーメモリーメモリーメモリーメモリー ： CUEポイント　99個／ファイル

一　　般一　　般一　　般一　　般一　　般

外形寸法外形寸法外形寸法外形寸法外形寸法 ： 57 (H)×206 (W)×132 (D) mm

本体質量本体質量本体質量本体質量本体質量 ： 約800g（バッテリー除く）

電源電源電源電源電源 ： DC12V
ACアダプタ（本機付属）

： アルカリ／ニッカド／ニッケル水素電池
（単三×4本）別売

： タミヤバッテリー（7.2V）別売

消費電力消費電力消費電力消費電力消費電力 ： 約3W

* 製品の外観や規格は、改良のため将来予告なく変更することがあります。
* 付属品の詳細については17ページを参照してください。
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FR-2LE V1.10FR-2LE V1.10FR-2LE V1.10FR-2LE V1.10FR-2LE V1.10対応　追補版対応　追補版対応　追補版対応　追補版対応　追補版

（（（（（11111））））） DiskDiskDiskDiskDiskメニューのメニューのメニューのメニューのメニューのFormatFormatFormatFormatFormatメニューに、メニューに、メニューに、メニューに、メニューに、記録するトラックのモード記録するトラックのモード記録するトラックのモード記録するトラックのモード記録するトラックのモード（（（（（ススススステテテテテレレレレレオオオオオ／／／／／モモモモモノノノノノ）））））を選択するを選択するを選択するを選択するを選択する
項目を追加項目を追加項目を追加項目を追加項目を追加（（（（（FormatFormatFormatFormatFormat メニューの詳細は取扱説明書メニューの詳細は取扱説明書メニューの詳細は取扱説明書メニューの詳細は取扱説明書メニューの詳細は取扱説明書・・・・・本文の本文の本文の本文の本文の9393939393ページをお読みください）ページをお読みください）ページをお読みください）ページをお読みください）ページをお読みください）。。。。。

追加した“Track Mode”を選択して [MENU/ENTER] キーを押すと、初期設定の“STEREO”が点滅して、
[+] キー／ [-] キーで“STEREO”または“MONO”が選択できます（MONO設定は保存されません）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：FS/BIT Modeを“MP3-192”に選択したときは、Track
Modeは“MONO”に設定できません。“MONO”を選択してフォー
マットを実行しようとしても右記ポップアップ画面が表われ、Track
Modeは“STEREO”に再設定されます。

（（（（（22222））））） DiskDiskDiskDiskDiskメニューにメモリーメニューにメモリーメニューにメモリーメニューにメモリーメニューにメモリー・・・・・カードの情報を表示するカードの情報を表示するカードの情報を表示するカードの情報を表示するカードの情報を表示する“““““Disk Info.Disk Info.Disk Info.Disk Info.Disk Info.”””””メニューを追加メニューを追加メニューを追加メニューを追加メニューを追加

追加した“Disk Info.”を選択して [MENU/ENTER] キーを押すと、現在使用しているメモリー・カードのメー
カ／機種名などが表示されます（下記例を参照）。

（（（（（33333））））） SetupSetupSetupSetupSetupメニューにメニューにメニューにメニューにメニューにLEDLEDLEDLEDLEDレベルレベルレベルレベルレベル・・・・・メータの機能を選択するメータの機能を選択するメータの機能を選択するメータの機能を選択するメータの機能を選択する“““““Level LED modeLevel LED modeLevel LED modeLevel LED modeLevel LED mode”””””メニューを追加メニューを追加メニューを追加メニューを追加メニューを追加

追加した“Level LED mode”を選択して [MENU/ENTER] キーを押すと、現在の設定が点滅して [+] キー／
[-] キーで “Peak”または“Level”が選択できます（設定は保存されます）。

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：Track Modeを“MONO”に設定してフォーマットした場
合、LCDのレベル・メータおよび本体フロント・パネル部にあるLED
メータはLチャンネルのみが機能し、内蔵マイクおよび外部入力端子
も Lチャンネルのみが使用可能になります（LCDのレベル・メータ
は右図のように変ります）。なお、モニター出力（L/R）はLチャン
ネルの音声が出力されます。

Peak（初期設定）

Level

フロント・パネル部にあるLEDレベル・メータが、ピーク表示として機能します。

フロント・パネル部にあるLEDレベル・メータが、レベル表示として機能します。

追加したメニュー

追加したメニュー

追加した項目

点滅

点滅

FR-2LEのソフトウエアをV1.10にバージョンアップして、MENUモードのDiskメニューとSetupメニュー
に下記の機能を追加しました。取扱説明書・本文のMENUモード解説と併せてお読みください。

* LCD内のレベル・メータは設定に影響されません。

© PRINTED IN CHINA JUNE 2007 8588 099 000 (465577)



FR-2LE V1.20FR-2LE V1.20FR-2LE V1.20FR-2LE V1.20FR-2LE V1.20対応　追補版対応　追補版対応　追補版対応　追補版対応　追補版

＜ご注意！＞＜ご注意！＞＜ご注意！＞＜ご注意！＞＜ご注意！＞
＜＜＜＜＜MP3MP3MP3MP3MP3（（（（（圧圧圧圧圧縮縮縮縮縮モモモモモーーーーードドドドド）））））記録時における変調ノイズについて＞記録時における変調ノイズについて＞記録時における変調ノイズについて＞記録時における変調ノイズについて＞記録時における変調ノイズについて＞

圧縮モード圧縮モード圧縮モード圧縮モード圧縮モード（（（（（MP3-192MP3-192MP3-192MP3-192MP3-192またはまたはまたはまたはまたはMP3-96MP3-96MP3-96MP3-96MP3-96）））））で記録したソースを比較的静かな状況下で再生した場合、で記録したソースを比較的静かな状況下で再生した場合、で記録したソースを比較的静かな状況下で再生した場合、で記録したソースを比較的静かな状況下で再生した場合、で記録したソースを比較的静かな状況下で再生した場合、
[PHONES] [PHONES] [PHONES] [PHONES] [PHONES] ボリュームを大きくすると背景音が変調されたようなボリュームを大きくすると背景音が変調されたようなボリュームを大きくすると背景音が変調されたようなボリュームを大きくすると背景音が変調されたようなボリュームを大きくすると背景音が変調されたような「「「「「ノノノノノイイイイイズズズズズ音音音音音」」」」」が聞こえることがありまが聞こえることがありまが聞こえることがありまが聞こえることがありまが聞こえることがありま
す。す。す。す。す。

これは、これは、これは、これは、これは、MP3MP3MP3MP3MP3特有の変調ノイズであり、特有の変調ノイズであり、特有の変調ノイズであり、特有の変調ノイズであり、特有の変調ノイズであり、記録信号レベルおよび背景ノイズの周波数スペクトルに依存し記録信号レベルおよび背景ノイズの周波数スペクトルに依存し記録信号レベルおよび背景ノイズの周波数スペクトルに依存し記録信号レベルおよび背景ノイズの周波数スペクトルに依存し記録信号レベルおよび背景ノイズの周波数スペクトルに依存し
ています。ています。ています。ています。ています。そのため、そのため、そのため、そのため、そのため、このような変調ノイズが問題となる場合はこのような変調ノイズが問題となる場合はこのような変調ノイズが問題となる場合はこのような変調ノイズが問題となる場合はこのような変調ノイズが問題となる場合は「「「「「圧圧圧圧圧縮縮縮縮縮モモモモモーーーーードドドドド（（（（（MP3MP3MP3MP3MP3）））））」」」」」での記録は避け、での記録は避け、での記録は避け、での記録は避け、での記録は避け、
「「「「「非非非非非圧圧圧圧圧縮縮縮縮縮モモモモモーーーーードドドドド（（（（（BWF)BWF)BWF)BWF)BWF)」」」」」で記録することをお勧めします。で記録することをお勧めします。で記録することをお勧めします。で記録することをお勧めします。で記録することをお勧めします。

FR-2LEのソフトウエアをV1.20にバージョンアップし、以下の機能を追加しました。
本書ではバージョンアップにより追加された機能についてのみ記載しておりますので、取扱説明書・本文お
よび他の追補版と併せてお読みください。

© PRINTED IN CHINA FEB. 2008 8588 102 000 (478437)

＜＜＜＜＜“““““STEREOSTEREOSTEREOSTEREOSTEREO”””””選択時＞選択時＞選択時＞選択時＞選択時＞ ＜＜＜＜＜“““““MONOMONOMONOMONOMONO”””””選択時＞選択時＞選択時＞選択時＞選択時＞

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：Track Modeを“MONO”に選択すると、FS/BIT Modeは自動的に“MP3-96”（MP3-96kbpsの
圧縮モード）に設定され、“STEREO”を選択したときは“MP3-192”（MP3-192kbpsの圧縮モード）に設定
されます（下記図を参照）。

（（（（（22222））））） BWFBWFBWFBWFBWFのののののTime referenceTime referenceTime referenceTime referenceTime referenceに、に、に、に、に、内蔵内蔵内蔵内蔵内蔵RTC (Real Time Clock) RTC (Real Time Clock) RTC (Real Time Clock) RTC (Real Time Clock) RTC (Real Time Clock) から求めた記録時間のサンプルから求めた記録時間のサンプルから求めた記録時間のサンプルから求めた記録時間のサンプルから求めた記録時間のサンプル・・・・・ワーワーワーワーワー
ドを記録するようにしました。ドを記録するようにしました。ドを記録するようにしました。ドを記録するようにしました。ドを記録するようにしました。
これにより、FR-2LEで記録したBWFフォーマットのファイルをBWFに対応したTC（出力）表示可能なシステム
で再生すると、24H RUNの時間情報が表示されるようになります。

（（（（（11111））））） V1.10V1.10V1.10V1.10V1.10で追加したで追加したで追加したで追加したで追加したFormatFormatFormatFormatFormatメニューのトラックメニューのトラックメニューのトラックメニューのトラックメニューのトラック・・・・・モードにおいて、モードにおいて、モードにおいて、モードにおいて、モードにおいて、“““““圧圧圧圧圧縮縮縮縮縮モモモモモーーーーードドドドド（（（（（MP3MP3MP3MP3MP3）））））”””””でフォーでフォーでフォーでフォーでフォー
マットする際のモノマットする際のモノマットする際のモノマットする際のモノマットする際のモノ・・・・・トラックが選択可能になりました。トラックが選択可能になりました。トラックが選択可能になりました。トラックが選択可能になりました。トラックが選択可能になりました。
トラック・モードの詳細については、同梱されている「V1.10対応 追補版」をお読みください。



Model FR-2LEModel FR-2LEModel FR-2LEModel FR-2LEModel FR-2LE取扱説明書取扱説明書取扱説明書取扱説明書取扱説明書
＜バージョン1.30対応 追補版＞
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V1.30のFR-2LEでは、本機搭載のALC (Auto Level
Control) 機能を拡張し、さらにはリモート・コント
ローラのキー機能を設定するための“Remote”メ
ニューを新たに“Setup”メニューに追加しました。

本書ではバージョンアップにより追加された機能に
ついてのみ記載しておりますので、ご使用の際は取
扱説明書・本文および他の追補版と併せてお読みく
ださい。



＜＜＜＜＜MemoMemoMemoMemoMemo＞＞＞＞＞：：：：：“ALC”メニューの設定は、MENUモー
ドで設定する以外にクイックセットアップ・モードで
も行えます。クイックセットアップ・モードの操作手
順については、取扱説明書・本文の55ページを参照し
てください。

MENUモードの“SetupSetupSetupSetupSetup”メニューにある“ALC (Auto Level Control)ALC (Auto Level Control)ALC (Auto Level Control)ALC (Auto Level Control)ALC (Auto Level Control)”メニューにおいて、録音レベ
ルを最大限利用するために入力信号を制御するモードを追加しました。マイクでの記録時など、マイク
の過大入力信号を制御して安定した記録が可能になります。バージョンアップ以前の“ALCALCALCALCALC”メニュー
の設定方法については取扱説明書・本文の91ページに記載されていますが、バージョンアップ後の設定
は下記手順で行ってください。

モードモードモードモードモード 動作の詳細動作の詳細動作の詳細動作の詳細動作の詳細

On

Limit

Off+12dB

LIM+12dB

ALCが機能します。

ATACK最小、Release最大に設定され
た、リミッターとして機能します。

（（（（（11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、
MENUMENUMENUMENUMENUモードの画面を表示させます。モードの画面を表示させます。モードの画面を表示させます。モードの画面を表示させます。モードの画面を表示させます。

（（（（（22222））））） [-] [-] [-] [-] [-] キーを押していき、キーを押していき、キーを押していき、キーを押していき、キーを押していき、“““““SetupSetupSetupSetupSetup”””””メニューを反転メニューを反転メニューを反転メニューを反転メニューを反転
させた後させた後させた後させた後させた後  [MENU/ENTER]   [MENU/ENTER]   [MENU/ENTER]   [MENU/ENTER]   [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。

（（（（（44444））））） [+] [+] [+] [+] [+] キーまたはキーまたはキーまたはキーまたはキーまたは [-]  [-]  [-]  [-]  [-] キーを押して希望のモードを選キーを押して希望のモードを選キーを押して希望のモードを選キーを押して希望のモードを選キーを押して希望のモードを選
択した後、択した後、択した後、択した後、択した後、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して確定しキーを押して確定しキーを押して確定しキーを押して確定しキーを押して確定し
ます。ます。ます。ます。ます。
モードは、初期設定の“OffOffOffOffOff”以外に次表に記載し
たモードが選択可能です。“Off+12dBOff+12dBOff+12dBOff+12dBOff+12dB”および
“LIM+12dBLIM+12dBLIM+12dBLIM+12dBLIM+12dB”モードを新たに追加しました。

なお、確定後は [STOP/CANCEL] キーを押して
MENUモードから抜け出します。

デフォルト・ゲイン+12dB固定に設定し
ます。

デフォルト・ゲイン+12dBにリミッター
を加えて機能します。

（（（（（33333））））） “““““ALCALCALCALCALC”””””メニューが反転している状態でメニューが反転している状態でメニューが反転している状態でメニューが反転している状態でメニューが反転している状態で [MENU/ [MENU/ [MENU/ [MENU/ [MENU/
ENTER] ENTER] ENTER] ENTER] ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されているモードが点滅します。

＜＜＜＜＜MemoMemoMemoMemoMemo＞＞＞＞＞：：：：：FR-2LE本体の [REWIND] キーを押すと、
現在表示されている画面の一つ前の画面に戻り、
[REWIND] キーを押していくと最終的にはMENUモー
ドから抜け出すことができます。

“““““ALC (Auto Level Control)ALC (Auto Level Control)ALC (Auto Level Control)ALC (Auto Level Control)ALC (Auto Level Control)”””””機能を拡張機能を拡張機能を拡張機能を拡張機能を拡張

＜注意＞＜注意＞＜注意＞＜注意＞＜注意＞：：：：：MENUモードとクイックセットアップ・
モードにおけるモード表示は、以下のように異なっ
ていますのであらかじめご承知置きください。

選択する選択する選択する選択する選択する
モードモードモードモードモード

On

Limit

Off+12dB

LIM+12dB

Off

クイックセットクイックセットクイックセットクイックセットクイックセット
アップアップアップアップアップ・・・・・モードモードモードモードモード
での表示での表示での表示での表示での表示

MENUMENUMENUMENUMENUモードモードモードモードモード
での表示での表示での表示での表示での表示

点滅

Off
（初期設定） ALC/Limiterともに機能しません。



本機に付属しているワイヤード・リモート・コントローラのキー機能を変更する“RemoteRemoteRemoteRemoteRemote”メニューを
MENUモードの “SetupSetupSetupSetupSetup”メニューに追加しました。工場出荷時は初期設定のモード（“MRK:REC:STBMRK:REC:STBMRK:REC:STBMRK:REC:STBMRK:REC:STB”）
になっていますので、用途に応じて設定を変更するには下記手順で行ってください。

STBYRECMARK

[MARK] キー

[REC] キー

[STBY] キー

設定するモード設定するモード設定するモード設定するモード設定するモード
MRK:REC:STB
（初期設定）

STP:PLY:STB

（（（（（11111））））） 停止状態で停止状態で停止状態で停止状態で停止状態で [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して、キーを押して、キーを押して、キーを押して、キーを押して、
MENUMENUMENUMENUMENUモードの画面を表示させます。モードの画面を表示させます。モードの画面を表示させます。モードの画面を表示させます。モードの画面を表示させます。

（（（（（22222））））） [-] [-] [-] [-] [-] キーを押していき、キーを押していき、キーを押していき、キーを押していき、キーを押していき、“““““SetupSetupSetupSetupSetup”””””メニューを反転メニューを反転メニューを反転メニューを反転メニューを反転
させた後させた後させた後させた後させた後 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。

（（（（（33333））））） [-] [-] [-] [-] [-] キーを押していき、キーを押していき、キーを押していき、キーを押していき、キーを押していき、“““““RemoteRemoteRemoteRemoteRemote”””””メニューを反転メニューを反転メニューを反転メニューを反転メニューを反転
させた後させた後させた後させた後させた後 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押します。キーを押します。キーを押します。キーを押します。キーを押します。
現在設定されているモードが点滅します。

[MARK]キー

[REC]キー

[STBY]キー

[MARK]キーとし
て機能します

[REC]キーとして
機能します

[REC STBY]キー
として機能します

* MRK: MARK
* REC: RECORD
* STB: STANDBY
* STP: STOP
* PLY: PLAY

[STOP]キーとして
機能します

[PLAY]キーとして
機能します

“““““RemoteRemoteRemoteRemoteRemote”””””メニューを新たに追加メニューを新たに追加メニューを新たに追加メニューを新たに追加メニューを新たに追加

（（（（（44444））））） [+] [+] [+] [+] [+] キーまたはキーまたはキーまたはキーまたはキーまたは [-]  [-]  [-]  [-]  [-] キーを押して希望のモードを選キーを押して希望のモードを選キーを押して希望のモードを選キーを押して希望のモードを選キーを押して希望のモードを選
択した後、択した後、択した後、択した後、択した後、 [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER]  [MENU/ENTER] キーを押して確定しキーを押して確定しキーを押して確定しキーを押して確定しキーを押して確定し
ます。ます。ます。ます。ます。
モードは初期設定の“MRK:REC:STBMRK:REC:STBMRK:REC:STBMRK:REC:STBMRK:REC:STB”の他に
“STP:PLY:STBSTP:PLY:STBSTP:PLY:STBSTP:PLY:STBSTP:PLY:STB”が選択でき、設定するモードに
よってコントローラの各キーが下記表の機能を果
たします。

なお、確定後は [STOP/CANCEL] キーを押して
MENUモードから抜け出します。

＜＜＜＜＜MemoMemoMemoMemoMemo＞＞＞＞＞：：：：：FR-2LE本体の [REWIND] キー
を押すと、現在表示されている画面の一つ前
の画面に戻り、 [REWIND] キーを押していくと
最終的にはMENUモードから抜け出すことが
できます。

点滅

[REC STBY]キー
として機能します

ワイヤード・リモート・コントローラ
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